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Introduzione


Benvenuto in OmniOutliner 4!



OmniOutliner è il tuo strumento di riferimento per creare e gestire elenchi. Che tu stia tenendo traccia delle attività da svolgere per un progetto, o creando lo schema di riferimento per un libro o per la relazione alla quale stai lavorando, OmniOutliner ti offre tutto il necessario per organizzare, e mantenere organizzato, ogni più piccolo dettaglio.





[image: Uno screenshot di OmniOutliner 4]


Ottimizzata per OS X El Capitan (V10.11), l’interfaccia utente di OmniOutliner ha subito una trasformazione che, siamo sicuri, ti lascerà senza fiato. È finita l’epoca dei pulsanti e dei controlli vecchio stile: tutti questi elementi sono stati aggiornati per fornire a OmniOutliner un aspetto gradevole e lineare.



Continua a leggere per saperne di più sulle novità di OmniOutliner e di questa documentazione.



In che modo è organizzata la documentazione


Questo splendido manuale (che stai consultando all’interno di OmniOutliner, online, in iBooks sul Mac o sul tuo dispositivo iOS, o entrambi) è stato strutturato in modo da offrirti una panoramica completa di OmniOutliner.




Inizieremo da una panoramica dell’interfaccia. Ti consigliamo di non saltare questo capitolo, che include molte informazioni e dettagli specifici su OmniOutliner che altrimenti potresti perderti. Se invece decidi di saltare il capitolo e poi ti ritrovi a domandarti “Ma quell’affare a cosa serve esattamente?”, puoi sempre tornare qui per scoprire di cosa si tratta.


Di seguito è riportato l’elenco dei capitoli del documento, per consultare più agevolmente la documentazione e imparare tutto quello che c’è da sapere su OmniOutliner:



	Capitolo 1: Introduzione a OmniOutliner

	Il primo capitolo va dritto al punto fornendoti una panoramica dall’alto dell’interfaccia utente di OmniOutliner. Niente di troppo dettagliato: solo le basi per farti iniziare.


	Capitolo 2: Sincronizzazione con OmniPresence e Omni Sync Server

	Per quanto riguarda la protezione dei tuoi documenti e la loro condivisione tra OmniOutliner sul tuo Mac e OmniOutliner sul tuo iPad, abbiamo qualcosa di davvero speciale da proporti: OmniPresence e Omni Sync Server. Questo capitolo illustra come scaricare, installare e configurare OmniPresence sul tuo Mac, in modo da poter condividere file tra OmniOutliner su Mac e iPad.


	Capitolo 3: Utilizzo del Browser delle risorse

	Il Browser delle risorse ti consente di aprire un file salvato di recente, o di creare favolosi documenti a partire da uno dei modelli disponibili.


	Capitolo 4: Utilizzo della barra degli strumenti

	La barra degli strumenti si trova nella parte superiore della finestra di OmniOutliner. La barra degli strumenti consente di accedere facilmente alle funzioni di OmniOutliner di uso più comune, ad esempio i pulsanti per nascondere e visualizzare la barra laterale e le finestre di impostazioni, o per comprimere ed espandere gli elenchi nella tua struttura. E proprio come nel caso delle altre applicazioni per Mac, puoi personalizzare i pulsanti della barra degli strumenti; a differenza delle altre applicazioni per Mac, tuttavia, se utilizzi OmniOutliner Pro puoi creare barre degli strumenti specifiche per documento.


	Capitolo 5: Utilizzo della barra laterale

	La barra laterale, posizionata lungo il margine sinistro della finestra di OmniOutliner, ti consente di mettere in evidenza e formattare il contenuto della tua struttura.


	Capitolo 6: Utilizzo delle finestre di impostazioni

	Una volta che hai imparato a conoscere gli strumenti, puoi utilizzare le finestre di impostazioni per esaminare il contenuto della tua struttura e modificarne le proprietà di stile.


	Capitolo 7: Stampa da OmniOutliner

	Ti potrà capitare di dover stampare la struttura alla quale stai lavorando in OmniOutliner. Questo capitolo illustra le caratteristiche fondamentali della finestra di dialogo di stampa di OmniOutliner.


	Capitolo 8: Preferenze

	Puoi utilizzare i sei pannelli delle preferenze per personalizzare ulteriormente OmniOutliner in base alle tue esigenze e al tuo stile di lavoro.


	Capitolo 9: Condivisione di file di OmniOutliner con altre applicazioni

	OmniOutliner è l’ideale quando si tratta di lavorare con contenuti testuali. E per tutte le tue esigenze in questo ambito, abbiamo reso il più semplice possibile l’importazione e l’esportazione di file di testo in una varietà di formati.


	Capitolo 10: Voci di menu e abbreviazioni da tastiera

	Qui troverai una descrizione dettagliata di ogni voce di menu in OmniOutliner 4, comprese le opzioni specifiche della versione Pro. Dove applicabile, le descrizioni includono le abbreviazioni da tastiera di ogni voce di menu, per consentirti di lavorare in OmniOutliner ancora più velocemente.


	Capitolo 11: Gestione delle licenze Omni

	Nella maggior parte dei casi non dovrai preoccuparti della tua licenza Omni, soprattutto se hai acquistato OmniOutliner da Mac App Store. Se invece hai acquistato OmniOutliner dal nostro sito web, dovrai immettere le informazioni specifiche incluse nel messaggio e-mail che ti abbiamo inviato.

Questo breve capitolo ti guida nel processo di inserimento delle tue informazioni di licenza in OmniOutliner, ti mostra come rimuovere una licenza e ti indica perfino dov’è “nascosta” la licenza sul tuo Mac, nel caso avessi necessità di inviarcela o di trasferirla sul tuo nuovissimo Mac appena acquistato.



	Capitolo 12: Assistenza

	Ammettere di aver bisogno di aiuto non è certo una vergogna. In effetti, siamo qui proprio per questo. Se lavorando in OmniOutliner rimani bloccato, o hai un problema con la licenza dell’app, o semplicemente vuoi complimentarti con gli operatori del nostro supporto e con i nostri esperti per l’ottimo lavoro, non esitare a contattarci. Questo capitolo ti indica tutte le risorse a tua disposizione: gli operatori del supporto, gli articoli di supporto, i video e la documentazione.





Utilizzo del presente manuale


Uno dei vantaggi del formato elettronico della documentazione di OmniOutliner è che è sempre disponibile quando ti serve. Abbiamo integrato la documentazione direttamente nel menu Aiuto. La documentazione è presente per intero sul nostro sito web, dove puoi anche eseguire ricerche e aggiungere segnalibri. Continuiamo inoltre sulla strada della creazione di versioni EPUB della documentazione, disponibili gratuitamente su iBooks Store.





Documentazione in formato EPUB

[image: L’icona dell’applicazione iBooks]Il formato che prediligiamo per la documentazione di supporto è EPUB, disponibile su iBooks Store. La documentazione relativa è identica a quella presente sul sito web e all’interno dell’app.


Il vantaggio di scaricare il Manuale dell’utente di OmniOutliner 4 per Mac da iBooks Store consiste nel fatto che, tutte le volte che aggiorneremo la documentazione per una nuova versione di OmniOutliner, riceverai una notifica in iBooks che ti informerà della disponibilità dell’aggiornamento. Il principale vantaggio del formato EPUB rispetto al PDF, comunque, è che le annotazioni o i segnalibri che crei nell’e-book vengono conservati nelle nuove versioni della documentazione.





Novità di OmniOutliner 4


Con supporto per le tecnologie più recenti e ottimizzato per OS X El Capitan, OmniOutliner 4 include tutte le caratteristiche che i nostri fan di lunga data ci chiedono da tempo, tra le quali:





	NOVITÀ Copia/incolla testo semplice come valori separati da tabulazioni: quando copi i contenuti di un documento di OmniOutliner con più colonne, OmniOutliner posiziona le informazioni negli appunti come valori separati da tabulazioni.

	Esportazione in formato CSV: oggi è possibile esportare la struttura come file di valori separati da virgole (.csv). Puoi utilizzare OmniOutliner 4 per esportare la struttura in modo da poterne importare i dati in altre applicazioni, come Numbers o Microsoft Excel.

	Esportazione in PowerPoint: hai necessità di trasformare la tua struttura in una presentazione? Puoi esportare la struttura da OmniOutliner 4 in formato Microsoft PowerPoint (.pptx) e in questo modo creare la tua presentazione in PowerPoint, o importare il file .pptx in Keynote di Apple.

	Browser delle risorse: il nuovo Browser delle risorse consente di muoversi tra i file modificati di recente, scegliere modelli, applicare temi a documenti esistenti e importare modelli da OmniOutliner 3.


	Barra laterale: abbiamo eliminato il vecchio cassetto di OmniOutliner 3 e creato una nuova barra laterale che include il contenuto della struttura, gli stili e molto altro ancora.


	Riprogettazione della finestra di impostazioni: la nuova finestra Impostazioni di OmniOutliner è più lineare e immediata.


	Stili: abbiamo riorganizzato il funzionamento degli stili per meglio allinearci con OmniOutliner 2 per iOS e creare una valida esperienza interpiattaforma. Inoltre, abbiamo aggiunto la definizione dei temi per gli stili, con la possibilità di applicare stili di modello a un documento esistente.


	Definizione di temi: oggi puoi applicare gli stili di un modello (il suo tema) alle strutture.


	Visibilità delle colonne: in presenza di un documento con molte colonne cui è necessario accedere solo saltuariamente, abbiamo aggiunto la possibilità di nascondere e visualizzare le colonne quando lo desideri.


	Tecnologia Smart Match: le colonne in stile elenco a comparsa sfruttano la tecnologia Smart Match già presente in OmniFocus. Mentre digiti in una cella Elenco a comparsa, OmniOutliner cerca di prevedere la tua scelta. E non è necessario che i caratteri immessi si trovino all’inizio della parola o siano contigui! Se digiti un nuovo valore da aggiungere all’elenco a comparsa, è sufficiente premere Comando-A Capo per aggiungerlo all’elenco.


	Collegamenti ipertestuali: gli URL vengono convertiti in link reali, che puoi aprire con un clic nel tuo browser predefinito. Non solo: questa opzione è attivabile o disattivabile a scelta, dalle preferenze di OmniOutliner.


	Allegati: a un documento OmniOutliner puoi associare praticamente qualsiasi cosa: immagini, video, audio e perfino altri file di OmniOutliner. Le immagini allegate vengono adattate automaticamente alla larghezza delle colonne, e puoi allegare clip audio che vengono riprodotte dall’interno della struttura. Non solo: abbiamo aggiunto un nuovo popover per allegati, in sostituzione del tagging di OmniOutliner 3, che consente di modificare la visibilità delle immagini allegate, utilizzare testo alternativo anziché un nome di file, e impostare la modalità di apertura degli allegati in OmniOutliner 4.


	Logica di analisi della data: la nuova logica di analisi della data di OmniOutliner consente di digitare ad esempio adesso, ieri, 2g, settembre, gio, -5s in una colonna di data e ottenere la corrispondenza desiderata.


	Stampa: tutte le opzioni di stampa specifiche di OmniOutliner sono ora disponibili nel pannello Stampa. Puoi personalizzare intestazioni e piè di pagina, adattare proporzioni e margini, scegliere se includere note e altro ancora.


	Zoom: il testo può essere ingrandito sullo schermo senza modificare il layout di stampa.


	Compatibilità con i file esistenti: OmniOutliner 4 è completamente compatibile con OmniOutliner 3 per Mac e OmniOutliner 1 e 2 per iPad. OmniOutliner 4 è in grado di aprire qualsiasi file con estensione .oo3.






Funzioni disponibili in OmniOutliner 4 Pro


Se hai acquistato OmniOutliner 4 Pro, o stai prendendo in considerazione l’aggiornamento dalla versione standard, ecco alcune caratteristiche esclusive di OmniOutliner Pro:



	Supporto per AppleScript: per automatizzare i flussi di lavoro con AppleScript.


	Supporto all’esportazione per Microsoft Word: puoi esportare la tua struttura come file .docx (con rientro o come struttura), che sarà poi possibile aprire in Microsoft Word.


	Interruzioni di pagina manuali: scegli se impostare un’interruzione di pagina manuale, visibile alla stampa del documento, per una riga o un particolare stile di riga.


	Personalizzazione delle note: per adattare altezza della riga e spaziatura interna per le note.


	Visualizzazione delle note in linea o in un pannello: le note in linea a volte possono essere di disturbo. Anziché doverle nascondere e visualizzare continuamente, oggi puoi visualizzare le note in un pannello separato nella parte inferiore dell’area della struttura. 


	Rientro degli elementi figlio: puoi scegliere se applicare un rientro alle righe figlio, o se allinearle alle rispettive righe padre.


	Possibilità di nascondere le colonne: puoi visualizzare e nascondere le colonne in base alle tue preferenze.


	Barre degli strumenti specifiche per documento: puoi creare barre degli strumenti personalizzate, che includono solo i pulsanti necessari per il documento specifico sul quale stai lavorando. 


	Modifica nidificata: puoi nascondere il testo all’interno di una riga quando non ne stai modificando il contenuto, e visualizzarlo completamente quando la riga è selezionata.


	Visibilità delle maniglie di riga: puoi utilizzare la finestra di impostazioni Stile per modificare la visibilità delle maniglie di riga. Inoltre, puoi impostare maniglie indipendenti l’una dall’altra, in modo che per alcune righe le maniglie siano sempre visibili, non lo siano mai, o vengano visualizzate solo quando passi il puntatore del mouse sopra la riga.


	Regolazione delle altezze e della spaziatura avanzata delle righe: puoi utilizzare la finestra di impostazioni Stile per modificare l’altezza della riga e aggiungere spazio intorno alle righe figlio.


	Il menu Modifica include una nuova opzione: Copia come link. L’opzione di menu Copia come link consente di creare link di riferimento incrociato tra righe all’interno dello stesso documento di OmniOutliner. Basta selezionare una porzione di testo in una riga, scegliere Modifica ▸ Copia come link e quindi spostarsi su un’altra riga nella struttura e premere Comando-V per incollare un link alla prima riga. Questo risulta particolarmente utile quando stai lavorando a una struttura di grandi dimensioni, in cui potrebbe essere necessario includere riferimenti ad altre parti dello stesso documento. I collegamenti tra documenti non sono supportati in questo momento. Per maggiori informazioni, vedi Voci di menu e abbreviazioni da tastiera.








Nota
 Non sei certo se la versione Pro è installata o meno sul tuo Mac? Scegli OmniOutliner ▸ Informazioni su OmniOutliner per verificare i dettagli sulla versione corrente e sullo stato della licenza per l’applicazione.





Tutto questo in un’interfaccia utente più immediata e rapida, creata per la massima compatibilità con OS X Yosemite e l’hardware Mac più recente.



La tua opinione è importante


Lavoriamo costantemente all’aggiornamento della nostra documentazione. Che si tratti di modificare il CSS, correggere l’occasionale errore di battitura (sì, a volte capitano), o aggiungere dettagli o chiarimenti per una caratteristica specifica, in base al suggerimento di un cliente, siamo sempre alla ricerca di modi nuovi per migliorare la documentazione e renderla ancora più utile.




Se hai osservazioni specifiche sulla documentazione che desideri comunicarci, non esitare. Puoi mandare un messaggio e-mail al nostro Supporto, oppure contattarci su Twitter @OmniWranglers.


Infine, vorremmo ringraziarti per aver dedicato tempo prezioso a leggere la documentazione.







Introduzione a OmniOutliner 4


Alla prima apertura di OmniOutliner vengono visualizzate due finestre: la finestra di modifica e la finestra Impostazioni. La finestra di modifica corrisponde all’effettiva area di lavoro, mentre la finestra Impostazioni fornisce tutti gli strumenti necessari per formattare il testo, le righe e le colonne. Prima di addentrarci nei dettagli, una rapida panoramica dell’interfaccia utente di OmniOutliner:




[image: Le quattro sezioni che compongono l’interfaccia utente di OmniOutliner includono tutte le funzionalità necessarie al tuo lavoro]


	La barra degli strumenti: lungo la parte superiore della finestra di OmniOutliner è presente una serie di utili pulsanti della barra degli strumenti. Completamente personalizzabile, incluse barre degli strumenti specifiche per il singolo documento, la barra degli strumenti facilita al massimo l’aggiunta di colonne e allegati, la registrazione e l’inserimento di clip audio, e non solo. Vedi la sezione Utilizzo della barra degli strumenti per maggiori informazioni.


	La barra laterale: si trova nella parte sinistra della finestra di OmniOutliner. Completamente comprimibile, la barra laterale fornisce una visualizzazione strutturale di ogni elemento presente nella finestra di modifica e tiene traccia degli stili utilizzati nel documento. Per saperne di più sulla barra laterale, vedi la sezione Utilizzo della barra laterale.


	La struttura: utilizzabile per immettere testo nelle righe e nelle colonne, aggiungere note, aggiungere segni di spunta utilizzando le caselle di stato, inserire immagini e clip audio e molto altro ancora. Per ulteriori informazioni sull’utilizzo di OmniOutliner, compresi dettagli sulla creazione di stili e modelli, ti consigliamo di seguire il tutorial pratico Working in OmniOutliner.


	La finestra Impostazioni: per le finestre Impostazioni è disponibile una finestra mobile dedicata, costituita dalle finestre di impostazioni Stile, Colonna, Struttura, Documento e Attributi di stile, che facilita la creazione di documenti di OmniOutliner perfettamente formattati; quando non ne hai bisogno, basta premere Maiuscole-Comando-I per nasconderla. Per ulteriori dettagli sulle finestre Impostazioni e sulle funzionalità di ciascuna di esse, vedi la sezione Utilizzo delle finestre Impostazioni.






Utilizzo e impostazione delle abbreviazioni da tastiera


Di tanto in tanto citeremo le abbreviazioni da tastiera utilizzabili in OmniOutliner. Per i nuovi utenti Apple, o per chi non fosse abituato a utilizzarle, le abbreviazioni da tastiera sono davvero utili per velocizzare il lavoro in OmniOutliner. Anziché utilizzare il mouse o il trackpad del Mac, puoi premere un’abbreviazione da tastiera per richiamare determinati comandi di menu.


Tuttavia, non a ogni voce di menu è associata un’abbreviazione da tastiera. Se utilizzi una voce di menu abbastanza spesso da rendere utile un’abbreviazione da tastiera specifica, o se desideri modificarne una esistente, puoi farlo mediante l’applicazione Preferenze di Sistema del tuo Mac. Per mostrarti com’è facile eseguire questa operazione, proviamo a creare la prima abbreviazione da tastiera personalizzata per OmniOutliner, per la voce di menu Porta alle dimensioni reali.



	Per prima cosa è necessario sapere dove si trova la voce di menu Porta alle dimensioni reali in OmniOutliner. La puoi trovare nel menu Vista:



[image: La voce di menu Porta alle dimensioni reali si trova nel menu Vista]

Non è necessario tanto sapere a quale menu appartiene la voce (anche se è un’informazione utile per altri motivi), ma piuttosto come si chiama esattamente. Questa informazione sarà necessaria al momento di creare l’abbreviazione da tastiera. Naturalmente, se necessario puoi sempre passare da OmniOutliner al pannello Tastiera delle Preferenze di Sistema, e viceversa, ma per evitare complicazioni è utile avere questa informazione a portata.


	Nel Dock fai clic su Preferenze di Sistema.


	Apri il pannello delle preferenze Tastiera, quindi fai clic nel pannello Abbreviazioni.


	Nella barra laterale a sinistra fai clic su Abbreviazioni app; nell’area a destra sono elencate le abbreviazioni da tastiera personalizzate create per le altre applicazioni sul Mac.

[image: Utilizza la sezione Abbreviazioni del pannello delle preferenze Tastiera per creare e gestire le abbreviazioni da tastiera personalizzate sul tuo Mac]


	Sotto l’elenco delle abbreviazioni personalizzate, fai clic sul pulsante Aggiungi, indicato dal segno più (+). Viene visualizzato un foglio in cui puoi creare l’abbreviazione da tastiera personalizzata.


	Nel foglio, esegui le operazioni seguenti:



	Nel menu Applicazione scegli OmniOutliner.app

	Nel campo Titolo menu immetti Porta alle dimensioni reali. Assicurati di inserire il testo esattamente come visualizzato nel menu.

	Nel campo Abbreviazione da tastiera digita l’abbreviazione che desideri utilizzare. In questo esempio abbiamo inserito ⌘-1, l’abbreviazione da tastiera utilizzata per lo zoom a dimensioni reali da molte diffuse applicazioni di disegno; puoi comunque scegliere qualsiasi combinazione di tasti.




Al termine, il foglio dovrebbe avere l’aspetto seguente:

[image: Configura la nuova abbreviazione da tastiera nel foglio]


	Fai clic su Aggiungi per creare la nuova abbreviazione da tastiera per OmniOutliner.





Tornando a OmniOutliner, nel menu Vista vedrai l’abbreviazione da tastiera appena creata per Porta alle dimensioni reali.


[image: Alla voce di menu Porta alle dimensioni reali è ora associata un’abbreviazione da tastiera specifica]

Per ulteriori informazioni sull’utilizzo delle abbreviazioni da tastiera sul tuo Mac, puoi consultare Abbreviazioni da tastiera OS X sul sito del supporto Apple.










Sincronizzazione con OmniPresence e Omni Sync Server



Disponibile per Mac e iOS, OmniOutliner è uno strumento essenziale per tutte le esigenze di schematizzazione. E quando devi proteggere tali documenti e condividerli tra OmniOutliner sul Mac e OmniOutliner sul tuo dispositivo iOS, abbiamo qualcosa di speciale per te: OmniPresence e Omni Sync Server.






	

OmniPresence è un’utility gratuita installata sul tuo Mac per eseguire la sincronizzazione dei file. L’esecuzione di OmniPresence avviene in background e consiste nel monitorare una cartella “collegata”. OmniPresence fa in modo che i file all'interno di quella cartella siano sincronizzati con i file nel cloud (un server WebDAV a tua scelta) e con le app iOS abilitate per OmniPresence.




Su iOS, OmniPresence è integrato in OmniOutliner e OmniGraffle. Potrai accedere alle cartelle e ai file di OmniPresence dall’interno del Browser delle risorse della rispettiva app. Il risultato è che su tutti i dispositivi per i quali hai abilitato OmniPresence eventuali modifiche verranno rilevante indipendentemente da dove vengano apportate, e quei dispositivi saranno costantemente sincronizzati per mantenere i file aggiornati.




Per iniziare, dovrai scaricare OmniPresence per Mac dal nostro sito web.





Nota
 OmniPresence non è un sostituto della soluzione di sincronizzazione corrente per OmniFocus o OmniPlan:



	OmniFocus utilizza il proprio codice di sincronizzazione integrato (anziché OmniPresence) per inviare le modifiche al database su un server WebDAV e per recuperarle; OmniFocus per Mac non richiede l’installazione di OmniPresence per il funzionamento della sua funzione di sincronizzazione.


	
OmniPlan utilizza una funzionalità publish-and-subscribe per la condivisione dei file di progetto. Ad esempio, puoi creare un piano di progetto in OmniPlan e condividerlo (pubblicarlo) con altri membri del team responsabili di determinate attività. A loro volta, questi si iscrivono al progetto per poter visualizzare e riferire circa le attività loro assegnate.








	

Omni Sync Server è una “scatola magica” che risiede in una stanza ben climatizzata insieme agli altri server di Omni e a un branco di unicorni. Omni Sync Server è il nostro server WebDAV personalizzato e funge da hub centrale per tutte le tue esigenze di sincronizzazione; è a questo server che OmniPresence si collega per trasferire file da e verso il tuo Mac e i tuoi dispositivi iOS.



Con Omni Sync Server, non diamo mai nemmeno un’occhiata a tuoi dati senza autorizzazione. Ad esempio, quando i nostri operatori umani del supporto lavorano con te per ripristinare un file danneggiato, o isolare un particolare problema che stai avendo con il nostro server. Fatti salvi questi casi, puoi essere certo che i tuoi dati sono assolutamente al sicuro su Omni Sync Server.








Per utilizzare Omni Sync Server, devi anzitutto registrarti e creare un account. Non preoccuparti: è tutto gratis. Se non disponi già di un account, collegati al nostro sito Web e registrati adesso per creare un account Omni Sync Server. E intendiamo proprio “adesso”!




OmniPresence e la riservatezza dei tuoi dati



Capiamo perfettamente che, in certe circostanze, preferirai mantenere i dati sul tuo server. Questo potrebbe dipendere dalla politica aziendale, da motivi legali, o semplicemente dal tuo desiderio di gestire direttamente il backup di tutte le tue risorse essenziali: ed è assolutamente comprensibile.




Se non desideri utilizzare Omni Sync Server, OmniPresence è in grado di collegarsi a qualsiasi server WebDAV. Può trattarsi di un server gestito da te, o che si appoggia a un servizio di terzi.




Se scegli di utilizzare il tuo server WebDAV, in questo utile articolo del supporto, disponibile sul nostro sito web sono disponibili le istruzioni passo passo per configurare WebDAV su OS X Server.






Come funziona la sincronizzazione



Prima di addentrarci nei dettagli della configurazione sul tuo Mac, vale la pena dedicare un momento al funzionamento della sincronizzazione con OmniPresence.






Con OmniPresence attivo, il server WebDAV designato (Omni Sync Server oppure un server tuo o di terzi) gestisce la sincronizzazione in modo che i file siano sempre aggiornati. A ogni successiva sincronizzazione, OmniPresence confronta i tuoi file locali con quelli sul server e applica eventuali differenze. Questo garantisce che i file siano non solo aggiornati, ma anche disponibili sempre e ovunque tu ne abbia bisogno.




Inoltre, abbiamo inserito un meccanismo di sincronizzazione automatica. Quando salvi un file in una cartella di OmniOutliner abilitata per OmniPresence (o quando viene eseguito un salvataggio automatico), OmniPresence aggiorna il file sul server di sincronizzazione. OmniPresence contatta Omni Sync Server almeno ogni ora per eseguire il confronto tra i file nella cartella di sincronizzazione. Se nulla è cambiato, OmniPresence continua a tenere d’occhio i file. Quindi, puoi essere certo che i file di OmniOutliner siano sempre al sicuro e, cosa ancora più importante, sempre aggiornati.




Installazione di OmniPresence



Se hai fatto clic sul collegamento precedente per scaricare OmniPresence per Mac (o su questo link), troverai il pacchetto di installazione nella cartella Download sul tuo Mac:





[image: Una finestra del Finder, aperta sulla cartella Download per visualizzare l’immagine disco scaricata di OmniPresence.]


Per installare OmniPresence, segui la procedura seguente:




		Apri una finestra del Finder e passa alla cartella Download sul tuo Mac.

		Individua il file OmniPresence-1.3.dmg e fai doppio clic su di esso.
	
	
	Note
 Il nome del file da te visualizzato potrebbe essere leggermente diverso. Al momento in cui scriviamo, OmniPresence per Mac è alla versione 1.3 (da cui il nome del file, OmniPresence-1.3.dmg). Se visualizzi un numero diverso nel nome del file, non preoccuparti; procedi pure e fai doppio clic. Significa semplicemente che il nostro team di tecnici ha lavorato sodo per migliorare ulteriormente OmniPresence per Mac.
	

	

	

		Dopo che avrai accettato la nostra licenza, verrà visualizzata la finestra seguente: [image: Trascina l’icona di OmniPresence.app sulla cartella Applicazioni per installare OmniPresence sul tuo Mac]
	

		Trascina l’icona di OmniPresence.app sulla cartella Applicazioni per installare OmniPresence sul tuo Mac. [image: Trascina l’icona di OmniPresence.app sulla cartella Applicazioni per installare OmniPresence sul tuo Mac]
	

		Chiudi la finestra premendo Comando-W

		Nella finestra del Finder espelli l’immagine disco.

		Nella finestra del Finder torna alla cartella Download. Seleziona il file OmniPresence-1.3.dmg e premi Comando-Canc per spostarlo nel Cestino. Il file verrà cancellato al prossimo svuotamento del cestino, per evitare che occupi spazio prezioso sul disco. (Prego!)





Anche se utilizzi OmniOutliner solo sul Mac, è buona prassi eseguire la sincronizzazione a scopo di backup automatico dei dati. Soprattutto, il nostro Omni Sync Server è gratuito e i server sono gestiti da noi affinché i tuoi dati siano sempre disponibili quando ne hai più bisogno.




Avvio di OmniPresence e connessione a Omni Sync Server



Ora che OmniPresence è installato sul tuo Mac, è il momento di avviarlo e creare o connetterti a un account Omni Sync Server esistente.






Iniziamo! Pronti? Via!




		Apri una finestra del Finder e scegli Applicazioni nella barra laterale del Finder. Se non la vedi, scegli Vai ▸ Applicazioni, o utilizza Maiusc-Comando-A. [image: Apri una finestra del Finder e scegli la cartella Applicazioni sulla barra laterale.]
	

		Scorri verso il basso nell’elenco delle applicazioni installate sul Mac e individua OmniPresence.app.

		Fai doppio clic sull’icona di OmniPresence.app per aprire l’app. OmniPresence viene installato e successivamente sulla barra dei menu si apre un menu aggiuntivo, dove andrai a configurare e a controllare OmniPresence.
	

		Fai clic su Set Up Syncing (Imposta sincronizzazione): [image: ]
	

		Fai clic su Create a Synced Folder (Crea una cartella sincronizzata): [image: ]
	

		Nel foglio visualizzato puoi assegnare un nome alla cartella di OmniPresence presente sul tuo Mac. Abbiamo precompilato l’etichetta New folder (Nuova cartella) con OmniPresence, ma puoi modificarla come desideri.
	

	
	Inoltre, questa cartella viene creata all’interno della cartella Documenti. Anche questa impostazione può essere modificata: ad esempio, potresti optare per inserire la cartella OmniPresence al primo livello della cartella Inizio.
	

	[image: ]
	
	Quando hai deciso un nome e una posizione per la cartella OmniPresence, o se decidi di optare per le opzioni di default, fai clic su Save (Salva). Verrà creata la cartella utilizzata da OmniPresence per sincronizzare i file.
	

	

		Dopo aver creato la cartella OmniPresence, il tuo prossimo compito consiste nel scegliere un server nel cloud in cui OmniPresence memorizzerà i file sincronizzati.


	[image: ]

	Le alternative possibili sono due:

 
	
		Omni Sync Server: è il server file gratuito di Omni, specificamente progettato per funzionare in combinazione con OmniPresence.

		Web Server (Server web): può essere il tuo server WebDAV, o un server WebDAV in hosting presso un fornitore terzo.

	

	
	Se possiedi un account Omni Sync Server, inserisci il tuo Nome account e la tua Password nei campi appositi e fai clic su Connetti.
	

	
	Nota
 Se non hai già impostato un account Omni Sync Server, fai clic su Sign Up for an Omni Sync Server Account (Registrati per creare account Omni Sync Server). Nel tuo browser di default verrà visualizzato il sito di Omni Sync Server, dove potrai registrarti, creare un account e impostare la password.
	

	

	

		
	
	Dopo che hai fatto clic su Connect (Connetti), OmniPresence si connette al server da te scelto ed esegue un test di compatibilità. Questo può essere un problema più con i server WebDAV di terzi che per la connessione a Omni Sync Server, che è stato progettato per funzionare con OmniPresence.
	

	[image: ]
	
	OmniPresence indica se è in grado di connettersi a Omni Sync Server (o al server WebDAV che hai specificato).
	

	

		
	
	Fai clic sulla casella di controllo per Open OmniPresence at Login (Apri OmniPresence al login) se desideri che OmniPresence venga avviato ogni volta che accedi al Mac.
	

	[image: ]

	
	Nella parte inferiore di questa finestra fai clic su Open Synced Folder (Apri cartella sincronizzata). In questo modo verrà eseguita la sincronizzazione tra la cartella OmniPresence e Omni Sync Server (o un server WebDAV). Se disponi già di un account Omni Sync Server, OmniPresence crea nuove versioni sincronizzate di questi file nella cartella che hai specificato.
	

	[image: ]
	





È tutto! Una volta che OmniPresence si collega con Omni Sync Server e crea la cartella di sincronizzazione sul tuo Mac, è tutto pronto. Ogni volta che crei file con OmniOutliner, assicurati di salvarli nella cartella di OmniPresence (~/Documenti/OmniPresence). OmniPresence sincronizza i file a ogni salvataggio, o quando sul Mac viene eseguito un salvataggio automatico.




Suggerimenti su OmniPresence



Ecco alcuni suggerimenti utili per migliorare la tua esperienza d’uso di OmniPresence:






		Puoi creare sottocartelle all’interno della cartella principale di OmniPresence per i file sincronizzati. Ad esempio, puoi creare sottocartelle per OmniOutliner, OmniGraffle, OmniPlan e OmniFocus, così come per altri file che desideri sincronizzare.

		Puoi mettere in pausa e riprendere la sincronizzazione facendo clic sull’icona di OmniPresence sulla barra dei menu.

		Fai clic sul menu Azione (l’ingranaggio accanto al pulsante In pausa/Riprendi) per accedere a una serie di opzioni di OmniPresence, tra le quali:

	[image: ]

	
			Informazioni su OmniPresence

			Note sulla versione

			Apri al login

			Verifica aggiornamenti

			Preferenze e privacy

			Aiuto di OmniPresence

			Contatta Omni

			Esci da OmniPresence

	

	

		Per interrompere la sincronizzazione di una cartella collegata, fai clic sul suo pulsante Info e scegli Disconnect (Disconnetti). La cartella sul tuo Mac verrà spostata nel Cestino e i file all’interno non verranno più sincronizzati. Tutti i file presenti nella cartella prima della disconnessione rimarranno al sicuro sul server cloud da te specificato. Per riconnettere e riavviare la sincronizzazione dei file, basta creare una nuova cartella collegata a quella posizione nel cloud.
	
	[image: ]
	

		
Non sei sicuro di quando è stata eseguita l’ultima sincronizzazione di OmniPresence? Fai clic sull’icona di OmniPresence sulla barra dei menu e quindi verifica sotto il nome di ogni cartella la data e l’ora dell’ultima sincronizzazione.



	[image: ]
	






Nota
 Se non imposti subito la sincronizzazione, ma decidi di farlo successivamente, puoi installare OmniPresence e configurare un account di Omni Sync Server in qualsiasi momento.









Utilizzo del Browser delle risorse


In base alle impostazioni di default delle preferenze di OmniOutliner, all’avvio di OmniOutliner verrà probabilmente visualizzato il nuovo Browser delle risorse. Il Browser delle risorse (File ▸ Browser delle risorse; Comando-N o Maiuscole-Comando-N) consente di aprire un file salvato di recente, o di creare stupendi documenti a partire da un modello.




[image: Il Browser delle risorse]

La barra laterale a sinistra facilita la selezione di un file utilizzato di recente, o la selezione di uno dei modelli con stili preapplicati inclusi in OmniOutliner 4.


Nella sezione Recenti sono visualizzati gli stessi elementi accessibili selezionando File ▸ Apri recente dalla barra dei menu, ovvero un elenco degli ultimi file aperti, che potrai selezionare e aprire rapidamente.


La sezione Modelli consente di aprire, in modo rapido e facile, uno dei modelli con stili preapplicati inclusi in OmniOutliner. Se non sai quale scegliere, puoi fare clic su un modello e premere la barra spaziatrice per aprire un’anteprima di “Visualizzazione rapida” del file di modello.


[image: Seleziona un modello nel Browser delle risorse e premi la barra spaziatrice per visualizzarne un’anteprima in “Visualizzazione rapida”]

Per chiudere l’anteprima di “Visualizzazione rapida”, premi di nuovo la barra spaziatrice.



Gestione e utilizzo dei modelli


Qualsiasi file salvato come modello (File ▸ Salva come modello) è disponibile nella sezione Modelli del Browser delle risorse. 




Per gestire i modelli, utilizza il menu Azione, indicato da un piccolo ingranaggio ([image: Il menu Azione]), nella parte inferiore del Browser delle risorse. Seleziona anzitutto uno dei modelli, quindi dal menu Azione scegli Mostra nel Finder. La cartella Templates viene visualizzata in una nuova finestra del Finder. Da qui non c’è praticamente limite a quello che puoi fare con i modelli. Puoi rinominarli, spostarli nel Cestino, o aggiungere sottocartelle in modo da catalogare i file di modello in base alle attività.



Una nota per gli appassionati di script


Per gli utenti più avanzati e che utilizzano gli script, la posizione esatta della cartella Templates sul disco rigido del Mac è la seguente:




	Acquisti su App Store non Mac:
 ~/Library/Containers/com.omnigroup.OmniOutliner4/
Data/Library/Application\ Support/The\ Omni\ Group/OmniOutliner/Templates



	Acquisto dal Mac App Store:


	
			Pro:
 ~/Library/Containers/com.omnigroup.
OmniOutlinerPro.MacAppStore/Data/Library/
Application\ Support/The\ Omni\ Group/OmniOutliner/Templates
		

			Standard:
 ~/Library/Containers/com.omnigroup.
OmniOutliner.MacAppStore/Data/Library/
Application\ Support/The\ Omni\ Group/OmniOutliner/Templates
		

	










Collegamento delle cartelle dei modelli sul Mac a OmniOutliner



Come indicato nella sezione precedente, quando crei un nuovo modello in OmniOutliner, di default i file vengono salvati all’interno del contenitore di OmniOutliner. Come conseguenza di questi, molti utenti hanno iniziato a memorizzare i propri modelli OmniOutliner in una posizione più comoda, ad esempio su Omni Sync Server, in una sottocartella della cartella Documenti nella directory Inizio, o altrove nel cloud. In questo modo, tuttavia, i modelli di OmniOutliner non vengono visualizzati nel Browser di risorse.






In OmniOutliner v4.4 abbiamo aggiunto la possibilità di aggiungere una cartella collegata alla sezione Modelli della barra laterale. Inizia facendo clic su [image: L’icona della cartella include due link e un segno più]. Quindi scegli una cartella nel foglio visualizzato e fai clic su Apri per aggiungere la cartella alla barra laterale del Browser delle risorse.



[image: Scegli una cartella nel foglio visualizzato]


Per rimuovere una cartella collegata dalla barra laterale del Browser delle risorse, seleziona la cartella in questione, fai clic su [image: Il menu Ingranaggio], e quindi scegli Rimuovi cartella collegata.





Utilizzo del menu Azione del Browser delle risorse


Puoi utilizzare il menu Azione ([image: Il menu Azione]) per aprire o creare nuovi modelli, verificare la posizione di una particolare risorsa nel Finder del tuo Mac, spostare un oggetto nel Cestino, o impostare come default un particolare modello.




Se desideri importare modelli di OmniOutliner 3, puoi scegliere Aggiungi risorse a Libreria per selezionare un file o un modello da aggiungere alla libreria di OmniOutliner.


Puoi utilizzare l’opzione Ripristina del menu Azione per ripristinare uno qualsiasi dei modelli di default eventualmente eliminato. Anche se elimini questi file dalla cartella Templates, le copie dei file di modelli rimangono all’interno dell’applicazione.


Supponiamo che, nel corso di una notte insonne, tu decida di non aver bisogno di nessuno dei modelli inclusi in OmniOutliner. e che, dal Browser delle risorse, li elimini uno per uno selezionando Azione ▸ Sposta nel cestino. Dopodiché, svuoti il cestino e te ne vai a dormire. La mattina dopo alle 5 spalanchi gli occhi con un’idea incredibile per il tuo prossimo best-seller. Peccato che il modello Bozza libro sia andato per sempre. Come rimediare? Fortunatamente, ci abbiamo pensato. Se scegli Azione ▸ Ripristina ▸ Modelli puoi selezionare uno (o tutti) i modelli inclusi in OmniOutliner e ripristinarli sul Mac.







Utilizzo della barra degli strumenti


La barra degli strumenti si trova nella parte superiore della finestra di OmniOutliner. Ricca di pulsanti e completamente personalizzabile, anche a livello di singolo documento (se disponi di OmniOutliner 4.2 Pro), la barra degli strumenti facilita la creazione di strutture assolutamente eccezionali.




[image: La barra degli strumenti]

Alle estremità opposte della barra degli strumenti si trovano i pulsanti per nascondere e visualizzare la barra laterale e le finestre Impostazioni. Sopra di essi, i controlli standard di OS X per chiudere e nascondere la finestra o per passare alla modalità Schermo intero.


Al centro della barra degli strumenti, nella parte superiore, è presente un’icona del documento che non si limita a indicare il tipo di file, come potrebbe sembrare: Tenendo premuto il tasto Comando (⌘) e facendo clic su questa icona, puoi accedere a un mini-menu che mostra la posizione del file sul tuo Mac. Questo può essere utile quando stai utilizzando più file duplicati e non ricordi esattamente dove hai salvato l’ultima versione del file.


Accanto all’icona del documento è indicato il nome del file. Se passi il puntatore del mouse sopra il nome del file, alla sua destra viene visualizzato un piccolo triangolo rivolto verso il basso. Facendo clic su questo triangolo viene visualizzata una piccola finestra a comparsa, in cui puoi modificare il nome del file, aggiungere tag con parole chiave/metadati per facilitare la ricerca del file utilizzando Spotlight, o perfino spostare il file in un’altra posizione sul tuo Mac.


[image: La finestra a comparsa per rinominare e spostare il file]


Personalizzazione della barra degli strumenti


Come già detto, la barra degli strumenti include di default una varietà di strumenti. Puoi comunque personalizzarla in base alle tue esigenze aggiungendo pulsanti ulteriori o riordinando quelli esistenti.




Per personalizzare la barra degli strumenti, seleziona Vista ▸ Personalizza barra strumenti oppure fai clic tenendo premuto il tasto Controllo sulla barra degli strumenti e scegli Personalizza barra strumenti. Quando esegui questa operazione, da sotto la barra degli strumenti appare un foglio con una serie di pulsanti collegati a diverse funzioni, che puoi trascinare sulla barra degli strumenti. Ad esempio, alla barra degli strumenti puoi aggiungere i pulsanti Raggruppa o Separa. Dopo aver completato le modifiche, fai clic su Fine.


[image: Personalizza la barra degli strumenti di OmniOutliner in base alla tua modalità di lavoro]

Se le modifiche che hai apportato non ti soddisfano, o se desideri ripristinare la barra degli strumenti allo stato di default, puoi semplicemente trascinare la riga in basso sopra la barra degli strumenti e quindi fare clic su Fine per salvare le modifiche. Le modifiche apportate alla barra degli strumenti vengono salvate insieme alle preferenze di OmniOutliner: di conseguenza, in ogni documento creato saranno visualizzate le stesse opzioni della barra degli strumenti.



(Pro Se disponi di OmniOutliner 4 Pro, puoi creare barre degli strumenti specifiche per il singolo documento scegliendo Vista ▸ Crea barra degli strumenti specifica per il documento.


[image: Utilizza spazi e spazi flessibili per organizzare in modo ottimale i pulsanti delle barre degli strumenti]

Partirai da una barra degli strumenti molto essenziale, che include solo la barra laterale e i pulsanti Impostazioni, insieme al pulsante “speciale” di spazio flessibile; a questa barra puoi aggiungere qualunque pulsante desideri. Se in un secondo momento vuoi rimuovere la barra degli strumenti personalizzata, scegli Vista ▸ Rimuovi barra strumenti specifica per il documento per tornare all’insieme di pulsanti di default.





Utilizzo del menu Azione della barra degli strumenti


Se hai personalizzato la barra degli strumenti in modo da includere il menu Azione, noterai che il suo funzionamento è leggermente diverso da quello del menu Azione del Browser delle risorse.




[image: Il menu Azione della barra degli strumenti]

Il menu Azione della barra degli strumenti include molte delle opzioni più comunemente utilizzate dei menu Modifica, Formato, Vista e Organizza. Anziché suddividerli in quattro diversi menu, abbiamo raccolto i comandi tendenzialmente più utilizzati in questo menu Azione compatto, comune a ogni documento di lavoro.



Inserimento di file come allegati


Le strutture non sono costituite solo da testo. In maggioranza sì, naturalmente, ma capiterà di voler inserire nel documento anche altri elementi: un’immagine, un filmato girato sul tuo iPhone, un file PDF, un altro file di OmniOutliner. Fortunatamente, OmniOutliner è in grado di gestire tutte queste esigenze.




Per allegare un file, puoi procedere in uno dei modi seguenti:



	Trascina l’elemento desiderato da qualsiasi posizione, inclusi file da una finestra del Finder o testo e immagini da una pagina web.

	Fai clic sull’icona a forma di graffetta sulla barra degli strumenti.

	Scegli Modifica ▸ Allega file.

	Fai clic sul menu Azione della barra degli strumenti e scegli Allega file.




Quando alleghi un file utilizzando un metodo diverso dal trascinamento in OmniOutliner, viene visualizzato un selettore di file molto simile a una finestra del Finder. Utilizza il selettore di file per individuare sul disco rigido del Mac il file da allegare.


[image: Scegli il file da allegare]

Nel selettore noterai due opzioni che influenzano la modalità con cui il file viene allegato al documento di OmniOutliner:



	Incorpora il file nel documento: l’opzione di default. Una copia del file allegato viene incorporata nel file di OmniOutliner attualmente in uso.

	Crea un link al file: anziché integrare un duplicato esatto del file, come con l’opzione precedente, nel documento di OmniOutliner viene copiata la posizione del file sul disco rigido del Mac.




La differenza tra le due opzioni potrebbe non essere evidente quando lavori sul tuo computer. Utilizzando ciascuna delle due opzioni, infatti, il file verrà comunque visualizzato all’interno della struttura: la differenza risulta invece evidente quando invii il documento di OmniOutliner a un altro utente. Ti consigliamo in quel caso di utilizzare l’opzione di default (Incorpora il file nel documento) in modo che il destinatario riceva anche l’allegato. Se scegli l’altra opzione, il destinatario visualizzerà unicamente un’icona e il nome del file allegato dal tuo Mac. Dato che il file si trova sul tuo Mac, gli altri utenti non saranno in grado di visualizzarlo o aprirlo.



Nota
 Se sei l’unica persona che utilizzerà i file di OmniOutliner, puoi valutare di utilizzare la seconda opzione (Crea un link al file) anziché incorporare gli allegati. L’opzione di collegamento riduce le dimensioni dei file di OmniOutliner (dato che il file allegato non è incluso), consentendo comunque di visualizzare e accedere agli allegati, che risiedono sul tuo Mac.


I problemi possono sorgere quando elimini un file allegato come link. In tal caso, verranno visualizzati unicamente l’icona e il nome del file, e nemmeno tu sarai in grado di visualizzare l’allegato.




Quando alleghi un’immagine o un file PDF, la relativa anteprima viene ridimensionata automaticamente in base alla larghezza della colonna in cui viene visualizzata. Altri tipi di file vengono visualizzati sotto forma di icona con il relativo nome.


[image: Vari file allegati, inclusi un’immagine, una clip video e un documento PDF]

Se fai clic su un’immagine o un file PDF allegato, viene visualizzato il seguente menu popover:


[image: Menu popover di un allegato]

Puoi optare per visualizzare l’allegato come immagine o come icona, e puoi modificare il Nome visualizzato del file allegato sostituendo il nome del file (visualizzato di default) con qualcosa di più indicativo. Per i file non di tipo immagine i pulsanti Mostra come immagine e Mostra come icona, nella parte superiore, non saranno disponibili. Per aprire il file, fai clic sul pulsante Apri con; ti verrà suggerita un’app da utilizzare in base al tipo di file allegato.


[image: Fai clic sul pulsante Apri con per aprire l’allegato]


Registrazione di audio


Tra le molte caratteristiche interessanti di OmniOutliner 4 ci sono i miglioramenti apportati alle funzionalità di registrazione audio. Per registrare, fai clic sul pulsante Inizia registrazione sulla barra degli strumenti, indicato da un microfono vecchio stile. OmniOutliner inizia a registrare non appena fai clic sul pulsante. Quando premi il pulsante, noterai che nell’interfaccia utente si verificano un paio di modifiche.




[image: La barra Registrazione consente di mettere in pausa, riprendere e salvare le clip audio nel documento di OmniOutliner]

Per prima cosa, il testo del pulsante del microfono sulla barra degli strumenti si modifica, passando da Inizia registrazione a Termina registrazione. È inoltre presente un piccolo pulsante Stop. L’altra modifica è relativa alla presenza della barra Registrazione, di colore rosso, appena sotto la barra degli strumenti, che gli utenti di OmniOutliner 2 per iPad riconosceranno immediatamente.


Al centro della barra Registrazione viene visualizzato un pulsante per mettere in pausa la registrazione (che, se premuto, modifica il colore della barra Registrazione impostandolo su grigio), e un pulsante con un segno di spunta (Salva) per interrompere la registrazione. Sulla barra grigia, noterai che Registrazione si modifica in In pausa, e che il pulsante Pausa viene sostituito dal pulsante Riprendi.


[image: I controlli di registrazione di OmniOutliner 4]

Fai clic sul pulsante Riprendi per continuare la registrazione dove l’avevi interrotta, oppure fai clic sul pulsante con il segno di spunta (Salva) per interrompere la registrazione. Quando interrompi la registrazione, una clip riproducibile tramite lettore audio viene visualizzata nella struttura.


[image: Le clip audio sono riproducibili all’interno di OmniOutliner]


Nota
 Facendo clic sul segno di spunta o sul pulsante Termina registrazione sulla barra degli strumenti si ottiene lo stesso effetto: la registrazione audio cessa e un file audio viene salvato nella struttura.




Proprio come avviene per gli allegati, se fai clic sul pulsante Info di una clip audio (la piccola icona i sul margine destro), viene visualizzato un popover con le opzioni di visualizzazione. Da qui puoi scegliere se visualizzare, per la clip audio, un’utilità di riproduzione (impostazione di default) o un’icona. Ancora più importante, puoi modificare il Nome visualizzato della clip audio, da una stringa di numeri casuali in qualcosa di più indicativo. Questo è particolarmente importante se scegli Mostra come icona nella parte superiore del popover.


[image: Fai clic sul pulsante Info della clip audio per modificarne il nome visualizzato, oppure per scegliere di visualizzarla come icona]


Suggerimento
 Se stai utilizzando OmniOutliner per prendere appunti durante una riunione, perché non registrare semplicemente quello che viene detto? In questo modo avrai a disposizione una registrazione audio completa della riunione all’interno dei tuoi appunti. OmniOutliner può registrare fino a sei ore di audio in un’unica clip.




Assicurati di consultare la sezione Preferenze di registrazione audio più oltre in questa guida per ulteriori informazioni sulle opzioni di registrazione audio in OmniOutliner.







Utilizzo della barra laterale


La barra laterale si trova lungo il margine sinistro della finestra di OmniOutliner. La barra laterale elenca i Contenuti della struttura unitamente agli Stili utilizzati. Nella parte superiore della barra laterale è inoltre presente un campo Cerca che facilita la ricerca all’interno delle varie strutture.




[image: La barra laterale di OmniOutliner elenca i contenuti e gli stili utilizzati nel documento]

La barra laterale è aperta di default, ma puoi nasconderla e/o visualizzarla scegliendo Vista ▸ Mostra/Nascondi barra laterale (Opzione-Comando-1), o facendo clic sul pulsante Barra laterale sulla barra degli strumenti. Le sezioni Contenuti e Stili scorrono in modo indipendente all’interno della barra laterale, consentendoti di gestire tutti i contenuti e gli stili utilizzati.


Se passi il puntatore del mouse sul margine destro della barra laterale, o sulla linea di divisione tra le sezioni Contenuti e Stili, noterai che il puntatore del mouse si trasforma in una maniglia di ridimensionamento. Fai clic e trascina la maniglia di ridimensionamento per ridimensionare la barra laterale o le sue sezioni.


[image: Fai clic e trascina le maniglie di ridimensionamento per ridimensionare la barra laterale o le sue sezioni]


Il pannello Contenuti


La metà superiore della barra laterale mostra il contenuto della struttura in un pannello scorrevole e comprimibile.




[image: La sezione Contenuti della barra laterale]



Sul margine sinistro delle righe con elementi figlio è presente un triangolo di apertura. Per visualizzare le righe figlio, fai clic su di esso e si aprirà l'elenco. Fai clic tenendo premuto Opzione per aprire o chiudere tutte le righe al suo interno.



Messa in evidenza dei contenuti di una struttura



Se hai una struttura piuttosto lunga, come quella relativa a un libro o a un articolo di ricerca, può capitare che tu voglia focalizzare la tua attenzione su una sezione specifica, senza farti distrarre da tutto il testo. Per fortuna, con OmniOutliner puoi farlo in un paio di modi diversi.






	
Nella barra laterale puoi fare clic su una sezione della struttura per evidenziarla: quando fai clic per selezionare una sezione dei Contenuti del documento, la vista struttura si modifica mettendo in evidenza solo quella riga e i suoi eventuali elementi figlio. 


[image: Fai clic su una riga nella barra laterale Contenuti per mettere in evidenza solo quella riga e i suoi eventuali elementi figlio]


	
In alternativa, mentre immetti testo nella struttura, puoi scegliere Vista ▸ Metti in evidenza (Maiuscole-Comando-F).

OmniOutliner conserva la cronologia delle righe messe in evidenza, che puoi scorrere all’indietro scegliendo Vista ▸ Annulla Metti in evidenza (Opzione-Maiuscole-Comando-F). Per tornare a visualizzare l'intero documento, scegli Vista ▸ Annulla tutte le operazioni Metti in evidenza o fai semplicemente clic ull'intestazione Contenuti nella barra laterale.







Nota
 In alternativa, puoi fare clic tenendo premuto il tasto Controllo sulle righe nel pannello Contenuti per aprire un menu contestuale che include le opzioni Metti in evidenza, Annulla Metti in evidenza e Annulla tutte le operazioni Metti in evidenza.





Aggiunta di sezioni e sottosezioni alla struttura nella vista Contenuti



Se selezioni una sezione nell'elenco Contenuti, per prima cosa OmniOutliner mette in evidenza quella sezione, per mostrare a destra solo la sezione e le eventuali sottosezioni, quindi evidenzia in grigio le sezioni messe in evidenza:





[image: I contenuti di una struttura con una sezione messa in evidenza]


Se desideri aggiungere un'altra sottosezione alla sezione selezionata, premi A capo. Viene visualizzata una nuova sottosezione alla fine dell'elenco e il cursore viene posizionato nella vista struttura per potervi inserire del testo.



[image: Aggiunta di una sottosezione a una sezione selezionata nella barra laterale Contenuti]


Ma come fare per creare una nuova sottosezione prima delle altre sottosezioni? Se fai clic per la seconda volta sulla sezione, questa e le relative sottosezioni vengono evidenziate in blu. 



[image: Facendo clic per la seconda volta su una sezione, questa e le sue sottosezioni vengono evidenziate in blu]


Premendo A capo viene inserita una nuova sottosezione in cima all'elenco di sottosezioni:



[image: Premi A capo per inserire una nuova sottosezione in cima all'elenco di sottosezioni]



Nota
 Tieni presente che la nuova sottosezione viene messa in evidenza in modo da poter immettere testo in quella riga.






Analogamente, se desideri aggiungere un'altra sezione allo stesso livello ma sopra la sezione attualmente selezionata, premi Maiuscole-A capo:



[image: Aggiunta di una sezione di pari livello a quella attualmente selezionata]


Ricerca all’interno della struttura


Il campo di ricerca integrato di OmniOutliner può essere molto utile quando devi individuare qualcosa all’interno della struttura in presenza di documenti particolarmente lunghi. Nella parte superiore del pannello Contenuti è presente una piccola icona a forma di lente di ingrandimento ([image: Il pulsante di ricerca]); fai clic su di essa per visualizzare la barra di ricerca. Puoi accedere al campo di ricerca anche selezionando Modifica ▸ Cerca ▸ Mostra ricerca (Opzione-Comando-F).




[image: OmniOutliner esegua la ricerca direttamente mentre digiti nel campo di ricerca]

OmniOutliner avvia la ricerca e adatta i relativi criteri in base a ogni carattere digitato; i risultati vengono visualizzati sotto la barra di ricerca. Fai clic sull’elemento ricercato per evidenziare la riga relativa nella struttura.


[image: Fai clic sull’elemento ricercato per evidenziare la riga relativa nella struttura]

Per eliminare il contenuto del campo di ricerca, premi Esc o fai clic sull’icona [image: pulsante Cancella ricerca] sul margine destro. Al termine della ricerca, fai clic su Fine. Il pannello Contenuti torna al suo stato precedente, visualizzando tutto il contenuto della struttura. Se in precedenza avevi evidenziato una particolare riga o sezione del documento, OmniOutliner ripristina il pannello Contenuti e la vista Struttura nello stato in cui si trovavano quando è stata annullata la ricerca. In alternativa puoi scegliere Modifica ▸ Cerca ▸ Nascondi ricerca (Opzione-Comando-F) per nascondere il campo di ricerca.



Il pannello Stili


La metà inferiore della barra laterale è costituita dal pannello Stili. Proprio come Contenuti, il pannello Stili scorre in modo indipendente all’interno della barra laterale. Include inoltre uno speciale pulsante (il pulsante Mostra/Nascondi Stili) che nasconde e visualizza il pannello Stili. 




Quando fai clic sul pulsante Mostra/Nascondi Stili, l’intero contenuto del pannello Stili viene nascosto, e il pulsante si sposta nell’angolo in basso a destra della barra laterale. Fai di nuovo clic sul pulsante per visualizzare nuovamente il pannello Stili. Questo è particolarmente utile nei casi in cui stai lavorando sulla struttura e desideri concentrarti solo su di essa nel pannello Contenuti.


[image: Il pannello Stili della barra laterale]

L’area sopra la linea di divisione mostra gli elementi con stili, cioè formattati, ([image: oo4mac_stylechit01]) o non formattati ([image: oo4mac_stylechit02]) del documento, incluso un elemento Documento intero. L’area sotto la linea di divisione include alcuni stili con nome, come intestazioni, opzioni per la messa in evidenza e un gruppo di colori di testo applicabili al contenuto del documento.


Gli stili stessi sono divisi in due categorie distinte, Stili documento e Stili con nome:



	Gli Stili documento, nella parte superiore del pannello Stili, includono tutti gli elementi cui è applicabile uno stile nel documento di OmniOutliner. Sono inclusi un elemento Documento intero, Titoli colonne, Note, una colonna Argomento e gli stili per le varie righe del documento. Gli stili di riga sono numerati in base al relativo livello di rientro, e vengono visualizzati nell’elenco man mano che vengono creati nella struttura.


	Gli stili con nome, sotto la linea di divisione dello stile, sono costituiti principalmente dagli stili di default inclusi con il modello di partenza. Gli stili con nome possono essere modificati selezionando prima il nome dello stile nel pannello Stili e quindi utilizzando la finestra di impostazioni Stile per modificare gli attributi di stile. Per creare un nuovo stile con nome, fai clic sul pulsante Aggiungi (+) nell’angolo in basso a sinistra del pannello Stili. Puoi eliminare gli stili con nome selezionando anzitutto lo stile dal pannello e quindi selezionando Elimina stile dal menu Azione nella parte inferiore della barra laterale.






Per acquisire famigliarità con il pannello Stili:



	Fai clic sul pulsante Mostra/Nascondi stili alcune volte di seguito per comprenderne il funzionamento.

	Fai clic sul pulsante Aggiungi (+) per creare un nuovo stile con nome.

	Fai clic sul pulsante Azione per aprire un mini-menu per creare nuovi stili con nome, duplicare o eliminare uno stile, copiare e incollare le proprietà di uno stile ed eliminare gli stili da una selezione.




Ti starai probabilmente chiedendo a cosa servono i quadratini colorati accanto agli stili nel pannello Stili. Questi quadratini sono definiti contrassegni di stile e tra poco ti mostreremo come funzionano.


[image: Un esempio di contrassegno di stile di OmniOutliner]

I contrassegni di stile forniscono una rappresentazione visiva dello stile:



	[image: oo4mac_stylechit01a]

	I contrassegni di stile con un motivo a scacchiera bicolore blu indicano che per l’elemento sono presenti varie proprietà di stile.


	[image: oo4mac_stylechit02a]

	Un contrassegno di stile vuoto con un bordo tratteggiato indica che per quella particolare riga o colonna non è presente alcuno stile. Questi elementi acquisiscono automaticamente lo stile Documento intero per il modello selezionato.


	[image: oo4mac_stylechit04]

	Un contrassegno di stile diviso in diagonale con una tonalità più scura nella metà superiore indica che alla selezione è applicato un colore di sfondo trasparente.


	[image: oo4mac_stylechit03] e [image: oo4mac_stylechit05]

	Quadrati a colore unico con la lettera A all’interno sono stili specifici per il testo, ad esempio il tipo di carattere e il relativo colore.






Nota
 Per maggiori dettagli su come creare e applicare stili documento e stili con nome, puoi scaricare il tutorial gratuito, Working in OmniOutliner da iBooks Store o dal nostro sito web.









Utilizzo delle finestre di impostazioni


Le finestre di impostazioni si trovano in una finestra mobile accessibile facendo clic sul pulsante Impostazioni [image: oo4mac_button_inspector] sul margine destro della barra degli strumenti. Per aprire la finestra Impostazioni puoi anche scegliere Finestra ▸ Mostra/Nascondi finestra impostazioni, o utilizzare l’abbreviazione da tastiera Maiuscole-Comando-I.




[image: Il pannello Impostazioni]

Per spostarti tra le finestre è sufficiente fare clic su una delle icone nella barra degli strumenti della finestra Impostazioni, lungo la parte superiore. Se non sei certo di quale pulsante apra quale finestra, passa il puntatore del mouse sopra il pulsante per visualizzare il nome della finestra, in corsivo, nella parte superiore della finestra Impostazioni.



Comportamento delle finestre di impostazioni


Prima di analizzare in dettaglio le operazioni possibili utilizzando le singole finestre, vale la pena dare una rapida occhiata a un paio di funzioni integrate che forse non conosci. 




Quando la finestra Impostazioni è aperta mentre lavori in una struttura a più colonne, la finestra di impostazioni Colonna viene visualizzata automaticamente ogni volta che selezioni un’intestazione di colonna. Questo facilita l’impostazione o la modifica del tipo di colonna e del suo comportamento di riepilogo.


Mentre lavori in OmniOutliner, noterai che ogni volta che inserisci testo in una cella di riga o colonna, la finestra di impostazioni Stile è sempre disponibile nella finestra Impostazioni. Tuttavia, se desideri visualizzare una finestra di impostazioni specifica mentre lavori, puoi fare doppio clic sull’icona della finestra in questione sulla barra degli strumenti della finestra Impostazioni. Nella finestra di impostazioni verrà visualizzato un lucchetto verde che indica che la finestra è sempre disponibile. Fai di nuovo doppio clic sulla finestra per sbloccarla.


[image: Utilizza il blocco della finestra di impostazioni per forzare la visualizzazione continuata di una finestra]

Questo risulta particolarmente utile quando desideri esaminare gli stili della struttura. Basta attivare il blocco per la finestra di impostazioni Attributi di stile e fare clic all’interno nel documento, per esaminare e modificare gli stili in base alle tue esigenze.



Finestra di impostazioni Stile [image: Pulsante per la finestra di impostazioni Stile]


Utilizza la finestra di impostazioni Stile quando desideri modificare l’aspetto delle righe nel documento.




[image: La finestra di impostazioni Stile]


	Stili di tipo

	Questa sezione della finestra di impostazioni Stili fornisce una serie di controlli per modificare l’aspetto del testo del documento:


	Tipo di carattere, dimensione e colore

	Consente di scegliere il font, la dimensione e il colore per il testo o la riga selezionata.


	Grassetto, Corsivo, Barrato e Sottolineato

	Fai clic per applicare gli stili di default Grassetto, Corsivo, Barrato o Sottolineato al testo o alla riga selezionata. Nella parte inferiore destra di questi pulsanti è visualizzato un minuscolo triangolo rivolto verso il basso, che indica se sono disponibili opzioni aggiuntive selezionabili. Puoi fare clic sulle frecce, oppure fare clic e tenere premuto il pulsante del mouse per visualizzare i menu degli attributi facoltativi:




[image: Fai clic sulle frecce negli angoli in basso a destra dei pulsanti Grassetto, Corsivo, Barrato e Sottolineato per visualizzare opzioni ulteriori per l’applicazione di stili al testo]



	Stili di paragrafo

	Consente di scegliere gli attributi per le righe all’interno del documento:


	Allineamento del testo

	La fila successiva di pulsanti viene utilizzata per allineare a sinistra, al centro, a destra o giustificare il testo.






	Altezza riga (Pro)

	Consente di scegliere tra una gamma di opzioni di spaziatura singola o doppia per il documento. L’altezza riga aggiunge spazio sopra il testo all’interno di una riga, mentre la spaziatura interna aggiunge spazio tra le righe.







	Sfondo

	Consente di impostare il colore di sfondo per la riga selezionata. Fai clic sulle frecce sul margine destro per scegliere uno dei preset presenti nel programma, o fai clic sulla barra dei colori per aprire la tavolozza Colori. Utilizza la tavolozza Colori per scegliere un colore personalizzato.




[image: Utilizza la tavolozza Colori per scegliere un colore personalizzato o un motivo da utilizzare per le righe di sfondo]



	Caratteristiche della riga

	Utilizza questi controlli per impostare le caratteristiche della riga:



	Maniglia (Pro)

	Determina se la maniglia di riga è sempre visibile, è visibile solo quando posizioni il mouse sopra la riga, o è sempre nascosta. Se le maniglie sono nascoste diventa leggermente più difficile trascinare e riorganizzare i tuoi contenuti; tuttavia, puoi utilizzare le opzioni Organizza ▸ Sposta per spostare le righe nelle varie direzioni.







	Numerazione

	Consente di scegliere uno stile di numerazione da utilizzare per le righe nel documento. Vedi Numerazione righe per ulteriori informazioni sugli stili di numerazione.


	Margine interno

	Consente di impostare un colore da utilizzare per il margine interno (l’area in cui vengono visualizzate la maniglia di riga e la casella di stato). Fai clic sulle frecce sul margine destro per scegliere uno dei preset presenti nel programma, o scegli Altro per aprire la tavolozza Colori.


[image: I colori di sfondo e del margine interno applicati a una riga]



	Lo scopo principale del colore del margine interno è aumentare la visibilità del livello di riga corrente. Come puoi vedere nell’immagine precedente, il margine interno si espande verso l’interno all’aggiunta di una o più righe figlio. Se imposti un colore di sfondo ma non un colore per il margine interno, quest’ultimo acquisisce automaticamente il colore di sfondo.









	Stili di spaziatura interna

	La spaziatura interna, a differenza dell’altezza riga, aggiunge spazio all’interno di righe, note e relativi elementi figlio:


	Spaziatura intera

	Consente di impostare la quantità di spazio (in pixel) sopra e sotto il testo all’interno della riga. A partire da OmniOutliner v4.1, Spaziatura interna è disponibile nelle versioni Standard e Pro.






	Sopra la nota (Pro)

	Consente di impostare la quantità di spazio sopra una nota in linea.


	Sopra i figli (Pro)

	Consente di impostare la quantità di spazio tra una riga padre e le relative righe figlio.


	Sotto i figli (Pro)

	Consente di impostare la quantità di spazio sotto le righe figlio di una riga padre.












	Interruzione di pagina (Pro)

	Consente di scegliere se inserire un’interruzione di pagina prima di una riga:


	Inizia nuova pag. (Pro)

	Determina se la riga attualmente selezionata imposta l’inizio di una nuova pagina. Quando selezioni questa opzione, sopra la riga viene visualizzata una linea rossa tratteggiata. Questa linea è inserita specificatamente ai fini della stampa o dell’esportazione in PDF.











	Rientro (Pro)

	Consente di scegliere se le righe figlio sono rientrate:


	Rientro figli

	Consente di scegliere se impostare il rientro degli elementi figlio di una riga. Se scegli di non applicare il rientro, potrebbe essere difficile distinguere riga padre e righe figlio. Può quindi essere utile applicare un diverso stile alle righe figlio, magari con un colore di sfondo o una tonalità diversa, riducendo la dimensione del carattere e così via.











	Stili con nome

	Consente di scegliere uno stile con nome da applicare:


	Stili inclusi

	Questo menu a comparsa consente di selezionare e applicare uno degli stili con nome, elencati nella parte inferiore della sezione Stili della barra laterale.








Finestra di impostazioni Colonna [image: Pulsante per la finestra di impostazioni Colonna]


La finestra di impostazioni Colonna include due menu a comparsa per l’impostazione degli attributi di colonna:





	Tipo

	L’impostazione di default per le nuove colonne è sempre RTF; tuttavia, è possibile modificarla in base ai requisiti della struttura, impostando una delle opzioni seguenti:


	Casella di controllo

	A differenza delle caselle di controllo di stato, parte integrante della colonna principale Argomento, le colonne Casella di controllo possono essere utilizzate per vari scopi, come semplici caselle di spunta, per monitorare lo stato di un elemento, e perfino per attribuire valutazioni. È possibile aggiungere un numero illimitato di colonne di questo tipo, nonché visualizzarle o nasconderle come necessario, mediante le opzioni disponibili in Vista ▸ Colonne.


	
Se utilizzati in combinazione con le funzionalità di ordinamento di OmniOutliner (Organizza ▸ Mantieni ordinato o Organizza ▸ Ordina struttura), le caselle di controllo possono essere utilizzate per indicare uno stato Sì o No (binario) praticamente per qualsiasi tipo di elemento: confronti, elementi da rivedere e così via.



	Data

	Consente di scegliere un formato di data e ora (facoltativo) da utilizzare nella colonna. La stringa di data di default si basa sulle impostazioni locali, configurate in Preferenze di Sistema ▸ Lingua e Zona. Tra le molte funzionalità aggiunte a OmniOutliner 4 è inclusa una logica di analisi della data nuova e migliorata, che consente di digitare ad esempio oggi, ieri, 2g, settembre, gio, -5s in una colonna di data e ottenere la corrispondenza desiderata.


	
Utilizza il menu Formato per scegliere le modalità di visualizzazione di data e ora in una colonna di data. Puoi scegliere tra una stringa di ora Breve, Media o Estesa, oppure optare per qualcosa di più tecnico, come ISO 8601 (UTC).



	
[image: Scegli un formato di data e ora da utilizzare nella colonna]


	
Le opzioni e i formati di default non ti soddisfano? Scegli Formato personalizzato per creare una stringa di data e ora personalizzata da utilizzare per una colonna di data.



	
[image: Crea un formato di data e ora personalizzato da utilizzare per una colonna di data]


	
Per utilizzare l’Editor formato data è sufficiente trascinare i componenti desiderati per la stringa di data/ora nel campo situato nella parte superiore della finestra di dialogo. Per gli elementi, come Giorno della settimana o Mese, sono disponibili altri formati che è possibile scegliere facendo clic sulla freccia rivolta verso il basso. Di default, nel formato personalizzato vengono utilizzate le barre (/) come delimitatore, ma è possibile inserire un altro carattere (o più) o rimuoverli del tutto.



	Durata

	Utilizza una colonna Durata per stimare o tenere traccia della quantità di tempo richiesta da un’attività o da un progetto. Se, ad esempio, stai utilizzando OmniOutliner per creare un elenco di tutte le attività che vuoi svolgere questo fine settimana, puoi utilizzare una colonna Durata per stimare quanto tempo richiederà catalogare la tua collezione di fumetti, e se è il caso di dare la priorità a quell’attività rispetto all’imbiancatura del garage.


	
[image: Scegli Durata come tipo di colonna quando desideri tenere traccia o stimare eventi a tempo]


	
Utilizza il menu a comparsa Impostazioni per selezionare Ore lavorative, Tempo globale o per utilizzare una durata personalizzata a tua scelta. OmniOutliner formatta la durata in base all’impostazione selezionata; ad esempio, 12h in tempo globale è equivalente a 1g 4h di ore lavorative (ipotizzando una giornata lavorativa di 8 ore). Se attivi il Formato esteso, OmniOutliner indica le durate per esteso; ad esempio, 1g 4h diventa 1 giorno 4 ore.



	
Utilizza ore al giorno, ore alla settimana e ore al mese per ottimizzare le impostazioni di durata in base alle tue esigenze. Ad esempio, c’è chi preferisce una normale giornata lavorativa di 8 ore, e chi (come i membri di uno studio legale o pubblicitario) lavora magari 80 ore alla settimana.



	Numero

	Scegli Numero come tipo di colonna in caso di valori numerici da monitorare.


	
[image: Scegli Numero come tipo di colonna per tenere traccia in modo preciso di numeri, percentuali o valori in valuta]


	
Utilizzando il menu a comparsa Formato puoi scegliere tra:



	9.999,99: numeri con due cifre decimali. Per valori elevati, verrà utilizzato un punto per separare le migliaia.

	9999,99: numeri con due cifre decimali.

	10000: numeri interi; i decimali vengono arrotondati per eccesso o per difetto al numero intero più vicino. Ad esempio, 2,67 viene arrotondato per eccesso a 3; 3,14 viene arrotondato per difetto a 3.

	10000%: percentuali intere; i decimali vengono arrotondati per eccesso o per difetto al numero intero più vicino. Ad esempio, 2,67% viene arrotondato per eccesso a 3%, 3,14% viene arrotondato per difetto a 3.

	99,99%: percentuali con due cifre decimali (quando necessarie). Ad esempio, 99,00% viene visualizzato come 99%; 3,14159% viene arrotondato a 3,14%.

	$ 9.999,99: utilizza questa opzione per rappresentare valori in valuta in base ai valori localizzati impostati in Preferenze di Sistema ▸ Lingua e Zona ▸ Regione. Ad esempio, se la regione è impostata su Asia ▸ Giappone, al valore in valuta sarà associato il simbolo dello Yen (¥).





	Elenco a comparsa

	Scegli il tipo Elenco a comparsa per una colonna con “opzioni” ripetute tra le quali scegliere. Ad esempio, per un modello di documento per la creazione di ricette, può essere utile creare una colonna Misure con opzioni come oncia, once, grammo e grammi (per citarne solo alcune). Quando inserisci una quantità potrai semplicemente selezionare l’opzione applicabile dall’Elenco a comparsa, anziché dover immettere il testo più volte.


	
[image: Scegli il tipo Elenco a comparsa per una colonna con opzioni ripetute tra le quali scegliere]


	
Per le celle a comparsa viene oggi utilizzata la tecnologia Smart Match di OmniFocus. Mentre digiti, OmniOutliner tenta di prevedere la tua scelta... e non è necessario che i caratteri immessi si trovino all’inizio della parola o siano contigui.



	
[image: La tecnologia Smart Match facilita l’individuazione dell’opzione ricercata in un elenco a comparsa]


	
Non solo: se immetti un nuovo termine che non sia già definito come parte dell’elenco, puoi premere Comando-A Capo per aggiungerlo all’elenco.



	RTF

	Scegli RTF per il testo normale; si tratta dello stile di default per le nuove colonne.


	
[image: Scegli RTF per tutte le esigenze di inserimento di testo]





	Riepilogo

	La cosa principale da sapere sui Riepiloghi colonna è che vengono visualizzati solo nella riga padre di un gruppo. Ad esempio, se scegli Riepilogo ▸ Totale in un documento con due colonne che include informazioni sui prezzi per una serie di pezzi di cui hai bisogno, ti verrà spontaneo chiederti “Dov’è il totale?”. Ma se raggruppi le righe selezionandole e scegliendo Organizza ▸ Raggruppa (Opzione-Comando-G), vedrai succedere qualcosa di interessante.


	
[image: I riepiloghi sono visualizzati nella riga padre di un gruppo di righe figlio]


	
In primo luogo, noterai che a tutte le righe selezionate è stato applicato un rientro rispetto a una nuova riga padre. In quella riga padre, il totale viene visualizzato nella colonna con tutte le informazioni sui prezzi, ma con uno sfondo grigio applicato alla cella. Lo sfondo grigio è un livello trasparente di colore nero, che scurisce leggermente il colore di sfondo assegnato allo stile della riga.



	
Le opzioni del menu a comparsa Riepilogo variano in base alle selezioni eseguite nel menu a comparsa Tipo:



	Casella di controllo

	Tra le opzioni di Riepilogo:


	Nessuno

	Non viene visualizzato alcun riepilogo; nella cella di riepilogo è presente una casella di controllo che funziona in modo completamente indipendente dai relativi elementi figlio.


	Stato

	Mostra una casella di controllo vuota se nessun elemento è stato selezionato; una casella di controllo con un trattino all’interno se sono stati selezionati alcuni elementi; oppure una casella di controllo piena, se tutti gli elementi sono stati selezionati.


	Nascosto

	La cella di riepilogo è vuota, indipendentemente dallo stato delle altre caselle della colonna.





	Data

	Tra le opzioni di Riepilogo:


	Nessuno

	Nessun riepilogo.


	Minimo

	Nella cella di riepilogo viene visualizzata la data (o ora) meno recente nella colonna per le righe figlio.


	Massimo

	Nella cella di riepilogo viene visualizzata la data (o ora) più recente nella colonna per le righe figlio.


	Nascosto

	La cella di riepilogo è vuota.





	Durata

	Tra le opzioni di Riepilogo:


	Nessuno

	Nessun riepilogo.


	Totale

	Nella cella di riepilogo viene visualizzato il totale di tutte le celle nella colonna.


	Minimo

	Nella cella di riepilogo viene visualizzata la durata minima nella colonna.


	Massimo

	Nella cella di riepilogo viene visualizzata la durata massima nella colonna.


	Medio

	Nella cella di riepilogo viene visualizzata la durata media per gli elementi figlio della riga padre nella colonna.


	Nascosto

	La cella di riepilogo è vuota.





	Numero

	Tra le opzioni di Riepilogo:


	Nessuno

	Nessun riepilogo.


	Totale

	Nella cella di riepilogo viene visualizzato il totale di tutte le celle nella colonna.


	Minimo

	Nella cella di riepilogo viene visualizzato il numero minimo nella colonna.


	Massimo

	Nella cella di riepilogo viene visualizzato il numero massimo nella colonna.


	Medio

	Nella cella di riepilogo viene visualizzato il numero medio per gli elementi figlio della riga padre nella colonna. La media è relativa solo ai discendenti: vengono quindi considerate tutte le righe incluse senza elementi figli, indipendentemente dal numero di livelli di nidificazione.


	Nascosto

	La cella di riepilogo è vuota.





	Elenco a comparsa

	Tra le opzioni di Riepilogo:


	Minimo

	Se l’elenco a comparsa contiene numeri, nella cella di riepilogo viene visualizzato il numero minimo utilizzato nella colonna. Se l’elenco a comparsa contiene testo, la cella di riepilogo utilizza la prima voce nella finestra di impostazioni Colonna.


	Massimo

	Se l’elenco a comparsa contiene numeri, nella cella di riepilogo viene visualizzato il numero massimo utilizzato nella colonna. Se l’elenco a comparsa contiene testo, nella cella di riepilogo viene visualizzata l’ultima voce nella finestra di impostazioni Colonna.


	Nascosto

	La cella di riepilogo è vuota.





	RTF

	Tra le opzioni di Riepilogo:


	Nessuno

	Nessun riepilogo.


	Nascosto

	La cella di riepilogo è vuota.











Finestra di impostazioni Struttura [image: Pulsante per la finestra di impostazioni Struttura]


Utilizza la finestra di impostazioni Struttura quando desideri modificare gli stili che influenzano la struttura nel suo complesso, piuttosto che singoli stili applicabili a una parte specifica della struttura.




[image: La finestra di impostazioni Struttura]


	Righe alternate

	Utilizza l’opzione Righe alternate per impostare un colore di sfondo a righe alternate nel documento. Puoi scegliere tra una delle opzioni di colore preimpostate (Grigio chiaro, Verde chiaro o Blu chiaro), o fare clic sulla barra dei colori a lato per scegliere un colore personalizzato o un motivo di sfondo dalla tavolozza Colori.


	Griglia orizzontale

	Utilizza l’opzione Griglia orizzontale per aggiungere una linea sottile di colore tra le righe del documento. Puoi scegliere tra una delle opzioni di colore preimpostate (Grigio chiaro, Grigio scuro, Verde chiaro, Verde scuro, Blu chiaro, Blu scuro, Rosso chiaro, Rosso scuro), o fare clic sulla barra dei colori a lato per scegliere un colore personalizzato o un motivo di sfondo dalla tavolozza Colori.


	Griglia verticale

	Utilizza l’opzione Griglia verticale per aggiungere una linea sottile di colore tra le colonne del documento. Puoi scegliere tra una delle opzioni di colore preimpostate (Grigio chiaro, Grigio scuro, Verde chiaro, Verde scuro, Blu chiaro, Blu scuro, Rosso chiaro, Rosso scuro), o fare clic sulla barra dei colori a lato per scegliere un colore personalizzato o un motivo di sfondo dalla tavolozza Colori.


	Intestazioni colonna

	Consente di visualizzare o nascondere le intestazioni di colonna. L’opzione Automatico mostra il testo eventualmente inserito per un’intestazione, ma nasconde l’intestazione Argomento generica se nel documento è presente una sola colonna. Puoi eseguire la stessa operazione anche scegliendo Vista ▸ Intestazioni colonna ▸ Mostra/Automatico/Nascondi.





Utilizzo delle righe e delle colonne della griglia per modelli creativi


Puoi combinare la griglia orizzontale e verticale per creare documenti simili a un foglio quadrettato. Basta aggiungere un’altra colonna e quindi modificare la dimensione del carattere per le intestazioni di colonna. Otterrai qualcosa di simile a questo:


[image: Ti serve un blocco per prendere appunti? Eccolo qua.]

Naturalmente, è stata necessaria qualche modifica (a dire il vero, nemmeno troppe), ma il concetto è chiaro: OmniOutliner facilita al massimo la personalizzazione dei documenti e la creazione di modelli che si adattano a ogni tua esigenza.






	Mostra stato riga

	Scegli questa opzione se desideri visualizzare le caselle di stato sul lato sinistro di ogni riga. Si tratta di elementi diversi dall’opzione Casella di controllo che puoi impostare su una colonna, in quanto le caselle di stato sono sempre situate sul margine sinistro e seguono il livello di rientro delle righe.


	Note in linea

	Questi pulsanti consentono di decidere se le note in linea andranno a capo in base alla prima colonna del documento, o se occuperanno la larghezza di tutte le colonne. Le note in linea, alle quali viene applicato lo stile Note, sono visualizzate sotto il testo immesso in una riga.






	

	
(Pro) Se disponi di OmniOutliner Pro, puoi fare in modo che le note in linea siano visualizzate in un pannello separato nella parte inferiore della struttura (Vista ▸ Note ▸ Mostra nel pannello).










	Rientro righe figlio (Pro)

	Questo menu a comparsa consente di scegliere il livello di rientro delle righe figlio. È possibile scegliere tra una delle opzioni di default (0, 8, 16 o 24 pixel), oppure immettere un valore a scelta e premere A capo.







Finestra di impostazioni Documento [image: Pulsante per la finestra di impostazioni Documento]


Utilizza la finestra di impostazioni Documento per specificare informazioni aggiuntive (metadati) sul documento in uso. Le informazioni incluse qui rimangono associate al documento e ne facilitano la ricerca all’interno del tuo Mac mediante Spotlight.




[image: La finestra di impostazioni Documento]

La prima opzione nella finestra di impostazioni Documento, Comprimi su disco, determina la modalità di salvataggio del documento di Outliner. Questa opzione è specifica per il documento, il che significa che è possibile attivarla o meno a seconda delle esigenze.


Se selezioni questa casella, OmniOutliner utilizza una semplice compressione Zip per ridurre al minimo le dimensioni dei file. I file compressi non solo occupano meno spazio sul disco rigido, ma possono anche essere inviati più facilmente via e-mail.


Se l’opzione Comprimi su disco rimane deselezionata, i file non vengono compressi e occupano una quantità maggiore di spazio (come indicato nel Finder). Può essere opportuno lasciare deselezionata questa opzione se stai salvando i file di OmniOutliner in un sistema di controllo delle versioni o di gestione documentale, o per facilitare l’esecuzione di script (Python, Ruby e così via) sul codice XML all’interno del documento. 


I campi di metadati della finestra di impostazioni Documento includono:



	Copyright

	Le note sul copyright indicano in genere il titolare dei diritti legali per una determinata risorsa. In questo caso, il titolare sarai tu oppure la tua azienda.


	Versione

	I numeri di versione sono utilizzati per indicare un determinato “stato” di un progetto. Ad esempio, 0.1 potrebbe essere una beta, 1.0 una release iniziale. Puoi anche aggiungere un numero di versione secondaria, come 4.0.1, ad esempio quando correggi un errore di battitura o similari. La scelta è tua.


	Oggetto

	Simile all’oggetto di un messaggio e-mail, ad esempio Assegnazioni personale per OmniOutliner 5, oppure Ricetta pollo fritto.


	Descrizione

	Il contenuto del file di OmniOutliner. Ad esempio, Elenco pezzi bicicletta, o Attori che hanno interpretato Batman.


	Commenti

	Nel campo Commenti puoi inserire informazioni aggiuntive sul file in uso. Ad esempio, puoi indicare dettagli aggiuntivi su un progetto cui questo file è associato, o appunti a te riservati su altri elementi da aggiungere al file.




Sotto il campo Commenti noterai un menu a comparsa impostato su Autori. Questo menu funziona in combinazione con il riquadro combo sottostante, per la creazione di coppie di attributi/valori di metadati. Cosa dici? Troppo complicato? Va bene, cerchiamo di spiegarci meglio.



I metadati, come forse saprai, sono minuscoli frammenti di informazioni “incorporate” che è possibile includere in file, immagini e perfino registrazioni audio e video. OS X utilizza questi metadati per le funzionalità di ricerca sul tuo Mac, indicizzando queste informazioni e rendendole disponibili a Spotlight. Le informazioni di metadati inserite qui, tuttavia, sono composte da due elementi: un attributo e il suo valore. In questo caso, gli attributi sono le opzioni presenti nel menu a comparsa: Autori, Organizzazioni, Lingue, Parole chiave o Progetti. Arriviamo al dunque: Come valore (o valori) per quegli attributi puoi inserire qualsiasi cosa ti venga in mente! Quel che è importante capire è che, una volta inseriti, l’attributo e il suo valore sono legati tra loro, un po’ come Arnold Schwarzenegger e Danny DeVito nel film I gemelli. Una volta combinati, formano una squadra imbattibile quando si tratta di aggiungere metadati univoci ai tuoi documenti.




Ecco come creare una copia valore/attributo di metadati utilizzando il menu a comparsa e il riquadro combo:



	Seleziona una delle opzioni nel menu a comparsa (Autori, Organizzazioni, Lingue, Parole chiave o Progetti, come descritti in maggiore dettaglio più avanti).


	Fai clic sul pulsante Aggiungi (il segno +) nella parte inferiore della finestra di impostazioni Documento.

[image: Utilizza il menu a comparsa con il riquadro combo per aggiungere metadati ulteriori al file di OmniOutliner]
Quando fai clic su Aggiungi, lo stato attivo passa alla casella al centro, dove puoi immettere informazioni sull’elemento selezionato nel menu a comparsa.

[image: Fai clic su Aggiungi (il pulsante con il segno più) e quindi inserisci la parola chiave per completare la coppia valore/attributo di metadati]


	Quando hai completato l’immissione di testo, premi Tabulazione o A capo per salvare le informazioni di metadati nel file.





Se in un secondo momento desideri rimuovere un elemento, selezionalo con il mouse e quindi fai clic su Rimuovi (il pulsante -, accanto al pulsante Aggiungi). Per modificare un elemento esistente, fai doppio clic per evidenziare il testo, quindi apporta le modifiche desiderate e premi Tabulazione o A capo per salvarle.


Le opzioni nel menu a comparsa includono (a tutte possono corrispondere più voci):



	Autori

	Il nome dell’utente che ha creato il documento. Puoi essere tu, tu e un tuo collega, oppure tu e il tuo gatto Gilles, che non voleva saperne di scendere dalla scrivania mentre stavi lavorando alle 2 di notte (naturalmente, i tuoi colleghi potrebbero domandarsi perché questo “Gilles” abbia lavorato a un progetto riservato... ma è un problema di cui si occuperanno i tuoi avvocati).


	Organizzazioni

	Inserisci il nome della tua azienda o dell’organizzazione per la quale il documento è stato creato.


	Lingue

	Immetti la lingua, ad esempio Inglese o Giapponese, o utilizza uno dei codici lingua ISO 639, ad esempio en o jp.


	Parole chiave

	Qui comincia il divertimento. Le parole chiave sono l’elemento che più di tutti contribuisce alla ricercabilità dei tuoi file. Questo perché puoi aggiungere a ogni file un numero quasi illimitato di parole chiave di ogni tipo. La chiave (sì, siamo spiritosi) è che le parole chiave contribuiscono a rendere ogni documento unico quando si tratta di cercare i file con Spotlight.


	Progetti

	Se hai creato un file di Outliner per un progetto specifico, puoi immetterne qui il nome.





Suggerimento
 Se stai utilizzando altre applicazioni Omni, come OmniGraffle o OmniPlan, puoi immettere metadati simili nelle finestre di impostazioni Documento per quelle applicazioni. Supponiamo che tu stia monitorando un progetto in OmniPlan, creando grafici e diagrammi in OmniGraffle e gestendo il tuo elenco di attività in OmniFocus: per ogni progetto potrai immettere informazioni simili. In questo modo, se esegui una ricerca in Spotlight per un particolare progetto, basterà inserirne il nome nel campo di ricerca per visualizzare tutti i documenti correlati (anche se non siano stati salvati nella stessa posizione).




Come già detto in precedenza, le informazioni immesse in questi campi, e attraverso il menu a comparsa, vengono registrate sul tuo Mac come metadati aggiuntivi per quel particolare file di OmniOutliner. Quando esegui una ricerca in Spotlight, facendo clic sul menu Spotlight nella barra dei menu (o utilizzando Comando-Spazio), tutte le informazioni inserite nella finestra di impostazioni Documento faciliteranno la ricerca del file.


Di conseguenza, anziché aprire una finestra del Finder e tentare di ricordare dove hai nascosto quel file riservatissimo, puoi premere Comando-Spazio, immettere una delle parole chiave, o un altro elemento che consenta di identificare il file, e Spotlight lo visualizzerà nei risultati della ricerca.


[image: I metadati inseriti nella finestra di impostazioni Documento facilitano il reperimento dei file sul tuo Mac]

Per aprire il file, selezionalo con il mouse e premi A capo.



Suggerimento
 In realtà, Spotlight funziona con tutti i file presenti sul tuo Mac, non solo con i file di OmniOutliner cui hai assegnato metadati. Spotlight è un servizio a livello di sistema che cataloga automaticamente i file sul tuo Mac, per consentirti di trovare rapidamente tutti i file di cui hai bisogno.





Finestra di impostazioni Attributi di stile [image: Pulsante per la finestra di impostazioni Attributi di stile]


A una prima occhiata, l’aspetto della finestra di impostazioni Attributi di stile potrebbe ingannare: una finestra all’apparenza innocua, che mostra tutti gli stili nel documento, è in realtà uno strumento estremamente potente. 




[image: La finestra di impostazioni Attributi di stile]

Gli stili vengono visualizzati in questa finestra man mano che li applichi alle righe e alle colonne nel file di OmniOutliner. Il contenuto della finestra di impostazioni Attributi di stile dipende dalla posizione del cursore all’interno del documento. Nell’immagine precedente il cursore si trova su una Riga livello 2, e il testo in tutte le righe di livello 2 deve essere formattato come testo a 14 punti con un colore Gesso (ovvero bianco).


Supponiamo però che al testo nelle righe livello 1 debba essere applicato lo stesso colore. Il modo più semplice per applicare questo stile è fare clic sul quadratino colorato al centro della finestra di impostazioni e quindi trascinarlo sullo stile Righe livello 1 nel pannello Stili della barra laterale. Il testo per tutte le righe livello 1 è ora dello stesso colore bianco e della stessa dimensione (14 punti). In questo modo puoi provare a utilizzare stili diversi con grande facilità. E ricorda: se la modifica che hai eseguito non ti convince, puoi premere Comando-Z per annullarla, e tutto tornerà come prima.


A rendere la finestra di impostazioni Attributi di stile particolarmente utile, tuttavia, è il fatto che l’ordine degli stili visualizzati corrisponde alla loro priorità di applicazione alla selezione. Questo ti consente di vedere come viene “calcolato” lo stile dell’elemento selezionato, e di comprendere perché ha un determinato aspetto. Inoltre, puoi fare clic sul piccolo pulsante [image: cancella stile] a destra per eliminare tutti gli stili, senza dover andare alla ricerca del controllo utilizzato per impostarli.







Stampa da OmniOutliner


Che tu abbia terminato di lavorare sul documento di OmniOutliner, o desideri verificare gli stili e la formattazione prima di finalizzare una struttura, una delle operazioni che vorrai eseguire sarà probabilmente la stampa della struttura. Da questo punto di vista OmniOutliner ha una serie di assi nella manica che possono rendere il tuo modulo stampato ancora più gradevole.




Per stampare, scegli File ▸ Stampa o utilizza l’abbreviazione da tastiera standard Comando-P. Verrà visualizzata la finestra di dialogo di stampa standard del tuo Mac ma, come detto, al pannello di stampa abbiamo aggiunto un paio di funzioni specifiche di OmniOutliner.


[image: Il pannello di stampa di OmniOutliner]

Questo capitolo ti guida attraverso le complessità del foglio di stampa, e ti mostra come personalizzare l’output di stampa del tuo documento OmniOutliner.



Nozioni di base relative al foglio di stampa


Quando scegli File ▸ Stampa (Comando-P), viene visualizzato il foglio di stampa di OmniOutliner, che include tre sezioni:





	Anteprima di stampa a sinistra

	Impostazioni stampante in alto a destra

	Le opzioni di stampa a destra, sotto il menu a comparsa centrato




[image: Il pannello di stampa di OmniOutliner]

Nell’area Impostazioni stampante è possibile scegliere una stampante sulla rete locale e un preset, definire il numero di copie da stampare e se stampare su entrambi i lati del foglio, e se stampare l’intero documento o un intervallo di pagine specifico. Indipendentemente dalle impostazioni nel menu a comparsa, la sezione Impostazioni stampante non si modifica.


Di default, il menu a comparsa è impostato su Contenuti, rivelando le opzioni di stampa specifiche del documento. La sezione Opzioni di stampa si modifica in base all’opzione selezionata nel menu a comparsa. Le modifiche apportate nella sezione Opzioni di stampa influiscono sull’aspetto dell’Anteprima di stampa.



Opzioni di stampa di OmniOutliner


Come risulta evidente dal menu a comparsa sotto la sezione delle impostazioni di stampa, abbiamo personalizzato il foglio di stampa con una serie di opzioni specifiche per OmniOutliner.




[image: Opzioni di stampa specifiche per i documenti di OmniOutliner]

Sul lato sinistro del pannello di stampa vedrai una replica esatta del documento di OmniOutliner, che ne mostra l’aspetto una volta stampato. Puoi utilizzare i pulsanti freccia sotto l’anteprima per scorrere il documento e verificare che tutto sia in ordine.


Mentre abiliti e disabiliti le varie opzioni, l’Anteprima di stampa si modifica di conseguenza. L’unica eccezione è rappresentata dall’opzione Includi note. Se desideri che le note nella struttura vengano stampate, dovrai assicurarti che siano visibili nel documento scegliendo Vista ▸ Mostra tutte le note (Controllo-Comando-'). Se non desideri stampare tutte le note, puoi selezionare righe specifiche e scegliere Vista ▸ Mostra nota (Opzione-Comando-') per rivelare la nota per quella riga.




Suggerimento
 Se avevi scelto di visualizzare tutte le note della tua struttura, puoi anche mostrare o nascondere note specifiche. A questo scopo, seleziona la riga con la nota che desideri nascondere, e scegli Vista ▸ Nascondi nota (Opzione-Comando-') per nascondere la nota. Questo è particolarmente utile quando in una struttura sono presenti più note, ma desideri nasconderne alcune prima di stampare o di generare un file PDF.





OmniOutliner stampa solo le colonne visibili nel documento. Se non desideri stampare una particolare colonna, scegli Vista ▸ Colonne e quindi seleziona dal sottomenu la colonna da nascondere. In questo modo la colonna viene deselezionata nel menu. Puoi anche fare clic tenendo premuto il tasto Controllo su un’intestazione di colonna e quindi scegliere Nascondi dal menu contestuale. Per visualizzare di nuovo la colonna nel documento, scegli Vista ▸ Colonne ▸ Mostra tutte le colonne.




Suggerimento Pro
 Se utilizzi OmniOutliner Pro, puoi aggiungere interruzioni di pagina manuali utilizzando la finestra di impostazioni Stili.






Altre opzioni di stampa disponibili attraverso il menu a comparsa


Fai clic sul menu a comparsa per visualizzare un’altra serie di opzioni di stampa; per ora ci concentreremo su Intestazioni e piè di pagina e su Margini.




[image: Il menu a comparsa Opzioni di stampa, espanso]


Applicazione di intestazioni e piè di pagina alla struttura


Le impostazioni di stampa Intestazioni e piè di pagina consentono di aggiungere dettagli relativi al documento di OmniOutliner nella parte superiore e inferiore della pagina stampata. Le sei caselle (tre per le intestazioni e tre per i piè di pagina) rappresentano le aree sinistra, centrale e destra della pagina. Utilizza il menu a comparsa appena sopra la sezione Intestazioni per applicare le intestazioni e i piè di pagina a Pagina principale, Prima pagina, Pagine dispari o Pagine pari. Utilizza il menu a comparsa Inserisci appena sotto la casella più a destra per inserire uno o più dei seguenti elementi:





	Numero di pagina

	Titolo sezione

	Ora di ultima modifica

	Conteggio pagine

	Titolo documento

	Nome del documento

	Ora di stampa




[image: Opzioni di stampa per intestazioni e piè di pagina]

È sufficiente fare clic all’interno di una delle sei caselle e scegliere l’opzione dal menu Inserisci. Ad esempio, l’immagine seguente rappresenta l’inserimento di Titolo documento e Ora di stampa nella casella centrale e destra dell’intestazione, rispettivamente. Per il piè di pagina, la casella centrale utilizza una combinazione di Numero di pagina e di Conteggio pagine (con la parola “di” aggiunta nel mezzo), che nella stampa verrà visualizzata come 1 di 3 o 2 di 3, e che risulta particolarmente utile per i documenti con un numero elevato di pagine.


[image: Un esempio di come puoi configurare le intestazioni e i piè di pagina per la stampa in un documento di OmniOutliner]


Impostazione dei margini di pagina


Utilizza le opzioni di stampa Margini per controllare l’aspetto del contenuto del documento all’interno dei limiti di una pagina stampata. I controlli Superiore e Inferiore consentono di impostare la distanza dal margine della pagina per eventuali intestazioni o piè di pagina applicati, e tra intestazione e piè di pagina e il contenuto effettivo. Per modificare uno qualsiasi dei valori di margine puoi fare clic nella casella e digitare un diverso valore, o utilizzare le frecce a destra per aumentare o ridurre il valore.




[image: Impostazione dei margini per il documento]


Una volta terminata la configurazione di tutte le Opzioni di stampa per il documento, fai clic su Stampa per stampare il file.








Preferenze


Ora che hai avuto la possibilità di acquisire famigliarità con l’interfaccia di OmniOutliner 4, dedichiamo un po’ di tempo a esaminare le preferenze dell’app. Per aprire il pannello delle preferenze di OmniOutliner scegli OmniOutliner ▸ Preferenze, oppure utilizza la comodissima abbreviazione da tastiera Comando-virgola (⌘-,). I sei pannelli delle preferenze sono utilizzabili per personalizzare ulteriormente OmniOutliner 4 in base alle tue esigenze e al tuo stile di lavoro.




Ogni pannello delle preferenze include un pulsante Ripristina ([image: oo4mac_button_reset]) e Aiuto ([image: il pulsante Aiuto]) che consentono di ripristinare le impostazioni di default, o di accedere rapidamente a questa pagina di Aiuto dall’interno dell’applicazione.



Preferenze Generali


Utilizza il pannello delle preferenze Generali per apportare modifiche applicabili globalmente a tutte le operazioni eseguite in OmniOutliner.




[image: Le preferenze Generali]

Le opzioni delle preferenze Generali comprendono:



	Nuovi documenti

	Consente di stabilire cosa avviene quando crei un nuovo documento, scegliendo File ▸ Nuovo o utilizzando l’abbreviazione da tastiera Comando-N. Puoi scegliere tra aprire un nuovo Browser delle risorse, o creare un nuovo documento basato sul modello di default. Se desideri modificare il modello di default, fai clic su Scegli e quindi seleziona uno dei file di modello di OmniOutliner sul tuo Mac.


	Link

	Consente di attivare o disattivare la capacità di rendere attivi gli URL (ad esempio http://www.omnigroup.com). Se deselezioni questa opzione, gli URL inseriti vengono visualizzati come testo e al clic del mouse non vengono aperti nel browser web predefinito.


	
Se desideri modificare l’etichetta di testo di un URL, fai clic tenendo premuto il tasto Opzione sul link, modifica il Titolo visualizzato come desideri e quindi fai clic su Fine.




	Stili

	Consente di attivare o disattivare l’acquisizione, da parte di una nuova riga, dello stile dal relativo collaterale. Quando l’opzione è selezionata e aggiungi una nuova riga (premendo A capo o Maiuscole-A capo), la nuova riga acquisisce gli stili della riga precedentemente attiva. Quando l’opzione non è selezionata, per tutti i nuovi modelli creati vengono ripristinati gli stili di default del modello scelto.


	
Supponiamo ad esempio di partire da un nuovo documento che utilizza il modello Vuoto, e che questa opzione non sia selezionata. Nella prima riga fai clic sulla maniglia di riga e assegna uno sfondo arancione alla riga. Quindi, inserisci testo e premi A capo. La riga successiva non acquisisce il colore di sfondo arancione, ma mantiene lo sfondo bianco (l’impostazione di default per il modello Vuoto). Se l’opzione Stili fosse selezionata, la riga successiva creata a partire dalla riga arancione acquisirebbe lo stesso colore di sfondo.






Preferenze Tastiera


Utilizza le preferenze Tastiera per adattare il comportamento di OmniOutliner alla pressione di determinati tasti.




[image: Le preferenze Tastiera]

Sono incluse le opzioni seguenti:



	Quando premi Tabulazione

	Di default, la pressione del tasto Tabulazione determina l’applicazione del rientro a una riga. Puoi modificare questo comportamento impostando il passaggio alla cella successiva tramite la commutazione dei pulsanti di opzione. Tenendo premuto il tasto Opzione inserirai un effettivo carattere di tabulazione, mentre premendo Maiuscole-Tabulazione eliminerai un livello di rientro per la riga corrente.


	Quando premi A capo

	Di default, premendo A capo viene creata una nuova riga vuota. È possibile modificare questo comportamento impostando l'inserimento di un'interruzione di riga nella riga corrente tramite la commutazione dei pulsanti di opzione; tuttavia, premendo Opzione-A capo verrà sempre inserita una nuova riga nella riga corrente.


	
Analogamente, se hai impostato Dividi la riga corrente nel punto di inserimento, premendo A capo puoi dividere la riga corrente in due in corrispondenza della posizione del cursore. Anche quando questa opzione è disattivata, puoi sempre premere Controllo-A capo per dividere la riga in due.



	Vengono create nuove righe

	Di default, per le nuove righe è attiva l’opzione Con rientro, se ci sono figli quando premi A capo. Se modifichi il pulsante di opzione passando a Sempre allo stesso livello le nuove righe vengono create allo stesso livello della riga in corrispondenza della posizione del cursore quando premi A capo.


	Quando premi Esc

	Le opzioni disponibili per il comportamento alla pressione del tasto Esc sono due. Di default, premendo il tasto Esc viene visualizzato il menu di completamento a livello di sistema. Questo risulta particolarmente utile quando non sei certo dell’ortografia di una parola. Puoi semplicemente digitare i primi caratteri della parola e quindi premere Esc per visualizzare un menu con un elenco di possibili opzioni. Per accettare una delle opzioni, puoi fare clic con il mouse, o utilizzare il tasto Freccia giù per evidenziare la parola che ti serve e quindi premere Tabulazione o A capo per accettare l’opzione.


	
[image: Di default, premendo il tasto Esc viene visualizzato il menu di completamento standard del sistema, che consente di velocizzare l’inserimento del testo]


	
La seconda opzione, Inizia o termina la modifica del testo, è utile per modificare rapidamente e con maggiore efficienza le celle di righe e colonne all’interno della struttura. Premendo Esc dopo l’immissione del testo in una riga, quest’ultima verrà evidenziata. Premi di nuovo Esc per posizionare il cursore alla fine della riga e procedere con la digitazione.



	Applica stili con nome con

	Di default, puoi utilizzare uno dei tasti funzione per applicare uno degli stili con nome alla riga corrente. Gli stili con nome si trovano nella parte inferiore della sezione Stili nella barra laterale. Per utilizzare i tasti funzione (da F1 a F9), dovrai tenere premuto il tasto fn e quindi premere un tasto funzione numerato per applicare lo stile. Ad esempio, per applicare lo stile con nome Intestazione 1, utilizza fn-F1.


	
Puoi modificare questo comportamento impostando Controllo + numero tramite la commutazione dei pulsanti di opzione nel pannello delle preferenze. Questo può facilitare l’applicazione degli stili con nome, dato che l’utilizzo de tasto fn in combinazione con i vari tasti funzione può risultare poco pratico.






Riorganizzazione degli stili con nome in base alle abbreviazioni da tastiera


Come avrai notato, non a tutti gli stili con nome nella barra laterale corrisponde un’abbreviazione da tastiera. Inoltre, non puoi assegnare direttamente (o riassegnare) queste abbreviazioni da tastiera in Preferenze di Sistema ▸ Tastiera ▸ Abbreviazioni, dato che non sono collegate a una voce di menu.


Tuttavia, puoi riorganizzare gli stili con nome trascinandoli in posizioni diverse all’interno dell’elenco. Ad esempio, se utilizzi molto spesso lo stile di testo Arancione, puoi trascinarlo nell’elenco in una posizione alla quale è associata un’abbreviazione da tastiera.


[image: Stili con nome e relative abbreviazioni da tastiera]




Preferenze Importazione ed esportazione testo


OmniOutliner offre anche la possibilità di importare o esportare file di testo non elaborati. Per facilitare questa operazione, le preferenze Importazione ed esportazione testo consentono di visualizzare (o modificare) i caratteri utilizzati per rappresentare gli elementi di un documento di OmniOutliner.




[image: Le preferenze Testo]

Tra gli elementi del documento che puoi controllare sono inclusi Punti elenco, Caselle di controllo e Spaziatura; è presente inoltre un menu a comparsa che consente di selezionare il tipo di codifica del testo per le operazioni di importazione ed esportazione.



Preferenze Esportazione RTF


In modo analogo al funzionamento delle preferenze Importazione ed esportazione di testo, OmniOutliner consente anche di esportare documenti in RTF. A questo scopo abbiamo preimpostato alcuni caratteri e dimensioni basati sui tipi di oggetto per Elenchi puntati e Caselle di controllo, e impostato la spaziatura per i rientri e la distanza tra le colonne.




[image: Le preferenze Esportazione RTF]

Puoi utilizzare le impostazioni di default, o modificarle in base alle tue preferenze e alle esigenze del documento.



Preferenze Registrazione audio


Utilizza le preferenze Registrazione audio per visualizzare il microfono che stai utilizzando per la registrazione, modificare il livello di compressione o accedere alla cartella di memorizzazione di registrazione temporanea.




[image: Preferenze Registrazione audio]

Durante la registrazione di clip audio, OmniOutliner crea un file temporaneo nel quale esegue il dump dei bit audio in registrazione. Al termine della registrazione questo file temporaneo viene eliminato e la clip audio viene inserita nel documento di OmniOutliner. E se OmniOutliner si chiude improvvisamente durante la registrazione? Niente panico: la registrazione temporanea è ancora disponibile, e il modo più semplice per recuperarla è proprio dal pannello delle preferenze Registrazione audio. Basta fare clic sul pulsante Apri cartella per accedere a una nuova finestra del Finder che mostra la posizione in cui è memorizzato il file temporaneo. Da qui puoi trascinare il file in OmniOutliner oppure, se desideri ripartire da zero, spostarlo nel Cestino.



Preferenze Aggiornamento software automatico


Non c’è niente di peggio di un software non aggiornato! Per essere certo di utilizzare sempre la versione più recente e funzionale di OmniOutliner puoi sfruttare le preferenze Aggiornamento software automatico.




[image: Le preferenze di aggiornamento]

Puoi specificare se OmniOutliner verificherà automaticamente la presenza di aggiornamenti con frequenza giornaliera, settimanale o mensile, oppure puoi scegliere Cerca aggiornamenti adesso. 


Nel pannello è anche disponibile una casella di controllo per inviare informazioni anonime sul sistema a The Omini Group quando esegui la verifica. Questo invio è totalmente facoltativo, quindi sentiti libero di deselezionare la casella e disattivare la funzione. Se tuttavia scegli di inviare le informazioni sul tuo sistema (nelle quali non è mai inclusa alcuna informazione personale), ti garantiamo che non le condivideremo mai con terzi. The Omni Group utilizza queste informazioni solo per determinare quali tipi di hardware e di sistema operativo considerare per i futuri aggiornamenti software.



Nota
 Se hai acquistato la tua copia di OmniOutliner attraverso il Mac App Store, puoi ignorare questo pannello delle preferenze, dato che sarai avvisato della disponibilità di un nuovo aggiornamento tramite l’App Store. Tuttavia, anche i clienti Mac App Store hanno la possibilità di inviarci informazioni di sistema anonime al momento dell’aggiornamento.









Condivisione di file di OmniOutliner con altre applicazioni


Come accennato, OmniOutliner è l’ideale quando si tratta di lavorare con i contenuti testuali. E per tutte le esigenze in questo ambito, abbiamo facilitato al massimo l’importazione e l’esportazione di file di testo in una varietà di formati.





Esportazione da OmniOutliner


Hai finito di lavorare sul tuo capolavoro, e ora è il momento di condividerlo con il resto del mondo. Per i casi in cui devi inviare un file di OmniOutliner a qualcuno che non dispone del programma (ma tu gli hai già detto quanto sia straordinario OmniOutliner, vero?), abbiamo incluso una serie di formati di file di esportazione tra i quali scegliere. Per esportare un file aperto, scegli File ▸ Esporta (Opzione-Comando-E), e quindi scegli una delle opzioni seguenti dal menu a comparsa Formato file:





	CSV

	Quando esporti come CSV una struttura multi-colonna, OmniOutliner salva il file .csv utilizzando le convenzioni standard per i valori separati da virgola (CSV) (vale a dire, ogni colonna è separata da una virgola, e il testo con spazi è collocato tra virgolette).


	HTML

	Crea una cartella con nome che contiene un file index.html, insieme alle immagini e agli allegati che costituiscono il file di OmniOutliner. Tutti gli stili che hai utilizzato in OmniOutliner vengono convertiti in CSS e inclusi nel file index.html.


	HTML (dinamico)

	Questa opzione include tutti gli elementi compresi nell’esportazione HTML, più un file outliner.js aggiuntivo. È questo file JavaScript a rendere il file dinamico, nel senso che è possibile aprire e chiudere le sezioni del documento proprio come in OmniOutliner.






	Microsoft Word (con rientro) (Pro)
 Microsoft Word (struttura) (Pro)

	Esporta il file di OmniOutliner in un file .docx che è possibile aprire in Microsoft Word. La differenza tra queste due opzioni è la seguente:

	Scegliendo Microsoft Word (con rientro) viene creato un file .docx che si apre nella visualizzazione Layout di pagina di default e conserva l’organizzazione della struttura. Scegli questa opzione se devi inviare la tua struttura in un formato più comune.


	Scegliendo Microsoft Word (struttura) viene creato un file .docx che si apre di default nella visualizzazione Struttura di Word. Scegli questa opzione per esportare una struttura che sia possibile ampliare facilmente in Word. Tuttavia, se la struttura originale include immagini, Word rileva le risorse di questo tipo nel file e utilizza per il documento la visualizzazione Layout di pagina. Se nel documento passi alla visualizzazione Struttura di Word, al posto delle immagini vedrai altrettanti spazi vuoti.







	MS Word (HTML) (Pro)

	Esporta un file .dochtml che è possibile aprire in Microsoft Word.









	OmniOutliner 3

	Esporta un file .oo3 che può essere aperto sia in OmniOutliner 3 o 4 per Mac, che in OmniOutliner 1 e 2 per iPad. Questi file non sono compatibili con OmniOutliner 2 su Mac o versioni precedenti.


	Modello di OmniOutliner 3

	Esporta un file .oo3template che può essere aperto in OmniOutliner 3 o 4. Questi file non sono compatibili con OmniOutliner 2 o versioni precedenti.


	OPML (Outline Processor Markup Language)

	Esporta un file .opml, che mantiene l'ordinamento gerarchico della tua struttura. I file OPML, tuttavia, non preservano nessuno degli stili che potresti aver applicato in OmniOutliner.

Il formato OPML (Outline Processor Markup Language) è un formato XML realizzato appositamente per le strutture. Sviluppato da UserLand Software per essere utilizzato come formato nativo di Radio UserLand, OPML offre tutto ciò che si desidera per una struttura semplificandone al contempo la condivisione con applicazioni e servizi.



Nonostante la flessibilità, il formato OPML riconosce unicamente il testo strutturato in modo gerarchico ma non legge gli stili né gli allegati. Sebbene ciò possa andare bene per le strutture di solo testo, se invece hai dedicato del tempo all'applicazione di stili alla tua struttura puoi conservare tali stili creando per prima cosa un tema modello, da riapplicare poi in un secondo momento. Ricorda tuttavia che ogniqualvolta salvi o esporti un file in formato OPML, tutti gli stili (incluso il tema modello) che vi hai applicato verranno ignorati.



Per creare un tema modello da un documento di OmniOutliner con stili, scegli File ▸ Salva come modello. Per riapplicare successivamente quel tema modello, scegli Formato ▸ Applica tema modello.





	Solo testo (larghezza fissa)

	Esegue l’esportazione in un file .txt non elaborato, privo di stili. Le righe figlio sono rientrate mediante quattro spazi, e sempre gli spazi vengono utilizzati anche per l’allineamento delle colonne. È possibile personalizzare il numero di spazi utilizzati in OmniOutliner ▸ Preferenze ▸ Testo ▸ Spaziatura.


	Solo testo (con tabulazioni)

	Esegue l’esportazione in un file .txt non elaborato, privo di stili. Le righe figlio e le colonne vengono allineate utilizzando tabulazioni anziché spazi; questo tipo di esportazione è utile per l’importazione in applicazioni di fogli di calcolo come Excel o Numbers.


	Formato PowerPoint 2012 (pptx)

	OmniOutliner esporta il contenuto della struttura in un formato XML che PowerPoint 2012 è in grado di interpretare e visualizzare. Dopo l’esportazione della struttura come .pptx, è possibile importare il file PowerPoint nell’app Keynote di Apple.


	RTF

	Esporta un file .rtf, che mantiene tutti gli stili applicati in OmniOutliner. RTF è un formato di documento standard compatibile con la maggior parte dei programmi di modifica di testo, come Word e TextEdit di OS X. Utilizza l’esportazione in RTF se il documento di Outliner contiene solo testo e numeri.


	RTFD (RTF con allegati)

	Esegue l’esportazione in un file .rtfd, che mantiene tutti gli stili applicati in OmniOutliner. La differenza tra RTFD e RTF è che un file RTFD può contenere allegati, ad esempio immagini, clip audio o qualsiasi altro elemento allegato al file di OmniOutliner. La maggior parte dei programmi di modifica di testo, come Word, Pages e TextEdit di OS X, sono compatibili con i file .rtfd.





Importazione in OmniOutliner


Per i casi in cui OmniOutliner non è la scelta più adatta, o per quando ricevi un file compatibile con OmniOutliner da un collega, è utile sapere quali tipi di file puoi aprire in OmniOutliner. Per importare un file, puoi utilizzare semplicemente File ▸ Apri e quindi selezionare uno dei seguenti tipi di file nella finestra di dialogo Apri:





	.opml: un file OPML valido.

	.oo3: file creati con OmniOutliner 3 o 4.

	.oo3template: file di modello creati con OmniOutliner 3 o 4.

	.txt: file di testo semplice e delimitati da tabulazioni.

	.rtf: tutti gli stili di testo e i colori vengono conservati all’importazione di un file RTF.

	.rtfd: come per i file RTF, tutti gli stili di testo e i colori vengono mantenuti ed eventuali immagini vengono anch’esse incluse. Le immagini vengono ridimensionate automaticamente in base alla larghezza delle colonne.





Suggerimento
 OmniOutliner non è in grado di aprire file creati o esportati come .csv (Comma-Separated Values, valori separati da virgola). Utilizza al loro posto un file delimitato da tabulazioni e salvalo con estensione .txt.





Condivisione di file di OmniOutliner con OmniGraffle


Puoi anche condividere i file di OmniOutliner con OmniGraffle, creando documenti ancora più eccezionali a partire da un semplice testo (ben) formattato. Con OmniGraffle, i tuoi testi diventeranno ancora più straordinari!





	Apri OmniGraffle e scegli File ▸ Apri.

	Nella finestra di dialogo Apri scegli un qualsiasi file con estensione .oo3.

	Fai clic su Apri.

	Viene visualizzata la finestra di dialogo Importa struttura. Nella parte superiore, assicurati di selezionare uno dei modelli a tema, come Cerchi o Linee; quindi nella casella combinata Colonne struttura scegli la modalità di formattazione dei dati della colonna (se il file di OmniOutliner include dati di colonna).




Puoi utilizzare il sofisticato Editor struttura di OmniGraffle (in OmniGraffle, scegli Vista ▸ Mostra contenuto ▸ Editor struttura) per rendere più sofisticato il diagramma appena creato. Al termine, esporta il file di OmniGraffle come file di OmniOutliner e quindi aprilo in OmniOutliner 4. Gli stili che hai utilizzato in OmniGraffle dovrebbero venire mantenuti in OmniOutliner. Se desideri modificarli di nuovo, scegli Formato ▸ Applica tema modello e quindi seleziona un modello da applicare al file di OmniOutliner.







Comandi di menu e abbreviazioni da tastiera


Di seguito ti forniamo un elenco esaustivo delle voci di menu, insieme alle relative abbreviazioni da tastiera, disponibili in OmniOutliner 4. In questa sezione non è inclusa semplicemente una panoramica dei comandi disponibili, ma anche piccoli suggerimenti preziosi per aiutarti a scegliere l’opzione di menu (o combinazione di opzioni) più adatta per sbloccare il tuo badge da “Utente avanzato di OmniOutliner” e suscitare l’invidia di tutti i tuoi amici e colleghi.





Nota
 Il badge da Utente avanzato di OmniOutliner non esiste davvero. Sarebbe un Easter Egg, e noi siamo troppo seri per inserire Easter Egg nei nostri programmi. (Non sai cos’è un Easter Egg? Guarda qui).





Se desideri impostare un’abbreviazione da tastiera per un’opzione di menu che ne è priva, puoi farlo in Preferenze di Sistema. Per i dettagli su come eseguire questa operazione, puoi consultare la barra laterale in Introduzione a OmniOutliner 4.




Il menu OmniOutliner


Il menu OmniOutliner, altrimenti noto come menu dell’applicazione, contiene i comandi specifici per OmniOutliner, come ad esempio la casella Informazioni, l’accesso alle Preferenze, le informazioni sulla licenza e altro ancora.






	Informazioni su OmniOutliner

	L’opzione consente di accedere alla finestra di dialogo Informazioni, che fornisce maggiori dettagli su OmniOutliner, inclusa la versione e il numero della build corrente (utili per eventuali esigenze di supporto tecnico). E a proposito di supporto tecnico, abbiamo incluso anche una serie di comodi indirizzi e-mail, utili per richiedere informazioni commerciali o contattare gli operatori del nostro supporto, ai quali porre tutte le domande possibili sull’utilizzo di OmniOutliner (o di un altro dei nostri prodotti). Se invece preferisci parlare direttamente con uno dei nostri operatori, basta contattare il numero telefonico indicato: siamo a tua disposizione dal lunedì al venerdì dalle 10:00 alle 17:00 (ora del Pacifico).




[image: Casella Informazioni su OmniOutliner]


	Verifica aggiornamenti

	Se il tuo Mac è collegato a Internet, questa opzione consente di contattare i nostri server per verificare la disponibilità di una versione aggiornata di OmniOutliner. Se è disponibile un aggiornamento, ti verrà chiesto se desideri eseguirlo; se è così, la nuova build verrà scaricata e installata sul tuo Mac.





Nota
 Se hai acquistato OmniOutliner 4 dal Mac App Store, l’opzione Verifica aggiornamenti non sarà disponibile.





	Preferenze (Comando–,)

	Consente di accedere alla finestra Preferenze, dalla quale puoi configurare ulteriormente OmniOutliner per adattarlo alle tue esigenze e al tuo stile di lavoro.


	Licenze

	Consente di accedere alla finestra Licenze, in cui puoi inserire o eliminare una licenza o, se stai utilizzando una copia di valutazione di OmniOutliner, fare clic su Acquista licenze per collegarti al nostro negozio online e acquistare una chiave di licenza.





Nota
 Se hai acquistato OmniOutliner 4 dal Mac App Store, l’opzione Licenze non sarà disponibile.





	Servizi

	In questa sezione troverai un elenco di applicazioni con cui OmniOutliner può condividere informazioni. Basta selezionare un elemento in OmniOutliner e quindi scegliere questa opzione di menu per visualizzare le applicazioni cui è possibile inviare dati.


	Nascondi OmniOutliner (Comando–H)

	Nasconde la finestra di OmniOutliner. Per visualizzarla nuovamente, fai clic sull’icona dell’applicazione nel Dock, oppure utilizza Comando–Tabulazione per tornare a OmniOutliner tramite lo switcher applicazioni.


	Nascondi altre (Opzione-Comando–H)

	Nasconde le finestre delle altre applicazioni. Come per Nascondi OmniOutliner, per visualizzare nuovamente un’applicazione nascosta fai clic sulla relativa icona nel Dock, oppure utilizza Comando–Tabulazione per tornare all’applicazione tramite lo switcher applicazioni.


	Mostra tutte

	Scegli questa opzione di menu per rivisualizzare rapidamente tutte le applicazioni nascoste.


	Esci da OmniOutliner (Comando–Q)

	Come avrai intuito, l’opzione chiude OmniOutliner. Se non l’hai già fatto, ti verrà chiesto di salvare il file corrente (denominandolo e specificando un percorso). Se stai lavorando su un file già salvato in precedenza, non dovrai preoccuparti di salvare prima di uscire, grazie alla funzione di salvataggio automatico di OS X. Per sicurezza, comunque, puoi sempre utilizzare Comando–S per salvare il file, prima di uscire utilizzando Comando–Q.





Il menu File


Opzioni per la creazione, l’apertura, la ridenominazione, l’esportazione e la stampa di documenti e modelli:





	Nuovo (Comando–N)

	Crea un nuovo documento utilizzando il modello di default.


	Browser delle risorse (Maiuscole-Comando–N)

	Apre il Browser delle risorse.


	Apri (Comando–O)

	Apre un file esistente.


	Apri recente

	OmniOutliner tiene traccia dei file aperti di recente e ne include i nomi in questo menu per consentirti di riaprirli rapidamente e di continuare il lavoro.





	Chiudi (Comando–W)

	Chiude la finestra corrente; utilizza Opzione-Comando–W per chiudere tutte le finestre aperte di OmniOutliner. Ti verrà richiesto di denominare e i file di documento nuovi e senza titolo prima della chiusura della finestra.


	Salva (Comando–S)

	Salva il contenuto del documento corrente.


	Duplica (Maiuscole-Comando–S)

	Crea un duplicato del documento corrente. L’esatto contenuto della finestra corrente viene copiato in una nuova finestra di documento, con il nome del file evidenziato sulla barra del titolo, in modo che tu possa immettere un nome diverso per il file. Il file verrà salvato nella stessa posizione del file originale.


	Rinomina

	Scegli questa opzione per evidenziare il nome del file sulla barra del titolo e poter immettere un nuovo nome per il file.


	Sposta in

	Scegli questa opzione per aprire un foglio e selezionare un’altra posizione in cui memorizzare il file sul disco rigido del tuo Mac.


	Esporta (Opzione-Comando–E)

	Consente di esportare il documento OmniOutliner in uno dei formati che seguono, indicati nella sezione Esportazione da OmniOutliner.


	Salva come modello

	Salva il file corrente come file di modello di OmniOutliner. I file di modello sono memorizzati sul tuo Mac in ~/Libreria/Containers/com.omnigroup.OmniOutliner/
Data/Library/Application Support/The Omni Group/OmniOutliner/Templates.





Nota
 Se hai acquistato OmniOutliner 4 dal Mac App Store, com.omnigroup.OmniOutliner sarà sostituito da com.omnigroup.OmniOutliner.MacAppStore, o da com.omnigroup.OmniOutlinerPro.MacAppStore se disponi di OmniOutliner 4 Pro.





	Ripristina a

	Apre Time Machine per consentirti di individuare versioni precedenti del documento corrente e di ripristinarle.


	Formato di stampa (Maiuscole-Comando–P)

	Consente di accedere alla finestra di dialogo Formato di stampa, nella quale puoi applicare eventuali impostazioni salvate in precedenza, scegliere la stampante per la quale preparare il documento, selezionare formato di pagina, orientamento e proporzioni per il documento.


	Stampa (Comando–P)

	Invia il documento corrente alla stampante di default. Puoi utilizzare Formato di stampa (Maiuscole-Comando–P) per scegliere una stampante diversa da quella di default; ad esempio, se disponi di un documento da stampare in Tabloid-Orizzontale su una stampante a colori.





Il menu Modifica


Opzioni per la modifica dei contenuti:





	Annulla (Comando–Z)

	Annulla l’ultima modifica apportata. OmniOutliner supporta un numero illimitato di annullamenti: puoi quindi premere Comando–Z anche fino a far scomparire tutto il tuo lavoro.


	Ripristina (Maiuscole-Comando–Z)

	In modo uguale e opposto al comando Annulla, se cambi idea questa opzione ripristina un’operazione annullata. Ad esempio, diciamo che stavi mettendo alla prova l’opzione Comando–Z, ma ora desideri fare un passo indietro. Ebbene sì: basta premere Maiuscole-Comando–Z per rimettere tutto a posto.


	Taglia (Comando–X)

	Elimina gli elementi selezionati e li colloca negli Appunti, in modo che tu possa (eventualmente) incollarli in un secondo momento.


	Copia (Comando–C)

	Copia gli elementi selezionati e li colloca negli Appunti in formato TSV (valori separati da tabulazioni), in modo che tu possa incollarli in un’altra posizione o in un altro documento.






	Copia come link (Pro)

	L’opzione di menu Copia come link (una novità di OmniOutliner 4.1) consente di creare link di riferimento interno tra righe all’interno dello stesso documento di OmniOutliner. Basta selezionare una porzione di testo in una riga, scegliere Modifica ▸ Copia come link e quindi spostarsi su un’altra riga nella struttura e premere Comando–V per incollare un link alla prima riga. Questo risulta particolarmente utile quando stai lavorando a una struttura di grandi dimensioni, in cui potrebbe essere necessario includere riferimenti ad altre parti dello stesso documento. I collegamenti tra documenti non sono supportati in questo momento.

Il link che viene incollato quando premi Comando–V fa riferimento alla posizione nel file del testo copiato, nel formato omnioutliner:///open?row=mLUW8Czar_j, come illustrato di seguito:


[image: Un esempio dell’aspetto dei link incollati in un file di OmniOutliner.]


Dopo aver incollato il link in un’altra posizione dello stesso documento, puoi selezionarlo e sostituirlo con qualsiasi testo tu desideri. Un’altra opzione per modificare il testo del link consiste nel fare clic tenendo premuto il tasto Opzione sul link e quindi modificare il Titolo visualizzato. Puoi optare per visualizzare l’URL del link. Quando hai finito di modificare il link, fai clic su Fine.



[image: Utilizza il popover di modifica del link per modificare il testo visualizzato per un link]


Fai clic sul link per passare alla relativa posizione nel documento.










	Incolla (Comando–V)

	Incolla il contenuto degli Appunti.

	Il comportamento del comando Incolla varia leggermente in OmniOutliner rispetto ad altre applicazioni. Se tagli o copi testo con interruzioni di riga da un’altra applicazione e lo incolli in OmniOutliner, tutto il testo verrà visualizzato su una singola riga, ma le interruzioni di riga verranno conservate.


[image: Funzionamento precedente del comando Incolla in OmniOutliner]



	Tuttavia, se desideri che ogni riga venga visualizzata separatamente in OmniOutliner, seleziona prima una riga facendo clic sul margine interno, quindi utilizza Modifica ▸ Incolla (o Comando–P) per incollare il testo.



	Incolla e mantieni lo stile (Opzione-Maiuscole-Comando–V)

	A differenza di Incolla, l’opzione incolla il contenuto degli Appunti ma applicando al materiale incollato lo stile predeterminato in OmniOutliner per la riga o colonna.





Una nota sugli Appunti, gli stili e le operazioni di Taglia-Copia-Incolla


Ogni volta che utilizzi Taglia o Copia, all’interno di OmniOutliner o in un’altra applicazione, tutti gli attributi degli elementi tagliati o copiati vengono inseriti negli Appunti di OS X. Gli Appunti sono una funzione di sistema che include un solo elemento per volta; presumibilmente perché, una volta che hai tagliato o copiato qualcosa, è probabile che tu lo voglia incollare altrove immediatamente o quasi.


Inoltre, OS X esamina anche l’elemento tagliato o copiato e conserva tutti gli stili eventualmente applicati a esso, ad esempio font, tipo di carattere o dimensione, e colore. Ecco perché Incolla e mantieni lo stile (Opzione-Maiuscole-Comando–V) risulta utile. Diciamo che hai copiato qualcosa da un sito web, e che parte del testo copiato è in blu, parte in verde, parte in grassetto. Quando copi il testo da Safari, OS X lo conserva esattamente come visualizzato sulla pagina web. Ma a te in realtà interessa solo il testo, giusto? Colori e formattazione non ti servono, desideri solo inserire il testo nel file di OmniOutliner e fare in modo che rispecchi lo stile del documento in uso. A questo scopo, anziché il comando di default Comando–V, per incollare il contenuto puoi utilizzare Maiuscole-Opzione-Comando–V. In questo modo tutti gli stili copiati insieme al testo vengono eliminati e viene applicato automaticamente lo stile per la riga o la cella selezionata.


Questo ti farà risparmiare una notevole quantità di tempo, evitandoti di dover riapplicare gli stili del documento agli elementi incollati, indipendentemente dal fatto che provengano da una pagina web, un documento Word o Pages o un altro file di OmniOutliner.





	Duplica selezione (Comando–D)

	Copia e incolla automaticamente la selezione nel documento corrente.


	Elimina

	Elimina la selezione corrente. Diversamente da ciò che avviene utilizzando il comando Taglia, la selezione non viene inserita negli Appunti.


	Seleziona tutto (Comando–A)

	Seleziona ogni singolo elemento all’interno del documento di OmniOutliner.


	Deseleziona tutto (Maiuscole-Comando–A)

	Deseleziona ogni singolo elemento all’interno del documento di OmniOutliner. Questa opzione può essere utile nei casi in cui non sei certo di aver selezionato un elemento prima di incollare.


	Imposta stato

	Utilizza una delle operazioni seguenti per impostare lo stato della casella di controllo di una riga:


	Selezionato

	Non selezionato

	Calcolato

	Nessuno





	Modifica nota (Comando–’)

	Consente di modificare la nota per la cella di riga o colonna attualmente selezionata.


	Allega file

	Consente di allegare un file al documento.


	Inizia/Interrompi la registrazione audio

	Aggiunge una clip audio al documento.


	Inserisci data/ora

	Inserisce uno dei seguenti contrassegni temporali nella riga corrente:


	Data abbreviata (Comando–/)

	Inserisce una stringa di data numerica localizzata; ad esempio: 10/05/2013.


	Data estesa (Opzione-Comando–/)

	Inserisce una stringa di data numerica localizzata; ad esempio: 5 ottobre 2013.


	Ora (Comando–@)

	Inserisce una stringa di ora numerica localizzata; ad esempio: 12:34:56.


	Data e ora abbreviate (Comando–|)

	Inserisce una stringa di data e ora numerica localizzata; ad esempio: 05/10/2013 12:34.


	Data e ora estese (Opzione-Comando–|)

	Inserisce una stringa di data e ora numerica localizzata; ad esempio: 5 ottobre 2013, 12:34:56 PDT.





	Cerca

	Puoi utilizzare una delle opzioni di ricerca seguenti:


	Mostra/Nascondi ricerca (Opzione-Comando–F)

	Visualizza il campo di ricerca nella barra laterale. Quando il campo di ricerca è visibile, alla sua sinistra viene visualizzato un pulsante Nascondi. Fai clic sul pulsante Nascondi oppure utilizza l’opzione di menu Nascondi ricerca (o l’abbreviazione da tastiera) per nascondere il campo di ricerca.


	Cerca (Comando–F)

	Apre la finestra di dialogo Cerca, in cui è possibile inserire un elemento da cercare. Puoi cercare una stringa di testo, ad esempio The Omni Group, oppure utilizzare un’espressione regolare, come Omni\s, per cercare la parola Omni seguita da uno spazio (\s).


	Cerca successivo (Comando–G)

	Cerca l’istanza successiva.


	Cerca precedente (Maiusc-Comando–G)

	Cerca l’istanza precedente.


	Usa selezione per cercare (Comando–E)

	Utilizza la selezione corrente come criterio di ricerca nella funzione Cerca. Puoi utilizzare questa opzione prima o dopo l’apertura della finestra di dialogo Cerca (Comando–F).





	Ortografia

	Scegli una delle opzioni seguenti per eseguire un controllo ortografico e grammaticale nel documento:


	Mostra/nascondi ortografia e grammatica (Comando–:)

	Consente di eseguire un controllo ortografico e grammaticale nel documento corrente.


	Controlla ortografia (Comando–;)

	Consente di eseguire un controllo ortografico nel documento corrente. Del resto la grammatica non è così importante, giusto?


	Controlla ortografia mentre scrivo

	Attivata di default, questa opzione controlla l’ortografia durante la digitazione. Se digiti una parola in modo errato, sotto di essa verrà visualizzata una linea rossa ondulata e OS X ti fornirà una serie di suggerimenti tra i quali selezionare quello con l’ortografia corretta.







[image: Problemi con l’ortografia? OS X e OmniOutliner possono aiutarti!]


	Voce

	Puoi fare in modo che in OS X il testo nella riga corrente o nota venga letto ad alta voce, utilizzando la voce di sistema impostata nelle preferenze Dettatura e Voce (Preferenze di Sistema ▸ Dettatura e Voce ▸ Testo da pronunciare).


	Inizia riproduzione

	Avvia la lettura del testo nella riga corrente.


	Interrompi riproduzione

	Interrompe la lettura.





	LinkBack

	LinkBack rappresenta una modalità di integrazione di contenuti tra applicazioni che consente di modificare questi contenuti in qualsiasi momento mediante il software originariamente utilizzato per crearli.


	Modifica elemento LinkBack

	Se hai incollato contenuti LinkBack da un’altra applicazione, seleziona l’oggetto e utilizza questo comando per aprire i contenuti nell’applicazione originale.


	Rimuovi LinkBack per elemento

	Selezionando questa opzione la funzione LinkBack viene eliminata dal contenuto selezionato, che potrà quindi essere modificato solo all’interno di OmniOutliner.





Come funziona LinkBack



LinkBack consente di integrare contenuti tra applicazioni in modo tale da poterli modificare in qualsiasi momento mediante il software originariamente utilizzato per crearli.




Supponiamo, ad esempio, che tu abbia utilizzato LinkBack per includere alcune informazioni da OmniGraffle in un documento di OmniOutliner. Per modificare il contenuto di OmniGraffle collegato al documento di OmniOutliner:




	Fai doppio clic sul contenuto di OmniGraffle collegato al documento di OmniOutliner. Tale contenuto verrà visualizzato in una finestra di OmniGraffle.

	Modifica normalmente il contenuto nella finestra di OmniGraffle.

	In OmniGraffle scegli File ▸ Salva; i contenuti nella finestra di OmniOutliner si aggiorneranno automaticamente.





Questo facilita lo scambio di contenuti condivisi tra applicazioni LinkBack senza richiedere l’aggiornamento in due app diverse. Per ulteriori informazioni su LinkBack, e un elenco delle applicazioni compatibili, collegati all’archivio dedicato a LinkBack su GitHub.







	Avvia dettatura (fn fn)

	Quando la funzione di dettatura è attiva, OmniOutliner utilizza il riconoscimento vocale di OS X per convertire le parole pronunciate in testo. Al termine, basta premere di nuovo fn fn per interrompere la dettatura.


	Emoji e simboli (Controllo-Comando-Spazio)

	Consente di aprire la finestra Caratteri, che fornisce accesso a una serie più ampia di caratteri, inclusi frecce, simboli e perfino Emoji.




[image: Inserisci frecce, simboli ed Emoji utilizzando il popover dei caratteri speciali]


Il menu Formato


Opzioni per la formattazione dei contenuti del documento, inclusi font e stili di testo, numerazione delle righe e altro ancora:





	Copia stile (Opzione-Comando–C)

	Crea una copia dello stile della selezione corrente e la colloca negli Appunti.


	Incolla stile (Opzione-Comando–V)

	Incolla lo stile precedentemente copiato nella selezione corrente.





Suggerimento
 Le opzioni di Copia e incolla stile sono molto utili per ripulire il documento. Una volta formattata correttamente una riga, puoi selezionare Copia stile, selezionare le altre righe da formattare in modo analogo e quindi scegliere Incolla stile.





	Cancella stile (Controllo-Comando–Elimina)

	Rimuove tutti gli stili che sono stati applicati a un elemento e ripristina lo stile di default per la selezione.


	Font

	Modifica il tipo di carattere e lo stile del testo.


	Mostra font (Comando–T)

	Apre la finestra Font, nella quale puoi scegliere un altro font e relativi tipo di carattere e dimensione.


	Grassetto (Comando–B)

	Attiva o applica il grassetto alla selezione corrente.


	Corsivo (Comando–I)

	Attiva o applica il corsivo alla selezione corrente.


	Sottolineato (Comando–U)

	Attiva o applica una sottolineatura alla selezione corrente.


	Bordato

	Attiva o applica una bordatura alla selezione corrente.


	Più grande (Comando–+)

	Aumenta le dimensioni della riga corrente o del testo selezionato.


	Più piccolo (Comando–−)

	Riduce le dimensioni della riga corrente o del testo selezionato.


	Crenatura

	Utilizza queste opzioni per modificare lo spazio tra i caratteri:


	Utilizza default

	Non utilizzarne nessuna

	Stretta

	Allargata





	Legatura

	Utilizza queste opzioni per controllare le legature nel documento:


	Utilizza default

	Non utilizzarne nessuna

	Utilizza tutte





	Linea di base

	Utilizza queste opzioni per adattare la linea di base della riga o della selezione corrente:


	Utilizza default

	Apice

	Pedice

	Solleva

	Abbassa





	Mostra colori (Maiuscole-Comando–C)

	Apre la tavolozza dei colori, con la quale sfogare tutta la tua creatività.





	Testo

	Opzioni di allineamento per testo, immagini e allegati:


	Allinea a sinistra

	Allinea il testo e gli oggetti al margine sinistro della riga o colonna corrente.


	Centra

	Allinea il testo e gli oggetti in base al centro della riga o colonna corrente.


	Giustifica

	Applica una spaziatura uniforme alle parole in una riga o colonna in modo che il testo su più righe utilizzi l’intera larghezza della colonna.


	Allinea a destra

	Allinea il testo e gli oggetti al margine destro della riga o colonna corrente.


	Direzione scrittura

	Modifica la direzione di scrittura:


	Da destra a sinistra

	Modifica la direzione di scrittura da Da sinistra a destra a Da destra a sinistra.









	Numerazione righe

	
Assegna uno schema di numerazione righe al documento. I numeri di riga si basano sul livello di rientro. Supponendo che una riga senza rientro sia la riga padre, la prima riga con rientro la riga figlio e le righe successive con rientro righe nipote e pronipote, le righe non numerate adotteranno la gerarchia seguente:

[image: Numerazione delle righe utilizzando il modello di numerazione della sezione]

Il menu Numeri di riga è suddiviso in due parti. La sezione superiore del menu consente di determinare uno stile numerato da utilizzare come prefisso per le righe del documento. Se hai impostato uno stile numerato diverso da Nessuno, gli stili nella sezione inferiore, x., x) e (x), possono essere applicati anche al numero di riga; ad esempio 1.1.1., 1.1.1) o (1.1.1), rispettivamente.


Puoi impostare la formattazione per i numeri di riga:



	Nessuno

	Quando l’opzione è selezionata, le righe del documento non sono numerate.


	1, 2, 3, 4

	Quando l’opzione è selezionata, le righe del documento vengono numerate in modo sequenziale, a partire da 1.


	A, B, C, D

	Quando l’opzione è selezionata, alle righe del documento viene applicato un ordinamento alfabetico utilizzando lettere maiuscole, a partire da A.


	a, b, c, d

	Quando l’opzione è selezionata, alle righe del documento viene applicato un ordinamento alfabetico utilizzando lettere minuscole, a partire da a.


	I, II, III, IV

	Quando l’opzione è selezionata, le righe del documento vengono numerate in modo sequenziale utilizzando numeri romani (maiuscoli), a partire da I.


	i, ii, iii, iv

	Quando l’opzione è selezionata, le righe del documento vengono numerate in modo sequenziale utilizzando numeri romani (minuscoli), a partire da i.


	1, 1.1, 1.1.1

	Quando l’opzione è selezionata, le righe del documento vengono numerate in modo sequenziale mediante i numeri di sezione, a partire da 1 per la riga padre, 1.1 per le righe con rientro di livello successivo, e così via.


	Nessun prefisso o suffisso

	Selezionata di default, l’opzione comporta che prima o dopo un numero di riga non sarà presente alcun carattere.


	x.

	Inserisce un punto dopo lo stile selezionato per il numero di riga, ad esempio 1.1.2..


	x)

	Inserisce una parentesi chiusa ) dopo lo stile selezionato per il numero di riga, ad esempio 1.1.2).


	(x)

	Inserisce i numeri di riga tra parentesi, ad esempio (1.1.2).





	Applica tema modello

	Apre un foglio simile al Browser delle risorse, dove puoi scegliere e applicare un tema modello al documento corrente.





Il menu Vista


Opzioni per lavorare all’interno del documento di OmniOutliner:





	Espandi tutte (Controllo-Comando–9)

	Espande tutte le righe nel documento.


	Contrai tutte (Controllo-Comando–0)

	Contrae tutte le righe nel documento.


	Espandi riga (Comando–9)

	Espande la riga corrente.


	Espandi riga completamente (Opzione-Comando–9)

	Espande la riga e tutte le righe figlio.


	Contrai riga (Comando–0)

	Contrae la riga corrente.


	Contrai riga completamente (Opzione-Comando–0)

	Contrae la riga e tutte le righe figlio.


	Metti in evidenza (Maiuscole-Comando–F)

	Mette in evidenza la riga corrente (e relative righe figlio), nascondendo tutti gli altri elementi nel documento OmniOutliner. Questo è particolarmente utile, ad esempio, quando desideri concentrarti sulla struttura per il capitolo di un libro, o per un elenco di parti di un progetto tecnico. Puoi anche assegnare diversi livelli di messa in evidenza in base alla struttura del documento. Ad esempio, in presenza di una riga con alcune righe figlio nidificate, puoi mettere in evidenza una delle righe figlio, e poi di nuovo una delle righe figlio di quest’ultima, quando e se presente.


	Annulla Metti in evidenza (Opzione-Maiuscole-Comando–F)

	Rimuove la messa in evidenza applicata in precedenza.


	Annulla tutte le operazioni Metti in evidenza

	Rimuove la messa in evidenza applicata a ogni oggetto nel documento di OmniOutliner.


	Zoom avanti (Comando–>)

	Ingrandisce la visualizzazione del documento. Puoi ingrandire il documento fino al 400%.


	Zoom indietro (Comando–<)

	Riduce la visualizzazione del documento. Puoi ridurre il documento fino al 50%.


	Porta alle dimensioni reali

	Riadatta automaticamente il documento fino al 100% (dimensioni normali). Questo è particolarmente utile quando hai applicato uno zoom del 400% e desideri tornare rapidamente a una visualizzazione normale.





Suggerimento
 Se esegui spesso questa procedura di applicazione dello zoom e quindi di ripristino delle dimensioni reali, valuta se aggiungere un’abbreviazione da tastiera per il comando Porta alle dimensioni reali. Molte ottime applicazioni per Mac, ad esempio Acorn, utilizzando Comando–1 a questo scopo.





	Intestazioni colonna

	Consente di scegliere se le intestazioni di colonna vengono visualizzate utilizzando una delle opzioni seguenti:


	Mostra

	Visualizza tutte le intestazioni di colonna.


	Automatico

	Attiva le intestazioni di colonna se nel documento sono presenti due o più colonne (la colonna Note non viene considerata).


	Nascondi

	Nasconde tutte le intestazioni di colonna.





	Mostra/Nascondi caselle di stato

	Consente di scegliere se visualizzare o nascondere le caselle di controllo di stato selezionabili. Queste caselle sono utili per strutture collegate a un progetto (ad esempio la struttura per preparare la documentazione di OmniOutliner) delle quali desideri spuntare le varie voci al procedere del lavoro.





Suggerimento
 Utilizza le caselle di stato in combinazione con le opzioni Organizza ▸ Mantieni ordinato o Organizza ▸ Ordina struttura per ordinare lo stato di un documento in base alle caselle di stato selezionate o meno.






	Nascondi colonna (Pro)

	Nasconde la colonna attualmente in evidenza.








	Colonne (Pro)

	
Consente di scegliere le colonne da visualizzare:


	Mostra tutte le colonne (Pro)

	Visualizza tutte le colonne nel documento di OmniOutliner.


	Nota (Pro)

	Nasconde o visualizza la colonna Note.


	Argomento (Pro)

	La colonna Argomento non può essere nascosta ed è sempre visibile.










Nota
 Dal momento che puoi modificare il nome di default dell’intestazione di colonna Argomento, le opzioni visualizzate nel sottomenu Colonne rispecchieranno i titoli assegnati alle intestazioni di colonna, compreso testo o caratteri Emoji eventualmente utilizzati.






	Testo riga (Pro)

	
Utilizza queste opzioni per la visualizzazione di testo all’interno di una riga:



	Mostra sempre il testo completo

	Il testo in una riga sarà sempre visibile, anche quando il cursore si trova in un’altra riga.


	Contrai quando non si sta modificando

	Il testo nella riga verrà troncato alla fine della prima riga (anziché andare a capo) quando la riga non è in fase di modifica. Questo è particolarmente utile quando hai importato testo da un altro documento (ad esempio un documento Word) e desideri visualizzare solo il testo per la riga su cui stai lavorando.














	Note (Pro)

	
Le Note in generale sono una caratteristica standard di OmniOutliner 4, ma la capacità di controllarne le modalità di visualizzazione è disponibile solo in OmniOutliner 4 Pro. Puoi scegliere come visualizzare le note nel file di OmniOutliner, in linea o in un pannello separato:



	Mostra in linea

	Le note vengono visualizzate in linea con il resto del contenuto.


	Mostra nel pannello

	Una funzione di OmniOutliner Pro: puoi fare in modo che le note nel file di OmniOutliner siano visualizzate in un pannello separato nella parte inferiore della finestra.











	Mostra/Nascondi Nota (Opzione-Comando–‘)
 Mostra/Nascondi pannello Note (Pro) (Opzione-Comando–’)

	Mostra o nasconde le note in linea o il pannello Note. Il pannello Mostra/Nascondi Note è una funzione di OmniOutliner Pro.


	Mostra/Nascondi tutte le note (Controllo-Comando–’)

	Abilita o disabilita la visibilità delle note nel documento.


	Mostra/Nascondi barra laterale (Opzione-Comando–1)

	Consente di scegliere se visualizzare la barra laterale sinistra che include le funzioni Cerca, Info documento e Stili.


	Attiva/Esci da schermo intero (Controllo-Comando–F)

	Per attivare la visualizzazione di OmniOutliner a schermo intero. Il vantaggio della funzione è di consentire di concentrarti sul lavoro senza distrazioni. La barra laterale Impostazioni è disponibile in modalità mobile nella parte superiore della finestra; potrai accedere ai pulsanti sulla barra degli strumenti di OmniOutliner spostando il puntatore del mouse verso la parte superiore dello schermo. Per uscire dalla modalità a schermo intero, utilizza nuovamente Controllo-Comando–F, oppure premi il tasto Esc.


	Mostra/Nascondi barra strumenti (Opzione-Comando–T)

	Scegli se visualizzare la barra degli strumenti nella parte superiore della finestra di documento.






	Crea/Rimuovi barra strumenti specifica per il documento (Pro)

	Questa opzione consente di creare una barra degli strumenti specifica per il documento attivo. Ad esempio, gli strumenti necessari per la scrittura di una sceneggiatura saranno totalmente diversi da quelli utilizzati per creare fatture. Dopo aver creato una barra degli strumenti specifica, potresti valutare di salvare il file come modello di OmniOutliner (File ▸ Salva come modello), in modo da non dover mai più ricreare la barra degli strumenti in questione.







	Personalizza barra strumenti

	Scegli questa opzione se desideri personalizzare la barra degli strumenti per ogni documento di OmniOutliner, fatta eccezione per eventuali modelli per i quali tu abbia creato una barra degli strumenti specifica del documento (vedi l’opzione di menu precedente). Consulta la sezione Personalizzazione della barra degli strumenti per maggiori dettagli su come personalizzare e creare barre degli strumenti specifiche per singoli documenti (una funzione di OmniOutliner Pro).





Il menu Organizza


Opzioni per l’aggiunta, la rimozione e l’ordinamento del contenuto del documento:





	Aggiungi riga

	Inserisce una riga sotto la riga corrente.


	Aggiungi all’interno (Comando–})

	Inserisce una nuova riga con rientro sotto la riga corrente.


	Aggiungi all’esterno (Comando–{)

	Inserisce una nuova riga con un livello di rientro in meno sotto la riga corrente.


	Aggiungi colonna

	Inserisce una nuova colonna dopo la colonna attualmente selezionata.


	Rimuovi colonna

	Rimuove la colonna selezionata.


	Mantieni ordinato

	
Scegli una di queste opzioni per ripristinare o mantenere il tipo di ordinamento desiderato per il documento:


	Cancella ordinamento

	Rimuove ogni opzione di ordinamento selezionata in precedenza. Utile quando vuoi ordinare un nuovo documento utilizzando un altro metodo.


	Note, A-Z

	Ordina il contenuto del documento in ordine alfabetico (A-Z) in base alle note per ogni riga.


	Note, Z-A

	Ordina il contenuto del documento in ordine alfabetico inverso (Z-A) in base alle note per ogni riga.


	Stato, da non selezionate a selezionate

	Ordina il contenuto del documento in base allo stato delle caselle di stato, da non selezionato a selezionato.


	Stato, da selezionate a non selezionate

	Ordina il contenuto del documento in base allo stato delle caselle di stato, da selezionato a non selezionato.


	Argomento, A-Z

	Ordina il contenuto del documento in ordine alfabetico (A-Z) in base agli Argomenti utilizzati nel documento.


	Argomento, Z-A

	Ordina il contenuto del documento in ordine alfabetico inverso (Z-A) in base agli Argomenti utilizzati nel documento.





	Ordina struttura

	Consente di ordinare gli oggetti nel documento, una volta, sulla base delle seguenti opzioni:


	Note, A-Z

	Ordina il contenuto del documento in ordine alfabetico (A-Z) in base alle note per ogni riga.


	Note, Z-A

	Ordina il contenuto del documento in ordine alfabetico inverso (Z-A) in base alle note per ogni riga.


	Stato, da non selezionate a selezionate

	Ordina il contenuto del documento in base allo stato delle caselle di stato, da non selezionato a selezionato.


	Stato, da selezionate a non selezionate

	Ordina il contenuto del documento in base allo stato delle caselle di stato, da selezionato a non selezionato.


	Argomento, A-Z

	Ordina il contenuto del documento in ordine alfabetico (A-Z) in base agli Argomenti utilizzati nel documento.


	Argomento, Z-A

	Ordina il contenuto del documento in ordine alfabetico inverso (Z-A) in base agli Argomenti utilizzati nel documento.








	Sposta

	
Utilizza i comandi seguenti per spostare e aumentare o ridurre il livello di rientro delle righe nel documento:


	Sposta su (Controllo-Comando–↑)

	Sposta la riga selezionata e i relativi elementi figli di una riga verso l’alto.


	Sposta giù (Controllo-Comando–↓)

	Sposta la riga selezionata e i relativi elementi figli di una riga verso il basso.


	Sposta a sinistra (Controllo-Comando–←)

	Sposta la riga selezionata e i relativi elementi figli a sinistra, ignorando eventuali elementi di pari livello.


	Sposta a destra (Controllo-Comando–→)

	Sposta la riga selezionata e i relativi elementi figli a destra, rendendoli figli della riga precedente.










Differenze tra Sposta a destra/a sinistra e Crea rientro/Elimina rientro



Quando si tratta di organizzare il contenuto della struttura, è importante comprendere le differenze tra spostare una riga a destra o a sinistra (oppure di un livello in alto o in basso) e applicare o rimuovere un rientro alla riga stessa.




Quando esegui uno spostamento a destra a sinistra, quel che stai facendo apparentemente è spostare la riga e i relativi figli verso l’alto o verso il basso di un livello, all’interno della gerarchia della struttura. Tuttavia, il comando Sposta a destra/a sinistra ignora eventuali righe che si trovano allo stesso livello della riga che stai spostando, ed esegue lo spostamento a destra o a sinistra e in alto o in basso nella gerarchia, come necessario.




Vediamo l’esempio seguente:



[image: Un elenco di nomi di colori con rientri casuali]

Con la riga Arancione selezionata, premi Controllo-Comando–← per il comando Sposta a sinistra. Nota che la riga Arancione si sposta non solo a sinistra, ma anche in fondo alla gerarchia dell’elenco. Infatti, dato che la riga Arancione si trovi allo stesso livello della riga Rosso, viene spostata a sinistra e in basso nell’elenco sotto gli elementi figli del colore Giallo.


[image: Spostamento della riga Arancione verso sinistra]


Se stai seguendo la procedura, premi Comando–Z per annullare la modifica prima di procedere.




Tuttavia, quando applichi o elimini un rientro da una riga, la stessa modifica si applica ai relativi figli. Con la riga Arancione nella posizione originale, premi Comando–[o Maiuscole–Tab per eliminare il rientro della riga stessa. Nota come la riga Arancione, che si trovava allo stesso livello della riga Giallo, ora diventa padre di quest’ultima.



[image: Eliminazione di un rientro per la riga Arancione]


Se premi Comando–] o Tab per applicare un rientro alla riga Arancione, essa diventa figlio della riga Rosso; la riga Giallo (e i relativi figli) mantiene la propria posizione come figlio della riga Arancione.



[image: Applicazione di un rientro alla riga Arancione]


Dedica un po’ di tempo a spostare una o più righe con i comandi Sposta a destra/a sinistra e Crea rientro/Elimina rientro. E se vuoi qualcosa di più creativo, prova a utilizzare anche i comandi Sposta su (Comando–↑) e Sposta giù (Comando–↓) per modificare anche la gerarchia dell’elenco.







	Crea rientro (Comando–])

	Applica un rientro alla riga corrente.


	Elimina rientro (Comando–[)

	Elimina un livello di rientro per la riga corrente.


	Raggruppa (Opzione-Comando–G)

	Applica un rientro alle righe selezionate e le raggruppa sotto una nuova riga padre.


	Separa (Opzione-Comando–U)

	Separa le righe di un gruppo selezionato. La separazione non rimuove la riga padre; se necessario, dovrai eliminarla separatamente.





Il menu Finestra


Opzioni per lavorare all’interno delle finestre di OmniOutliner:





	Contrai (Comando–M)

	Sposta la finestra corrente sul lato destro del Dock. Per riportare in evidenza la finestra, puoi scegliere Finestra ▸ [nome file] (nella parte inferiore del menu Finestra troverai un elenco dei documenti aperti), o semplicemente fare clic sull’icona del documento nel Dock.


	Ridimensiona

	Ridimensiona la finestra del documento di OmniOutliner per ridurla o riportarla alle dimensioni normali. Il comando svolge la stessa funzione del tasto verde Ridimensiona ([image: oo4mac_button_zoom]) nell’angolo superiore sinistro della finestra di documento.


	Mostra/Nascondi finestra impostazioni (Maiuscole-Comando–I)

	Apre le finestre di impostazioni.


	Impostazioni

	Consente di passare direttamente a una delle finestre di impostazioni seguenti:


	Stile

	Colonna

	Struttura

	Documento

	Attributi di stile





	Porta tutto in primo piano

	Porta tutte le finestre aperte di OmniOutliner in primo piano rispetto alle finestre delle altre applicazioni attualmente aperte sul tuo Mac.





Il menu Aiuto


Qualcosa che non ti è chiaro del funzionamento di OmniOutliner? Siamo qui per aiutarti:





	Aiuto OmniOutliner

	Apre il documento della guida in-app che stai leggendo in questo momento.


	Benvenuto

	Una piccola nota di benvenuto da parte nostra. Non siamo teneri?


	Note sulla versione

	Scopri le novità della versione più recente di OmniOutliner. Tra i dettagli che troverai in questa sezione, correzioni di bug, aggiunte e modifiche.






	Apri cartella degli script

	Consente di aprire una nuova finestra del Finder alla posizione ~/Libreria/Application\ Scripts/com.omnigroup.OmniOutliner4. Se crei AppleScript per l’utilizzo con OmniOutliner 4 Pro, questa è la posizione in cui dovresti salvarli.







	Contatta Omni

	Apre un messaggio e-mail indirizzato a omnioutliner@omnigroup.com mediante il quale puoi inviarci un commento o richiedere assistenza. Per agevolare il supporto, la riga Oggetto del messaggio è precompilata con il numero della tua build e il codice di licenza per la tua versione di OmniOutliner.









Gestione delle licenze Omni



Se hai acquistato OmniOutliner direttamente da noi (grazie mille!), avrai ricevuto un messaggio e-mail da The Omni Group contenente le informazioni relative alla tua licenza: il nome utilizzato per la registrazione di OmniOutliner 4, e una stringa di caratteri che costituisce la chiave di licenza. Queste informazioni saranno necessarie per immettere la licenza in OmniOutliner.






Nota
 Se hai acquistato OmniOutliner 4 dal Mac App Store (di nuovo: grazie mille!), non dovrai preoccuparti delle licenze. La tua copia di OmniOutliner 4 ti viene concessa in licenza automaticamente da Apple. Se hai necessità di aggiornare la tua copia, o di reinstallare OmniOutliner, puoi farlo tramite il Mac App Store.





Aggiunta di una nuova licenza



Per immettere la tua licenza, procedi come indicato di seguito:




	Sulla barra dei menu scegli OmniOutliner ▸ Licenze per visualizzare la finestra di dialogo Licenze.

	Fai clic su Aggiungi licenza. Da sotto la barra del titolo della finestra Licenza appare un foglio.

	In Mail (o altro client e-mail da te utilizzato) individua il messaggio e-mail che contiene la chiave di licenza per OmniOutliner 4.

Suggerimento
 Puoi passare rapidamente tra un’applicazione e l’altra sul tuo Mac tramite lo switcher applicazioni integrato di OS X: Comando-Tab. Per mantenere aperto lo switcher applicazioni, tieni premuto il tasto Comando dopo aver premuto Tab. 



Quando premi Comando-Tab, lo switcher applicazioni si apre sullo schermo sotto forma di una fila di icone corrispondenti alle applicazioni attualmente in esecuzione sul Mac. Continua a tenere premuto Comando-Tab fino a individuare l’applicazione che ti interessa (questo caso, Mail) e quindi rilascia il tasto Comando. Puoi anche utilizzare Maiuscole-Comando-Tab per muoverti all’indietro nell’elenco delle applicazioni in esecuzione, oppure utilizzare i tasti freccia sinistra o freccia destra per muoverti avanti o indietro, rispettivamente.






	Nel messaggio e-mail, dovrai individuare il nome utilizzato per il Titolare licenza e la Chiave di licenza. Seleziona il nome accanto a Titolare licenza e scegli Modifica ▸ Copia (o utilizza Comando-C) per copiare il nome negli Appunti.


Nota
 Se non riesci a copiare e incollare queste informazioni, dovrai inserirle manualmente. Assicurati di inserire i dati esattamente come appaiono nel messaggio, trattini inclusi.







	Premi Comando-Tab per tornare da Mail a OmniOutliner.

	Nel campo Titolare, scegli Modifica ▸ Incolla (o premi Comando-V) per incollare il nome utilizzato per la registrazione di OmniOutliner.

	Premi Comando-Tab per passare da OmniOutliner a Mail.

	Nell'e-mail che ti abbiamo inviato, seleziona la chiave di licenza e scegli Modifica ▸ Copia (o utilizza Comando-C) per copiare la chiave di licenza negli appunti.

	Premi Comando-Tab per tornare da Mail a OmniOutliner.

	Fai clic nel campo Chiave di licenza e scegli Modifica ▸ Incolla (o utilizza Comando-V).

	Il menu a discesa Tipo, disattivato di default, limita il tipo di licenza a Personale per l’account utente corrente sul tuo Mac. Tuttavia, la chiave di licenza può essere utilizzata anche per un altro tipo, Computer:



	Personale: Questa licenza è per uso personale e sarà disponibile sul computer corrente solo dopo che avrai eseguito l’accesso con le credenziali dell’utente che ha installato OmniOutliner. Puoi installare questa licenza su più computer, ma solo per uso personale. Questo tipo di licenza non ti consente di utilizzare il software su due computer diversi contemporaneamente. Se è disponibile una licenza personale, l’applicazione la utilizzerà sempre.


	Computer: Puoi configurare il Mac per utilizzare questo tipo di licenza, che consente a qualsiasi altro account utente sul Mac stesso di utilizzare OmniOutliner. Vedi Configurazione di OmniOutliner per supportare la licenza Computer per informazioni su come procedere.







	Fai clic su Salva.





Dopo che hai fatto clic su Salva, la chiave di licenza viene verificata; quindi, se hai acquistato OmniOutliner 4 Pro, dovrai, riavviare OmniOutliner per sbloccare tutte le caratteristiche della versione Pro.




Non riesci a trovare il messaggio e-mail contenente la chiave di licenza?


Se non trovi più il nostro messaggio e-mail contenente le informazioni di licenza, puoi riottenerle rapidamente andando alla nostra pagina Lost and Found (“Oggetti smarriti”).




Basta inserire l’indirizzo e-mail che hai utilizzato all’acquisto di OmniOutliner (o di qualsiasi altro prodotto di The Omni Group) e fare clic su Send Licenses (Invia licenze). Se il nostro sistema riconosce l’indirizzo e-mail, i nostri robot ti invieranno un messaggio e-mail contenente le informazioni di licenza che ti servono. Lo vedi che i robot possono anche essere simpatici?




Ti ricordiamo che, se hai acquistato OmniOutliner 4 dal Mac App Store, non ti verrà rilasciata una licenza. Sarà sufficiente accedere al tuo account Mac App Store e andare su Acquisti per reinstallare le applicazioni già acquistate.






Acquisto di una licenza



Diciamo che hai scaricato OmniOutliner 4 dal nostro sito web e ne hai fatto buon uso durante il periodo di prova gratuita di 14 giorni. Hai creato un sacco di elenchi molto “strutturali” e hai perfino iniziato a tracciare i profili dei personaggi di quel libro che vuoi scrivere da sempre. Ora sei totalmente convinto e colpito dalle caratteristiche di OmniOutliner 4 Pro, e hai deciso che è venuto il momento di acquistare OmniOutliner 4 prima che termini il periodo di prova.






Puoi acquistare OmniOutliner 4 dal Mac App Store, oppure acquistare una chiave di licenza direttamente da noi, dall’interno di OmniOutliner!




Per acquistare una licenza:




	Apri OmniOutliner 4.

	Sulla barra dei menu scegli OmniOutliner ▸ Licenze per visualizzare la finestra di dialogo Licenze.

	Fai clic su Acquista licenze.





Una volta fatto clic sul pulsante Acquista licenze, ti troverai magicamente trasportato (col tuo browser preferito) nell'Omni Store, dove potrai acquistare una licenza per OmniOutliner 4 (ovviamente solo se sei connesso a Internet).




Registrazione di un’app Omni acquistata tramite canale di vendita al dettaglio



Se hai acquistato OmniOutliner da un canale di vendita al dettaglio (ad esempio un Apple Store), dovrai registrarti sulla nostra pagina di registrazione prodotto.




Nel caso in cui perdessi la chiave di licenza, registrando la tua applicazione Omni sarai certi di poter recuperare le tue informazioni di licenza mediante la nostra pagina Lost and Found (“Oggetti smarriti”).






Configurazione di OmniOutliner per supportare la licenza Computer



Se sul tuo Mac sono presenti più account utente e desideri che tutti gli utenti possano sfruttare OmniOutliner, dovrai seguire una piccola procedura (questo è dovuto al sandboxing delle app imposto da Apple in OS X 10.7 e versioni successive). Per impostare una licenza Computer, attieniti alla procedura seguente:






		Esci da OmniOutliner.

		Apri una nuova finestra del Finder.

		Imposta le impostazioni di visualizzazione del Finder su Colonna, scegliendo Vista ▸ Come colonne (o utilizzando Comando-3). In questo modo ti sarà più facile muoverti all’interno della gerarchia delle cartelle sul tuo Mac.

		Scegli Vai ▸ Computer.

		Scegli il disco rigido del tuo Mac (se non l’hai rinominato, dovrebbe chiamarsi Macintosh HD), quindi muoviti attraverso le seguenti cartelle:
	
			Library


			Application Support

	

	

		Nella cartella Application Support, crea una nuova cartella (scegli File ▸ Nuova cartella, o utilizza Maiusc-Comando-N) e denominala Omni Group. Dovrai immettere la password di amministratore per creare una nuova cartella a questo livello.

		Nella cartella Omni Group, crea una nuova cartella e denominala Software Licenses (Licenze software).

		Apri di nuovo OmniOutliner, quindi scegli OmniOutliner ▸ Licenze.

		Fai clic su Aggiungi licenza.





Quando fai clic su Aggiungi licenza, noterai che il menu a discesa Tipo non è più visualizzato in grigio, e che l’opzione Computer è disponibile per la selezione. Ora è sufficiente inserire le informazioni relative a Titolare e Chiave di licenza ottenute da Omni e fare clic su Salva.




Rimozione di una licenza


Per rimuovere una licenza:





	Scegli OmniOutliner ▸ Licenze.

	Seleziona la licenza che desideri rimuovere nella finestra Licenze.

	Fai clic su Elimina licenza.

	Viene visualizzato un foglio di avviso che ti chiede di confermare l’eliminazione della licenza. Se sei certo di voler procedere, fai clic su Elimina. Se hai cambiato idea, fai clic su Annulla e chiudi la finestra Licenze.









Assistenza


Quando hai bisogno di aiuto, perché stai cercando di capire come funzionano i livelli, o perché hai altri problemi con OmniOutliner, è utile sapere che il personale dell’assistenza di The Omni Group è sempre pronto a darti una mano.





Il sito web di OmniOutliner


Il sito web di OmniOutliner è una risorsa preziosa per consultare le informazioni più recenti su OmniOutliner.





Forum


I forum online per tutti i prodotti di The Omni Group sono a tua disposizione. Vieni a condividere domande e suggerimenti con gli altri utenti e con il personale Omni.





Assistenza via e-mail


Se hai un problema che non riesci a risolvere, hai un suggerimento per la prossima versione di OmniOutliner, o semplicemente vuoi farci un saluto, inviaci un’e-mail. Scegli Aiuto ▸ Contatta Omni dalla barra dei menu per creare automaticamente un messaggio indirizzato a The Omni Group, oppure scrivici direttamente. Per The Omni Group l’assistenza è un elemento molto importante; ti assicuriamo che riceverai una risposta (non automatica!) in tempi brevi.





Note sulla versione


Per informazioni ultra-dettagliate sulle modifiche apportate a ogni versione di OmniOutliner, seleziona Aiuto ▸ Note sulla versione dalla barra dei menu.





EPUB/art/oo45mac_printing07.png
?

Ricetta pane alla banana.oo3 — Modificato ~

~ Pane alla banana
oo
B

K <

1di1 > | »

PDF

Nascondi dettagli

016, 204139

| W Evidenziazione:...

W Evidenziazione:...

Viola

Blu

Verde
Giallo
Arancione

Rosso

+ B EEE EE

F5
F6
F7
F8
F9

Stampante: = @ Samsung CLX-3180 Series
Preset: Impostazioni di default
Copie: 1
Pagine: © Tutte
(pa: 1 a1
Margini
Dall'inizio della pagina all'intestazione: ,64 cm C
Dall'inizio della pagina al contenuto: 1,27 cm C
Margine sinistro: 1,27 cm ° Margine destro: 1,27 cm <
Dal contenuto al fondo pagina: 1,27 cm <
Dal pié di pagina al fondo pagina: ,64 cm <
("] Copia i margini laterali di pagine affiancate
Annula
TE |

Per prima cosa montare parte del burro nella ciotola, quindi aggiungere
gradualmente lo zucchero e continuare a mescolare.






EPUB/art/oo45mac_printing06.png
0@ ® "= Ricetta pane alla banana.oo3 — Modificato ~

[N -0 €29 | ¢ ENO
Rcetta pane ata banana. 27/05/16. 204139 . [, i ‘ol
ol b Stampante: @ Samsung CLX-3180 Series
I Preset: Impostazioni di default

oo Copie: 1
Pagine: °Tutte

Cpa 1 w1

Intestazioni e pié di pagina

Pagina principale B

Intestazioni

[0}

Ricetta pane alla banana (27/05/16, 20:41:39

« < 1di1 > >> =
- - Inserisci... N

Pié di pagina

Inserisci... v

?  PDF Nascondi dettagli Annulla

Verde
Giallo
Arancione

Rosso

+ B EEE





EPUB/art/oo4mac_pastebehavior.png
Cursore in una
nuova riga

Riga selezionata

Comportamento con funzione Incolla

.

Questa & una riga
Questa € un'altra riga
E questa € I'ultima riga|

Questa & una riga
Questa € un'altra riga

E questa & I'ultima riga






EPUB/art/oo45mac_printing03.png
Ingredienti

PapmEm—
5098 a8 rocipmcan

Procadimento

CN J = Ricetta pane alla banana.oo3 — Modificato ~

~ Pane alla banana

Stampante: @ Samsung CLX-3180 Series

Preset: Impostazioni di default

Pagine: © Tutte

Contenuto

Righe: Documento:

Stampa solo righe selezionate Adatta a larghezza pagina
Filtra righe in base a casella di stato Stampa titoli colonne
Includi selezionate Stampa maniglie riga

) Includi deselezionate

" | Espandi per mostrare tutti i discendenti
Compatta rientro
Includi note

© come visualizzate nel documento
" espanse

v

1di1

Stampa colori righe alternati
Stampa altri colori di sfondo

PDF Nascondi dettagli Annulla
- W Evidenziazione:... F6 [] gradualmente lo zucchero e continuare a mescolare. |

A] Viola F7

(A] Blu F8 [

A] Verde Fo (]

Al Giallo

[A] Arancione L)

(A] Rosso UJ

+ - 2






EPUB/art/oo45mac_printing02.png
Ricetta pane alla banana.oo3 — Modificato ~

Stampante: @ Samsung CLX-3180 Series

~ Pane alla banana

ngrecont Preset: Impostazioni di default

Pagine: © Tutt
) Da:

Contenuto

Righe: Documento:

Stampa solo righe selezionate Adatta a larghezza pagina
_ Filtra righe in base a casella di stato Stampa titoli colonne
Judi se ate Stampa maniglie riga
O (el CE e Stampa colori righe alternati
Stampa altri colori di sfondo

| Espandi per mostrare tutti i discendenti
Compatta rientro
Includi note

© come visualizzate nel documento

) espanse

? PDF Nascondi dettagli Annulla

- | ' Evidenziazione:... F6 [_] gradualmente lo zucchero e continuare a mescolare. |

[A] Viola F7

[A] Blu F8 [

[A] Verde Fo (]

[A] Giallo

[A] Arancione O

[A] Rosso O

+ Py






EPUB/art/oo45mac_printing05.png
?

000 F Ricetta pane alla banana.oo3 — Modificato ~
[oF W €24 s A E N O
Stampante: @ Samsung CLX-3180 Series
~ Pane alla banana
B Preset: Impostazioni di default
ntrmern Pagine: © Tutte
Cpa: 1 a1
Intestazioni e pié di pagina B
Pagina principale B
Intestazioni
<« < 1di1 > > Ao
- - Inserisci... Rk
o . Numero di pagina

Pié di pagina Titolo sezione L3
Ora di ultima modifica
Conteggio pagine
Titolo documento
Nome del documento
Ora di stampa

N T O

PDF Nascondi dettagli

Verde
Giallo
Arancione

Rosso

+ B EEE






EPUB/art/oo45mac_printing04.png
?

~ Pane alla banana

PDF

1di1

Nascondi dettagli

Stampante: @ Samsung CLX-3180 Series
Preset: Impostazioni di default

Pagine: © Tutte
Da: 1 a: 1

¥ Contenuto

Intestazioni e pié di pagina
Margini

Righe:

Stampa solo righe  Layout ghezza pagina
Filtra righe in base Gestlor}e canta li colonne
Copertina N L.
C iglie riga

Grafica
Carta
Caratteristiche stampante

ori righe alternati
i colori di sfondo

Espandi per most
Compatta rientro
Includi note

© come visualizzate nel documento

~espanse






EPUB/art/oo4mac_pref_audiorecording.png
O Preferenze Registrazione audio

= = a8 B 53 O

Generali Tastiera Testo Esportazione RTF Registrazione audio Aggiornamento

Dispositivo di ingresso: Microfono integrato

| dispositivi possono essere modificati in Preferenze di Sistema »
Audio » Ingresso.

Modifica preferenze

Compressione: @) Prestazioni ottime
) Qualita ottima

Cartella registr. temporanea: Apri cartella

In questa sezione puoi recuperare o eliminare eventuali file audio
temporanei in caso OmniOutliner si chiuda improvvisamente durante
una sessione di registrazione.






EPUB/art/oo4mac_uioverview.png
eoce 5 migliorie_bici 2016.003 — Modificato ~

[ 3] B 100% ) & o

Nascondi barra aterale_Tema___Zoom Inzia registrazione_Aggiungi colonna._impostaziont
conTeNuTI @ Componente

v Migliorie alla bici per... v Migliorie alla bici per il 2016

» Trasmissione. Trasmissione $1,168.95

» Sospensione/Ruote Pedali Shimano XTR OD-M985 $179.00

» Parte anteriore Pulegge Shimano XTR OD-M985 $444.99

v Atro Gambio anteriore Top Swing Shimano XTR OD-M985 $80.99
* Sellino Brooks C1... Cambio posteriore Shadow Plus Shimano XTR OD-M985 $199.99
* Reggisell... Catena Shimano XTR a 10 velocita $54.99

st & Gassetta Shimano XTR a 10 velocita $199.99
B Documento intero prpe

[ Titoli colonne
Righe ivello 1 « Ruote Mavic CrossMax SLR 29 $999.99

Righe livello 2 « Pneumatici WTB Wierwolf AM TCS. $118.00
Righe lvello 3 [p— $1,599.98
[ Note .
Componente « Manubrio Napaim Carbon di Loaded Precision $220.99
e « Asse Napalm Carbon 120mm/6° di Loaded Precision $§249.99 Sopralanota: 0

« Forcella Fox 34 Talas 29 140 Fit CTD regolabile $1,120.00

Sospensione/Ruote

Sopraifighi: 0
@ intestazione 1

(&) Intestazione 2

(@) Intestazione 3
i . * Reggisella telescopico Crank Brothers Kronolog $269.99

W cvidenziszione:.. F4 [ tegg P 9 Rientro figi: (MMM o

W Evidenziazione:... * Cavi $50.00|

« Sellino Brooks C17 Cambium $160.00

W Evidenziazior F8 stiliinclusi: Nessuno

@
(B verde

@ Gialo

[@ Avancione
+





EPUB/art/oo45mac_printing01.png
‘= Ricetta pane alla banana.oo3 — Modificato ~

~ Pane alla banana

Ingrecinti

<«

PDF

<

1di1

Nascondi dettagli

>

Stampante: =@ Samsung CLX-3180 Series

Preset:  Impostazioni di default

Pagine: © Tutte
Cpa 1 a1

Contenuto

(0}

Righe:
| Stampa solo righe selezionate
| Filtra righe in base a casella di stato
Includi selezionate
®) Includi deselezionate
| Espandi per mostrare tutti i discendenti

~ Compatta rientro
Includi note

° come visualizzate nel documento

~
|__'espanse

Documento:

Adatta a larghezza pagina
Stampa titoli colonne
Stampa maniglie riga
Stampa colori righe alternati
Stampa altri colori di sfondo

Annulla

W Evidenziazione:...

+ B EEEE

Viola
Blu
Verde
Giallo

Arancione

Rosso

F6 [

gradualmente lo zucchero e continuare a mescolare.






EPUB/art/cover.png
UINNOIUWIO

Manuale
CD dell'utente di
— \ per Mac






EPUB/art/oo4mac_button_action03.png





EPUB/art/oo4mac_button_action2.png





EPUB/art/oo4mac_button_action01.png





EPUB/art/oo4mac_keyboardshortcut04.png
@& OmniOutliner File Modifica Formato Organizza Finestra Aiuto

Espandi tutte ~$89
Contrai tutte ~3%0
Contrai riga &0
Contrai riga completamente &0
Metti in evidenza {+38F
Zoom avanti 8>
Zoom indietro ¥<
Porta alle dimensioni reali N 81
Intestazioni colonna »>

Mostra caselle di stato

Colonne »
Testo riga >
Note >
Nascondi nota &'

Nascondi tutte le note ~3'

Nascondi barra laterale 31
Mostra ricerca

Nascondi stili

Attiva modalita a tutto schermo ~%F
Nascondi barra strumenti 8T

Crea barra strumenti specifica per il documento
Personalizza barra strumenti...






EPUB/art/oo4mac_button_action02.png





EPUB/art/oo4mac_keyboardshortcut03.png
[} Tastiera

Applicazione: Tutte le applicazioni

Per modificare u ) , o . erisci i
e el mve] Titolo menu: Porta alle dimensioni reali

M Launchpad Inserisci il nome esatto del comando
) menu che vuoi aggiungere.
= Monitor . . o8/
ER Mission Coi  Abbreviazione da tastiera: %1 ‘
Tastiera

| Sorgenti di Annulla Aggiungi

¥ Istantanee !
£ Servizi

@ Spotlight A
@ Accessibilita
A\ Abbreviazioni app

+

Accesso completo tramite tastiera: nelle finestre e nelle finestre di dialogo, premi il Tabulatore
per spostare il punto focale della tastiera tra:

o Solo riquadri di testo ed elenchi
Tutti i controlli

Premi Ctrl+F7 per modificare questa impostazione.

Livello batteria tastiera: @ ) 15%






EPUB/art/oo4mac_clippings_folders.png
Default Clippings

-
Make Default Clipping File
Open

Open Clippings Folder






EPUB/art/oo4mac_keyboardshortcut02.png
Tastiera Q Ricerca

Tastiera  Testo | AlslslcliEralenll Sorgenti di input

Per modificare un‘abbreviazione, selezionala, fai clic sulla combinazione di tasti, quindi inserisci i
tasti della nuova abbreviazione.

M Launchpad e Dock v Tutte le applicazioni

= Monitor Mostra il menu Aiuto 8/
B3 Mission Control

|| Tastiera

| Sorgenti di input
¥ Istantanee schermo

4 Servizi

@ Spotlight
@ Accessibilita

Abbreviazioni app

&L=

Accesso completo tramite tastiera: nelle finestre e nelle finestre di dialogo, premi il Tabulatore
per spostare il punto focale della tastiera tra:

°Solo riquadri di testo ed elenchi
" Tutti i controlli

Premi Ctrl+F7 per modificare questa impostazione.

Livello batteria tastiera: @) 15% ?






EPUB/art/oo4mac_specialcharacters.png
LN ] 5 Campeggio.003 — Modificato ~
(28-S

T, @ T Campeggio con Diego
v ltinerario: da TRN a FRZ
» Campeggio con Diego Campeggio con Diego
L] Caratten
. # Ric ]
. © Emoji © smileyepersone  Viaggi e luoghi
— Frecce
. A o @ mmtoraws = @ & ™
sTIL " i N
® ) 0 pareesi & chocrnse ¥ %
B Documento intero #5 Pittogrammi B 8 @ =
[ Titoli colonne ., Pumeggiatra @ Atith " -
Righe livello 1 * punt {8 Vieggi e luoghi 2z '
= Tend
| Righe livello 2 Ne simbolialldbetcl o) B R EB8 enda
i} Righe livello 3 /" simboli R aEA R Z Aggiungi ai preferiti |
8 Note $ simboli valute simboli
Variazione font
| Rubrique P Bandiere L "
b o 3
(&) Intestazione 1 m 0
@ Intestazione2  F2 [J Bx=Ex
[@ Intestazione 3 3 [J * Fomell da cag EEOE E
8| =mnm
]
(&) Arancione 70
[ Viola /0
Blu f 0
(&) verde (m}
[ Giallo (]
(A Rosso (]
2] Grafite m
ar E-






EPUB/art/oo4mac_keyboardshortcut01.png
@& OmniOutliner File Modifica Formato Organizza Finestra Aiuto

Espandi tutte ~$89
Contrai tutte ~3%0
Contrai riga &0
Contrai riga completamente &0
Metti in evidenza {+38F
Zoom avanti 8>
Zoom indietro ¥<
Porta alle dimensioni reali N

Intestazioni colonna »>

Mostra caselle di stato

Colonne »
Testo riga >
Note >
Nascondi nota &'

Nascondi tutte le note ~3'

Nascondi barra laterale 31
Mostra ricerca

Nascondi stili

Attiva modalita a tutto schermo ~%F
Nascondi barra strumenti 8T

Crea barra strumenti specifica per il documento
Personalizza barra strumenti...






EPUB/art/oo45mac_icon_linkedfolder.png





EPUB/art/oo4mac_button_search.png





EPUB/art/oo4mac_toolbar_docspecific.png
Aa

migliorie_bici_2016.003 ¥
8 1O 5






EPUB/art/oo4mac_inspector_column.png
= N m|

A 2 0O B
Tipo: RTF
Riepilogo: Nessuno






EPUB/art/oo4mac_audiorecording03.png
v Ecco le impressioni del team sulla nuova funzione...

o ) > [J (]






EPUB/art/oo4mac_audiorecording04.png
v Ecco le impressioni del team sulla nuova funzione...

o W) D> l‘l—t‘

Mostra come lettore™ VI Rolol CRIoI )

Nome visualizzato:

1464372538.317092

Apri con iTunes.app © Fine






EPUB/art/oo4mac_icon_notes.png





EPUB/art/oo4mac_audiorecording01.png
[ JON ] Senza titolo -

CONTENUTI @





EPUB/art/oo4mac_audiorecording02.png
Registrazione ll V 00:00:02

In pausa [ RV 4 00:00:01





EPUB/art/oo4mac_button_inspector_styleattributes.png





EPUB/art/oo4mac_pref_update.png
Preferenze Aggiornamento software automatico

=8 B L]

Generali Tastiera Testo Esportazione RTF Registrazione audio Aggiornamento

Verifica aggiornamenti: =~ Ogni giorno B Cerca aggiornamenti adesso...

Includi le informazioni di sistema

Scegliendo di inviarci le tue informazioni di sistema, nelle prossime
versioni la tua configurazione potra avere un migliore supporto. Questa
operazione & completamente volontaria e anonima. Ti garantiamo che tali
informazioni verranno utilizzate in modo totalmente legittimo.

Ulteriori informazioni...

Ripristina ?






EPUB/art/oo4mac_stylechit04.png





EPUB/art/oo4mac_button_inspector_outline.png





EPUB/art/oo4mac_stylechit03.png





EPUB/art/oo4mac_stylechit06.png





EPUB/art/oo4mac_sync10.png
(R ® AL 3 @D 0 = 70%

| Il Pause |-§v

1 Create a Folder 2 Pick a Cloud Location 3 Connect

Connection Successful!

You can now add or save files to your Synced Folder. Sync other
OmniPresence devices to this cloud location to connect this folder to

your other devices.

Open OmniPresence at Login

Open Synced Folder






EPUB/art/oo4mac_spotlight_search.png
Q_ migliorie|_bici_2016.003 2 |

MIGLIOR RISULTATO

v Migliorie alla bici per il 2016 $4,366.91

R migiiorie_bici_2016..003
ST « Pedali Shimano XTR OD-M985 $179.00
B « Pulegge Shimano XTR OD-M985 $444.99
D migliorie_bici_2016..003 « Cambio anteriore Top Swing Shimano XTR OD-Mg85  $89.99
. o « Cambio posteriore Shadow Plus Shimano XTROD-  $199.99
| migliorie_bici_2016..003 Mogs
« Catena Shimano XTR a 10 velocita $54.90

migliorie_bici_2016..003 « Cassetta Shimano XTR a 10 velocita $199.99

- « Ruote Mavic CrossMax SLR 29 $999.99
‘ bicicletta « Pneumatici WTB Wierwolf AM TCS $118.00
socuma po-

= N " * Manubrio Napalm Carbon di Loaded Precision $229.99
El !
- Donaz'°nl pdf * Asse Napalm Carbon 120mm/6° di Loaded Precision $249.99
E d0cument°F|rmatO.pdf * Forcella Fox 34 Talas 29 140 Fit CTD regolabile $1,120.00
Altro $479.99
g Trasloco.pdf o Sellino Brooks C17 Cambium $160.00
SEGNALIBRI E CRONOLOGIA « Reggisella telescopico Crank Brothers Kronolog zsg_gg
e Cavi 0.00

Amazon.it: faro anteriore cromato

Associazione ciclismo Cascade | Red-...

Incontro annuale dei soci





EPUB/art/oo4mac_stylechit05.png





EPUB/art/oo4mac_sync11.png
¥ 6 P MO N F es%E

= Add Synced Folder






EPUB/art/oo4mac_button_clearstyle.png





EPUB/art/oo4mac_sync09.png
@8 6 A L1 3 @O0 S 0%
| v

1 Create a Folder 2 Pick a Cloud Location 3 Connect

Connecting

Testing Server for Compatibility






EPUB/art/oo4mac_sync05.png
© %

@ AL 3 MO T 75%

Welcome to OmniPresence

OmniPresence is a way to create and
share folders between your devices
using a web server.

The OmniPresence app on your Mac connects you to the folders on
your other devices.

OmniPresence can be used with your own web server, or with the
Omni Sync Server for documents created with your Omni apps.

Set Up Syncing






EPUB/art/oo4mac_sync06.png
(R4 ® A L1 3 @D 0 = 74%

1 Create a Folder

Create a local Folder

This new folder will live on your computer. This is where you will store
documents you want to keep synced.

Create a Synced Folder






EPUB/art/oo45mac_sections05.png
CONTENUTI

v Livello 1

v Livello 2
e Livello 3
e Livello 3
e Livello 2

e Livello 42






EPUB/art/oo4mac_sync07.png
© ® AL 3 @D 0 = 73%

\

| New Folder: OmniPresence—Work|
¢ Tags:

1 Where: Documents

c

Cancel

Create a Synced Folder






EPUB/art/oo4mac_sync08.png
© 8 ® A L1 3 @D 0 = 2%

1 Create a Folder 2 Pick a Cloud Location
Pick a Cloud Location to store your synced files
Any files currently in this location will be added to your local folder.

Omni Sync Server Web Server
Easily sync Omni documents. Your own WebDAV space.
Signup is free!

Sign Up for an Omni Sync Server Account

Account Name: omnidocwranglers

Password: eeececcscece

Connect






EPUB/art/oo4mac_handle_alwayson.png
-«





EPUB/art/oo4mac_sync01.png
[ XON |21 Downloads

< 38 ZEv %y M| O Q Ricerca By
. )
Dropbox
£33 Drop A
¢ iCloud Drive PR
@ AirDrop
/A, Applicazioni
(=] Desktop
D ti .
MR Document OmniPresence-1.4.1.dmg
o Downloads
3 Condivisa Immagine disco - 5,4 MB

Creato Lunedi 23 maggio 2016 20:37

RachteshlD Modificato Lunedi 23 maggio 2016 20:38
[ Sites Ultima apertura Lunedi 23 maggio 2016 20:38
3 Aggiungi tag...
ﬁj victor
£33 Empresa
Dispositivi & Macintosh HD » (& Utenti > %" victor > /@] Downloads > & OmniPresence-1.4.1.dmg

Selezionato 1 di 1, 317,91 GB disponibili





EPUB/art/oo45mac_sections02.png
CONTENUTI

v Livello1

v Livello 2

e Livello3

o Livello3

e Livello 2

o Livello 42

v Livello 2
e Livello3
e Livello3






EPUB/art/oo4mac_icon_notes_visible.png





EPUB/art/oo4mac_sync02.png
o060 | OmniPresence

OmniPresence L] N\

The Omni Group

& Applications

Drop OmniPresence
here to install it in your
OmniPresence.app Mac's Applications
folder. Or, just place it

wherever you'd like.

Your documents, synced everywhere






EPUB/art/oo45mac_sections01.png
CONTENUTI

v Livello1

v Livello 2

e Livello 3

e Livello 3

e Livello 2

o Livello 42

v Livello 2
e Livello3
e Livello3






EPUB/art/oo4mac_stylechit01a.png





EPUB/art/oo4mac_sync03.png
OmniPresence

The Omni Group

Applications

N AR Drop OmniPresence
here to install it in your
OmniPresence.app Mac's Applications
folder. Or, just place it
wherever you'd like.

Your documents, synced everywhere






EPUB/art/oo45mac_sections04.png
CONTENUTI

v Livello 1

v Livello 2

o Livello 3
o Livello 3
e Livello 2

o Livello 42






EPUB/art/oo4mac_handle_onhover.png
-«





EPUB/art/oo4mac_sync04.png
000 [ Applications
Hl = ol EEmy v M a Q Search
Favorites
=] Dropbox &
& iCloud Drive
@ AirDrop OmniGraffle.app OmniOutliner.app OmniPresence.app Pages.app
#3; Applications
—
Desktop - —‘
[ Documents -
0 Downloads Photo Booth.app Pixelmator.app Pixen.app Preview.app
& Pictures
e
Devices
QuickTime Reminders.app Safari.app Sketch.app
Player.app






EPUB/art/oo45mac_sections03.png
CONTENUTI @ v Livello 2

v Livello1 e Livello3
v Livello 2 e Livello 3
e Livello 3
e Livello 3
e Livello 2

e Livello 42






EPUB/art/oo4mac_button_zoom.png





EPUB/art/oo4mac_license.png
Software Licensed: OmniOutliner Professional 4

Add or remove licenses below. If you don't have a license, click on the
‘Buy Licenses..." button below to go to our online store, call 1.800.315.0MNI x100
(or +1 206.523.4152 x100), or send email to <sales@omnigroup.com>.

| Owner | Entered | Expires

100 The Omni Group 10/15/13 4/1/14

@ | Delete License | (CAdd icehsers)






EPUB/art/oo4mac_newuishot.png
migliorie_bici_2016.003 — Modificato ~

CONTENUTI Componente

v Migliorie alla bici per il 2016

v Migliorie alla bici per...

$1,168.95
> Sospensione/Ruote e Pedali Shimano XTR OD-M985 $179.00
Pulegge Shimano XTR OD-M985 $444.99

» Trasmissione Trasmissione

» Parte anteriore

v Altro o Cambio anteriore Top Swing Shimano XTR OD-M985 $89.99
o Sellino Brooks C1... « Cambio posteriore Shadow Plus Shimano XTR OD-M985  $199.99 CE Bl = E
 Reggisell... o Catena Shimano XTR a 10 velocita $54.99 Altezzariga: 1,1 x
Sl © o Cassetta Shimano XTR a 10 velocita $199.99 Sfondo: | mem— )

B8 Documento intero

B8 Titoli colonne
3 Righe livello 1 * Ruote Mavic CrossMax SLR 29 $999.99

Sospensione/Ruote $1,177.99

Maniglia: - o«
Numerazione: = Nessuna '
Margine interno: | mmm—— B

Righe livello 2 * Pneumatici WTB Wierwolf AM TCS $118.00
Righe livello 3

Parte anteriore $1,599.98

e Manubrio Napalm Carbon di Loaded Precision $229.99 Spaziatura interna: 4 e

e Asse Napalm Carbon 120mm/6° di Loaded Precision $249.99 Sopra lanota: 0 ©

o Forcella Fox 34 Talas 29 140 Fit CTD regolabile $1,120.00 Sopra i figli: [0 Q)
[A] Intestazione 1 F1 -
E. Intestazione 2 F2 Sotto i figli: 0 @
[ Intestazione 3 3 o Sellino Brooks C17 Cambium $160.00 e AR s m
! Evidenziazione:... F4 * Reggisella telescopico Crank Brothers Kronolog $269.99 Rientro figli: M
W Evidenziazione:... F5 E] e Cavi $50.00

W Evidenziazione:... F6
[A] Viola F7
[A] Blu F8
[A] Verde F9
[A] Giallo

[A] Arancione

stili inclusi: ~ Nessuno n

O0ooocooocooa

]
<





EPUB/art/oo4mac_button_inspector_style.png





EPUB/art/oo4mac_inspector_column_summary.png
CONTENUTI

» Migliorie alla bici per...

migliorie_bici_2016.003

Componente

STILI

Ed Documento intero

B4 Titoli colonne
Righe livello 1
Righe livello 2

{__i Righe livello 3

©

Intestazione 1

Intestazione 2

Intestazione 3
Evidenziazione:...
Evidenziazione:

Evidenziazione:...

Viola

Blu

Verde
Giallo
Arancione

+ BEEERERENNNERE

v Migliorie alla bici per il 2016
Trasmissione
Pedali Shimano XTR OD-M985
Pulegge Shimano XTR OD-M985
Cambio anteriore Top Swing Shimano XTR OD-M985

Cambio posteriore Shadow Plus Shimano XTR OD-
M985

Catena Shimano XTR a 10 velocita
Cassetta Shimano XTR a 10 velocita
Sospensione/Ruote
¢ Ruote Mavic CrossMax SLR 29
e Pneumatici WTB Wierwolf AM TCS
Parte anteriore
e Manubrio Napalm Carbon di Loaded Precision
o Asse Napalm Carbon 120mm/6° di Loaded Precision
e Forcella Fox 34 Talas 29 140 Fit CTD regolabile

¢ Sellino Brooks C17 Cambium
* Reggisella telescopico Crank Brothers Kronolog

e Cavi

$1,168.95
$179.00
$444.99
$89.99
$199.99

$54.99
$199.99
$1,177.99
$999.99
$118.00
$1,599.98
$229.99
$249.99
$1,120.00

$160.00
$269.99
$50.00






EPUB/art/oo4mac_icon_128px.png





EPUB/art/oo4mac_inspector_styleattributes.png
[} Attributi di stile

T =k
A SER 7
Riga "-"

font > colore riempim.: Gesso

[Ed font > dimensione: 14

4 font > spessore: Grassetto

W] colore sfondo: Blu acqua chiar...
Documento intero

[Ed font > dimensione: 13

[Ed font > famiglia: Helvetica Neue

[Ed multiplo altezza linea: 1.1

4 orientamento: da sinistra a de...

[E4 riga > spaziatura interna: 0





EPUB/art/oo4mac_outlinerpro_menu.png
.' ol lle I 18 File Edit Format View Organize Window Help

About OmniOutliner
Check for Updates...

Preferences... 8,
Licenses...

Pro Purchased

Services >

Hide OmniOutliner  3H
Hide Others X $H
Show All

Quit OmniOutliner ¥#Q






EPUB/art/oo4mac_sync12.png
) = 68% Tue 3:31 P

=+ Add Synced Folder Il Pause o3

About OmniPresence
Release Notes

OmniPresence—Work

Q) v Open at Login N
Check for Updates...

Preferences and Privacy...

OmniPresence Help
Contact Omni

Quit OmniPresence






EPUB/art/oo4mac_sync13.png
=+ Add Synced Folder

OmniPresence—Work






EPUB/art/oo4mac_sync14.png
Local Folder:

Cloud Location:

Account Name:

Password:

Disconnect...

(R4 ® A1 3 @O 0 = 66%m

| Il Pause |§v

/Users/chuck/Documents/OmniPresence —Work

https://sync.omnigroup.com/omnidocwranglers

omnidocwranglers





EPUB/art/oo4mac_stylechit02a.png





EPUB/art/oo4mac_attachment03.png
Lista dei desideri per la mia bicicletta

Nome visualizzato:

Lista_dei_desideri_per_la_mia_bicicletta

Apri con OmniOutliner.app ©






EPUB/art/oo4mac_attachment02.png
Immagini Filmati

B slomovideo

[z Mostra come immagine Y {EKels] i [R{ele]

Apri col eprima.app ©






EPUB/art/oo4mac_attachment01.png
Immagini Filmati Documenti

. B slomovideo
. =

2 OmniGraffle 6
-~ per Mac






EPUB/art/oo4mac_toolbar_callouts.png
Chiudi Nascondi Attiva/Disattiva modalita Icona Rinomina, duplica o
finestra finestra  a tutto schermo documento___Nome documento sposta documento

\N |7 ] ]

[ XX 1 migliorie_bici_2016.003
] B 100% ¢ i)
Nascondi barra laterale  Tema Zoom Inizia registrazione Aggiungi colonna Impostazioni
Mostra/Nascondi Applica Zoom struttura Awia/lnterrompi Ag?iungi Mostra/Nascondi
barra laterale tema. registrazione colonna impostazioni





EPUB/art/oo4mac_resourcebrowser_quicklook.png
Q0 Moderno con stili livello.oo3template

" Stili livello

¥ Sezione 1
V¥ Sottosezione 1A

® Questo documento assegna automaticamente uno stile alla riga
in base al suo livello.

® Puoi personalizzare gli stili "righe di livello n" nella barra laterale
come desideri, in questo documento o in qualsiasi documento di
OmniOutliner.

® Sottosezione 1B

¥ Sezione 2
® Sottosezione 2A

® Sottosezione 2B

Apri con OmniOutliner

th






EPUB/art/oo4mac_attachment00.png
00 = migliorie_bici_2016.003 -

£ . 0
B <> 8= @ 5%+ | [7 Desktop c i) g Q Cerca
—— = IMG_2759.CR2.jpg

retertt = IMG_2973.jpg
E Recenti = IMG_2975.jpg
£ Dropbox = IMG_2981.jpg
. . 8 IMG_3003.jpg
& iCloud Drive i IMG_3012.jpg
/3 Applicazioni B IMG_3783.jpg
B |IMG_3786.jpg
[ Desktop 3
: 8) AMC_3787 irg IMG_3796.jpg
[ Documenti B IMG_3796.jpg
© Downloads 8) IMG_381 0'j.pg Immagine JPEG - 4 KB
= IMG_3811.jpg Creat | 17:55
=] i . reato oggi, 17:
Condivisa
_ 8 :mg_ggs?jpg Modificato oggi, 17:55
=] Macintosh HD 2 = P9 Ultima apertura oggi, 17:55
B sites = IMG_3832jpg Dimensioni 138 x 118
= IMG_4107.CR2.jpg Aggiungi tag...
£} victor = IMG_4121.CR2.jpg
. = IMG_4152.CR2.jpg
o Incorpora il file nel documento
" Creaun link al file
Opzioni Annulla Seleziona
N e —— — -
W Evidenziazione:.. F6 regolabile
A] Viola F7 Altro $479.99
F8
Al o Sellino Brooks C17 Cambium $160.00
A] Verde F9
= Giallo o Regagisella telescopico Crank Brothers $269.99
Kronolog
A] Arancione
= e Cavi $50.00
AF - 22






EPUB/art/oo4mac_button_inspector.png





EPUB/art/oo4mac_customizeToolbarSheet.png
Trascina i tuoi elementi preferiti nella barra strumenti...

[ DL -2 $ & < > P
Barra laterale Azione Inizia registrazione Allega Sposta a sinistra Sposta a destra Sposta su
v —— — —
¥ = v= r= + +

Sposta gil Raggruppa Separa Espanditutte Contrai tutte Aggiungiriga Aggiungi all'interno

NS = = o Colonne v

Aggiungi all'esterno Aggiungi colonna Rimuovi colonna Tema Impostazioni Visibilita
50% ¢ Aa O & <r
Zoom Font Colori Stampa Spazio Spazio flessibile

... 0 trascina la configurazione di default sulla barra strumenti.

[ B s0% ¢ & ()

Barra laterale  Tema Zoom Inizia registrazione Aggiungi colonna Impostazioni

Mostra Icona e testo ~ Usa dimensioni ridotte






EPUB/art/oo4mac_pref_keyboard.png
o Preferenze Tastiera

= = B (B ¢ O

Generali Tastiera Testo Esportazione RTF Registrazione audio Aggiornamento

Quando premi Tabulazione: @ Rientra riga
Vai alla cella successiva

Mantieni premuto X (Opzione) per inserire un carattere
di tabulazione

Mantieni premuto € (Maiuscole) per invertire la direzione

Quando premi A capo: (@) Crea una nuova riga vuota
Inserisci un'interruzione di riga nella riga corrente

X ¢ (Opzione-A capo) inserisce sempre interruzione di riga
Dividi la riga corrente nel punto di inserimento

~ ¢ (Controllo-A capo) divide sempre la riga corrente in
corrispondenza del punto di inserimento

Vengono create nuove righe: Sempre allo stesso livello
© Con rientro, se ci sono figli

Quando premi Esc: o Mostra menu di completamento sistema standard
Inizia o termina la modifica del testo

Applica stili con nome con: @ Tasti funzione
Controllo + numero






EPUB/art/oo4mac_inspector_lock.png
[} Attributi di stile

Riga "Livello 1"

B4 font > corsivo: si

4 font > spessore: Grassetto

[4 allineamento: centro

4 riga > spaziatura interna: 5
Documento intero

[Ed font > dimensione: 13

[Ed font > famiglia: Helvetica Neue

[Ed multiplo altezza linea: 1.1

4 orientamento: da sinistra a de...

[E4 riga > spaziatura interna: 0





EPUB/art/oo4mac_button_reset.png
Reset





EPUB/art/oo4mac_inspector_style.png
O style

EEiEf = B
A | Helvetica v
12 v) [ ——
B .J I ] & ] U

Background:

Gutter:

Handle:

Numbering:

Line height:

Row padding:
Above note:
Above children:

Below children:

Indent children:

Start a new page:

Included styles:

<« [«]

<

<«

o
) @D G

gl

gl

E

None v

Yes






EPUB/art/oo4mac_inspector_style_callouts.png
OmniOutliner Pro

Stile

A B0

A Helvetica

13
1

v

Altezza riga:

Sfondo:

Maniglia:
Numerazione:

Margine interno:

Spaziatura interna:
Sopra la nota:
Sopra i figli:

Sotto i figli:

Inizia nuova pag.:

Rientro figli:

Stili inclusi:

.
?Z

———
5. U
= E
1,1 %

s -

Nessuna

A
v

(=] o
<> <

o
<>

Nessuno

—  Strumenti
di stile

} stili di tipo {

Stili di paragrafo _I'[

Stili di maniglia

Stili di spaziatura
interna

——— Impaginazione
Rientro

Stili con nome

OmniOutliner Standard

@ Stile
A = U
A Helvetica
13
B. I

Sfondo:

Numerazione:

Margine interno:

Spaziatura interna:

Stili inclusi:

%2

Nessuno






EPUB/art/oo4mac_styles_named_keyboard.png
A] Intestazione 1

A] Intestazione 2

A] Intestazione 3

W Evidenziazione:...
W Evidenziazione:...

W Evidenziazione:...

A] Viola

Al Blu ’
’

Al Verde ]

Al Giallo /

A] Rosso
A] Grafite

+

F4 L) _==< JV Evidenziazione:...

?‘Evidenziazione:...
N

| 43

Aranci

v

Fai clic e tieni premuto

A] Intestazione 1

A] Intestazione 2

Al Intestazione 3

Verde
Giallo

Arancione

Rosso
Grafite

+

.

F1
F2
F3
Fa4
F5
F6

F8
F9

Intestazione 1

A
|A] Intestazione 2

Al Intestazione 3

W Evidenziazione:...
W Evidenziazione:...
W Evidenziazione:...

Arancione

Viola

Blu F9

Verde

Giallo

Rosso

v

Trascina nell'elenco di stili e
rilascia dove vuoi

= =] =] =] =] @

Grafite

| + %~

Gli stili si spostano in basso
nell'elenco





EPUB/art/oo4mac_resourcebrowser_templates.png
06 () Templates )

FAVORITES Blank.oo3template

% Dropbox CESTEZID - - ook Draft oo3template
Budget.oo3template
Class Notes.oo3template
? AirDrop Level Styles.oo3template
A Applications Notetaking.oo3template
Solarized (D...oo3template
ﬁ Desktop Solarized (Li...oo3template
‘ﬂ Documents
0 Downloads
JJ Music

—1 Movies

@) Pictures

DEVICES

SHARED

TAGS






EPUB/art/oo4mac_notes_pane.png
[ BN ] Untitled — Edited

B] . B % $ (i}
CONTENTS @ Topic
b LovelSies 5 o Level Styles
v O Section 1
v [] Subsection 1A

o [] This document automatically styles each row based on its level.
STYLES 2

* [] You can customize the “Level N Rows” styles in the sidebar

B8 Whole Document however you like — in this document, or in any OmniOutliner
E§ Column Titles document!

B Level 1 Rows
B Level 2 Rows
B Level 3 Rows v O Section 2
i} Level 4 Rows
B8 Notes
{__} Topic

¢ [] Subsection 1B

¢ [] Subsection 2A

¢ [] Subsection 2B

A] Heading 1 F1
A] Heading 2 F2
A] Heading 3 F3
W Highlight: Yellow F4
W Highlight: Red F5
W Highlight: Green  F6
Al Purple F7
Blue F8
Bondi

Green

Notes are useful for adding additional information about the row’s contents. You
can also hide these by choosing View > Hide Note or View > Hide All Notes.

Yellow

Orange
Red
Graphite

+ FEFEFEEFRERE






EPUB/art/oo4mac_inspector_outline.png
Struttura

2

Righe alternate:
Griglia orizzontale:

Griglia verticale:

Intestazioni colonna:
Mostra stato riga:

Note in riga:

Rientro righe figlie:

Automatico
o s
——

16

A
v
A
v
A
v

A
v






EPUB/art/oo4mac_colorpalette.png
o [
b o

Opacita

H::

Colori






EPUB/art/oo4mac_style_sidebar_callouts.png
STYLES 3

B Whole Document
[ Column Titles

i i Level 1 Rows

B Notes

o . Topic
A -

Heading 1

Al Heading 2

[A] Heading 3

W Highlight: Yellow
W Highlight: Red
W Highlight: Green
Al Purple

Blue
Bondi
Green

Yellow

Orange
Red
Graphite

> = ] E F F >

O+






EPUB/art/oo45mac_linkedfolder.png
[ XOX } Browser delle risorse

RECENTI

Documenti
Modelli

MODELLI

Altri I miei stili livello
Appunti

Elenchi

Matematico

Scrittura

Stili livello

Temi

File di Outliner

Nuova struttura






EPUB/art/oo4mac_button_action.png





EPUB/art/oo4mac_inspector_column_popup.png
Tipo: Elenco a comparsa B
Riepilogo: Nessuno B

Tazza
Quarto
Gallone






EPUB/art/oo4mac_row_numbering.png
v Genitore
v Figlio
* Nipote
v Nipote
« Pronipote

« Pronipote
« Nipote

« Figlio
« Figlio
v Genitore
« Figlio
« Figlio

* Genitore





EPUB/art/oo4mac_button_inspector_column.png





EPUB/art/oo4mac_inspector_document.png
[} Documento

A 77

Dimensioni: Comprimi su disco
Copyright: 2015
Versione: 0.1.2.3
Oggetto: | giochi da tavola di Omni

Descrizione: Un elenco di giochi da tav

Commenti:

Autori
giochi da tavolo
giochi
Wil Wheaton deve venire a trovarci!

E girare un episodio di Tabletop.
+ (=






EPUB/art/icon_ibooks.png





EPUB/art/oo4mac_sidebar07.png
Mostra/Nscondi stili

Stili documento

Stili con nome

Menu Azione
Aggiungi nuovo stile

STILI

©

Titoli colonne
i Righe livello 1

i Righe livello 2

i Righe livello 3
Note
Componente

i Prezzo

[ Documento intero

A] Intestazione 1 F1
[A] Intestazione 2 F2
A] Intestazione 3 F3
W Evidenziazione:.. F4
W Evidenziazione:... F5
W Evidenziazione:... F6
A] Viola F7
Al Blu F8
A] Verde F9
A] Giallo

A] Arancione

A] Rosso

A] Grafite

pa— + ;





EPUB/art/oo4mac_sidebar06.png
Sellino Brooks C17 Cambium
Migliorie alla bici per il 2016

eggisella telescopico Crank Brg
Migliorie alla bici p 2016

migliorie_bici_2016.003 -

Componente

STILI v

Ed Documento intero
Ed Titoli colonne

[A] Intestazione 1
[A] Intestazione 2
[A] Intestazione 3
W Evidenziazione:...
W Evidenziazione:...

W Evidenziazione:...
Viola

[A] Blu
[A] Verde

[A] Giallo
[A] Arancione

+

000000O0Oocooo

L
<

v Viigiiorie alla pbici per 11 2016
Trasmissione
e Pedali Shimano XTR OD-M985
e Pulegge Shimano XTR OD-M985

e Cambio anteriore Top Swing Shimano XTR
OD-M985

Cambio posteriore Shadow Plus Shimano
XTR OD-M985

e Catena Shimano XTR a 10 velocita

e Cassetta Shimano XTR a 10 velocita
Sospensione/Ruote

¢ Ruote Mavic CrossMax SLR 29

* Pneumatici WTB Wierwolf AM TCS
Parte anteriore

e Manubrio Napalm Carbon di Loaded
Precision

Asse Napalm Carbon 120mm/6° di Loaded
Precision

Forcella Fox 34 Talas 29 140 Fit CTD
regolabile

Altro
e Sellino Brooks C17 Cambium

e Reggisella telescopico Crank Brothers
Kronolog

e Cavi

$1,168.95
$179.00
$444.99
$89.99

$199.99

$54.99
$199.99
$1,177.99
$999.99
$118.00
$1,599.98
$229.99

$249.99

$1,120.00

$479.99
$160.00
$269.99

$50.00






EPUB/art/oo4mac_sidebar05.png
Sellino Brooks C17 Cambium
Migliorie alla bici per il 2016

eggisella telescopico Crank Brc
Migliorie alla bici per il 2016






EPUB/art/oo4mac_sidebar04.png
CONTENUTI @ v Livello 2

v Livello 1 e Livello3
v Livello 2 e Livello3
e Livello 3
e Livello 3
o Livello 2

o Livello 42






EPUB/art/oo4mac_sidebar03.png
CONTENUTI

v Livello 1
v Livello 2
e Livello 3
e Livello 3
o Livello 2

o Livello 42






EPUB/art/oo4mac_icon_remove.png





EPUB/art/oo4mac_sidebar02.png
CONTENUTI @ v Livello 2

v Livello 1 e Livello3
v Livello 2 o Livello 3
o Livello 3 —
e Livello 3
o Livello 2
o Livello 42

STILI =)

Documento intero

Fai clic e trascina qui per
ridimensionare la barra
laterale

Fai clic e trascina qui per
ridimensionare i pannelli
Contenuti e Stili





EPUB/art/oo4mac_copyaslink.png
CONTENUTI

» Pane alla banana

STILI

Documento intero
Titoli colonne
Righe livello 1
Righe livello 2
Righe livello 3
Note

_i Argomento

[A] Intestazione 1
[A] Intestazione 2
[A] Intestazione 3

v Pane alla banana
Ingredienti

120 g di burro non salato*
150 g di zucchero di canna
3 banane omnioutliner:///open?row=g4ETGj2UIYM

2 uova omnioutliner:///qpen?row=g4ETGj2UIYM
260 g di farina 2

1 cucchiaino di sale

80 g di gocce di cioccolato

50 g di granella di noci pecan
* (@ temperatura ambiente)

Procedimento

1 Accendere il forno a 180° C.

Preriscaldare sempre il forno in modo che raggiunga la temperatura necessaria
mentre si prepara |'impasto.

2 Preparare uno stampo per pane spennellando un sottilissimo strato di burro non
salato (altri 15-30 g).

Prima della cottura & sempre bene imburrare lo stampo, anche quando se ne
utilizza uno antiaderente.

3 In una ciotola medio-grande, mescolare insieme farina, bicarbonato e sale, quindi
tenere da parte.





EPUB/art/oo4mac_sidebar01.png
eoe
LBk Ad

| miei stili livello.oo3 — Modificato ~

CONTENUTI

v Livello 1
v Livello 2
e Livello 3
e Livello 3
o Livello 2

o Livello 42

STILI

Ed Documento intero

Ed Titoli colonne
ighe livello 1
ighe livello 2
ighe livello 3

Argomento

Intestazione 1

Intestazione 2

Intestazione 3

W Evidenziazione:...
A] Viola

Blu

Verde

Giallo

Arancione

Rosso

@

©

v Livello 1
v Livello 2
e Livello3
e Livello3
o Livello 2
o Livello 42






EPUB/art/oo4mac_editlinkpopover.png
CONTENUTI @ | ~ Pane alla banana

» Pane alla banana Ingredienti
120 g di burro non salato*
150 g di zucchero di canna

3 banane ben mature

2 uova omnioutliner:///open?row=g4ETGj2UIYM

RN ~ Ai favina

Titolo visualizzato:

O] —

B bocumernto intero | Mostra URL:
- Titoli colonne omnioutliner:///open?row=g4ETGj2UIYM

Rignepiveliop] Rimuovi link Annulla
Righe livello 2

Righe livello 3 Preriscaldare sempre il forno in modo che raggiunga la temperatura necessaria

mentre si prepara |'impasto.

=] 2 Preparare uno stampo per pane spennellando un sottilissimo strato di burro non
salato (altri 15-30 g).
Prima della cottura & sempre bene imburrare lo stampo, anche quando se ne
A] Intestazione 1 F1 utilizza uno antiaderente.
A] Intestazione 2 F2 = 3 In una ciotola medio-grande, mescolare insieme farina, bicarbonato e sale, quindi
Al Intestazione 3 F3 tenere da parte.






EPUB/art/oo4mac_pref_clippings.png
Clippings Preferences

Default Clippings Modifications to the Services menu may
not appear in other applications until you
relaunch them.

# Split multi-line clippings
Clippings with multiple lines of text
will be treated as separate rows.






EPUB/art/oo4mac_icon_128.png





EPUB/art/oo4mac_pref_text.png
@ Preferenze Importazione ed esportazione testo

1'721 Iﬁl IEI Iél liJ

Generali Tastiera Testo Esportazione RTF Registrazione audio Aggiornamento

O

Punto elenco per le righe senza figli: | -

Righe con figli, espanse: -

Righe con figli, contratte:

Selezionato:
Non selezionato:

Indeterminato:

Spazi per livello:

Spazi tra colonne:

Codifica testo per importazione/esportazione:

[+]
[1]
[-]
4
2

Unicode (UTF-8)

©






EPUB/art/oo4mac_inspector_column_smartmatch.png
Data Percorso Miglia Condizioni

22/02/15 e Chilly
Chilly Hilly Loop (Bainbridge Island)
CW Lake Washington Loop
CW Lake Washington Loop

32,55 Sole






EPUB/art/oo4mac_toolbar_file_rename.png
migliorie_bici_2016.003 — Modificato vk

Nome:  migliorie_bici_2016.003
rnpostaz

te Tag:

Situato in: File di Outliner [T} Bloccato |
1





EPUB/art/oo4mac_spelling_autocheck.png
Whails are bluberny
blueberry x





EPUB/art/oo4mac_pref_general.png
Preferenze Generali

= =@ B B i1 L

Generali Tastiera Testo Esportazione RTF Registrazione audio Aggiornamento

Per i nuovi documenti: ° Apri Browser delle risorse
") Usa modello:

Link: Crea automaticamente link dagli URL digitati

B Usa stile di elementi pari livello all'aggiunta di riga






EPUB/art/oo4mac_yellowlegalpad.png
CONTENUTI

o Portare la bici in officin...

e Acquistare camere d'ari...

e Acquistare bevande ...

e Arieggare tenda

o Arieggiare sacchi a pelo

e Congelare una bottigli...

e Pulire sacca d'acqua

a DNEDI ADQI ~ramnlataman DEPILARSI completamente (scherzo)

STILI

Ed Documento intero
B4 Titoli colonne

i} Righe livello 1

Ed Note

i} Argomento

[A] Intestazione 1

[A] Intestazione 2
[A] Intestazione 3
W Evidenziazione:...
W Evidenziazione:...
W Evidenziazione:...
[A] viola

[A] Blu

[A] Verde

[A] Giallo

[A] Arancione

[A] Rosso

[A] Grafite

+

F1
F2
F3
Fa4
F5
F6
F7
F8
F9

@ Elenco di controllo precorsa

Portare la bici in officina per una revisione

Acquistare camere d'aria di scorta

Acquistare bevande di idratazione Skratch

Arieggare tenda

Arieggiare sacchi a pelo

Congelare una bottiglia d'acqua

Pulire sacca d'acqua

©






EPUB/art/oo4mac_button_help.png





EPUB/art/oo4mac_icon_remove4.png





EPUB/art/oo4mac_inspectors00.png
A RN

A Helvetica

13

Altezza riga:

Sfondo:

Maniglia:
Numerazione:

Margine interno:

Spaziatura interna:
Sopra la nota:
Sopra i figli:

Sotto i figli:

Inizia nuova pag.:

Rientro figli:

Stili inclusi:

11 %

s -
Nessuna B

5 o]
0 -
0 -
0 -
EIl o |
Si No

Nessuno B






EPUB/art/oo4mac_icon_remove3.png





EPUB/art/oo4mac_icon_remove2.png





EPUB/art/oo4mac_inspector_rowcolors.png
Righe livello 1
Righe livello 2
Righe livello 3
Righe livello 3

Righe livello 2
Righe livello 1

Colore margine
interno






EPUB/art/oo4mac_menu_rowtextoptions.png
- —— a8 =
= Bh (100% - & [

| Mary had a little lamb, whose fleece was white as snow. And everywhere that Mary went, the lamb was sure to go. |

f
CONTENTS @ e Mary had a little lamb, vhose fleece was white as snow. And everywh__,

. * |t followed her to school one day, which was against the rule. And so .
e Mary had a little la...
o It followed her to sch... o “Why does the lamb love Mary so?” the t?ager children cry. “Why Mary
loves the lamb, you know,” the teacher did repIyJ

e “Why does the lamb I...





EPUB/art/oo4mac_stylechit02.png





EPUB/art/oo4mac_stylechit01.png





EPUB/art/oo4mac_inspector_typefaces.png
v Default

Leggero
v Regolare
Grassetto

Ultraleggero
Sottile
Leggero
Libro

v Regolare
Medio
Semi grassetto
Semigrassetto
Grassetto
Extra grassetto
Pesante
Nero
Ultra
Extra nero

v Default

v Regolare
Corsivo

Default

¥ Tutto I'intervallo
Solo parole

Default

v Tutto I'intervallo
Solo parole






EPUB/art/oo4mac_movingvsindenting01.png
v Colori dello spettro visibile
v Rosso

* Arancione

v Giallo
v Verde
* Blu
* Violetto





EPUB/art/oo4mac_movingvsindenting02.png
v Colori dello spettro vi

* Arancione






EPUB/art/oo4mac_movingvsindenting03.png
v Colori dello spettro visibile
* Rosso

v Arancione

v Giallo
v Verde
* Blu
* Violetto





EPUB/art/oo4mac_inspector_column_date.png
Tipo: Data

Riepilogo: Nessuno

Formato: 27/05/16 B

|

v 27/05/16 Breve
27 mag 2016 Medio
27 maggio 2016 Esieso

¥ Nessuno Nessuno
19:57 Breve
19:57:33 Medio
19:57:33 CEST Esteso

2016-05-27 19:57:33 +0200 Data e ora

Fri, 27 May 2016 17:57:33 GMT HTTP
20160527T175733.727Z 1SO 8601 (UTC)
20160527T195733.727+0200 SO 8601 (Local)

Formato personalizzato...






EPUB/art/oo4mac_movingvsindenting04.png
v Colori dello spettro vi
v Rosso

v Arancione

v Giallo
v Verde
¢ Blu
* Violetto






EPUB/art/oo4mac_aboutbox.png
® OO0

Supporto - omnioutliner@omnigroup.com
Vendite - store.omnigroup.com

THE OMNI GROUP

1000 Dexter Ave N Suite 400

Seattle, WA, USA 98109-3582

+1 800 315-OMNI « +1 206 523-4152

© 2000-2016 The Omni Group

Om n | Outl I n er L'aggiornamento a OmniOutliner Pro

Come su carta, ma
meglio
4.5.3 (v177.7.10 r261276)

¢ stato installato. Grazie!






EPUB/art/oo4mac_button_clearsearch.png





EPUB/art/oo4mac_pref_rtfexport.png
o Preferenze Esportazione RTF

-~ 1@1 l%J lal i} QJ

L J
Generali Tastiera Testo Esportazione RTF Registrazione audio Aggiornamento

Punti elenco per le righe senza figli: -

Righe con figli, espanse: ~

Righe con figli, contratte: »
Larghezza minima: 0,328 cm

Larghezza: 0,328 cm

Selezionato:

Non selezionato: O

Indeterminato: -
Larghezza minima: 0,416 cm

Larghezza: 0,423 cm

Larghezza rientro per livello: 0,635 cm

Spazio tra colonne: 0,317 cm






EPUB/art/oo4mac_resourcebrowser.png
Browser delle risorse

RECENTI

oo

5
5
B
5
B8

Documenti
Modelli

Altri Compatto
Appunti

Elenchi

Matematico

Scrittura

Stili livello
Temi Elenco libri

sieidiashibinenti

Classico con stili
livello

Appunti lezione

Preventivo

Elegante con stili
livello

*

Bozza libro

Moderno con stili

Annulla

livello

Nuova struttura






EPUB/art/oo4mac_toolbar_customize.png
O 066 Untitled — Edited =

Drag your favorite items into the toolbar...

E] ’§s ~) =4

Sidebar Sections i Move Left

— Com—
omm omm<
— Omm<
-— omm<

Move Right Ungroup

o —
Columns v F—]
=

Visibility Add Row

e 6

Add Inside Add Outside Add Column Remove Column

| 4

Toggle Ruler

=

Print Space Flexible Space

... or drag the default set into the toolbar.

B 6

Sidebar Inspect

Show | Icon Only 2 [ ] Use small size E






EPUB/art/oo4mac_button_inspector_document.png





EPUB/art/oo4mac_pref_keyboard_esc.png
OmniOutliner Pro is am: i

among
amazingly
amusing

am

amazed
amaze

amid
amongst
ambassador
amounts
amp
amendment
amount
ambitious
amateur





EPUB/art/oo4mac_prothanks.png
Thank You

You have licensed OmniOutliner 4 Pro.
We’re happy to have you with us. From everyone here at the Omni Group... Enjoy!

AppleScript features will be available the next time you quit and reopen the app; other
Pro features are available now.

L d N

The Omni Group






EPUB/art/oo4mac_inspector_column_date_custom.png
Editor formato data

Digita il testo e trascina gli elementi di data e ora per creare un formato personalizzato.

Elementi di data

Giorno della settimana martedi v Giorno dell'anno
Mese gennaio v Settimana dell'anno
Giorno del mese 5 v Settimana del mese
Anno 2016 v

Elementi di ora

Ora 7~ AM/PM
Minuto 08 v Fuso orario
Secondo 09 v Millisecondi

Annulla

PM
CET v
000 v

Salva






EPUB/art/oo4mac_keyvaluepairs.png
[} Documento

A 77

Dimensioni: Comprimi su disco
Copyright: Janey Appleseed
Versione: 1.0.1.1
Oggetto: Elenco di controllo precors

Descrizione: Cose da fare ed equipaggi

Commenti:

cose da
i Seattle-
hiedono

Ecco un elenco d
preparare per la
Portland a luglio

Parole chiave

(o}

bici

Elenco di controllo
Campeggio
precorsa

oy






EPUB/art/oo4mac_toolbar_actionmenu.png
CONTENUTI

v Migliorie alla b

B3 Titoli colonne
{ i Righe livello 1
Righe livello 2

_i Righe livello 3

Ed Note

i} Componente

i__i Prezzo

= migliorie_bici_2016.003 -

Taglia

Copia
Incolla

Visualizzazione rapida dell'allegato
Font

Ortografia e grammatica
Sostituzioni
Trasformazioni

Voce

Direzione scrittura
Orientamento layout

Copia stile

Cancella stile gTR 10 veloca

0 XTR a 10 velocita
Allega file...

Suspeisiviic/ nuute

* Ruote Mavic CrossMax SLR 29
* Pneumatici WTB Wierwolf AM TCS

Parte anteriore

(A] Intestazione 1
(A] Intestazione 2
(4] Intestazione 3

W Evidenziazione:...
W Evidenziazione:...
W Evidenziazione:...

(A] Viola

(4] Blu
(A] Verde

(4] Giallo
[A] Arancione

+

Manubrio Napalm Carbon di Loaded
Precision

Asse Napalm Carbon 120mm/6° di Loaded
Precision

Forcella Fox 34 Talas 29 140 Fit CTD
regolabile

o Sellino Brooks C17 Cambium

o Reggisella telescopico Crank Brothers
Kronolog

O00o0o0oOooocooo

e Cavi

¥
<

Controlla ortografia mentre scrivo
Controlla grammatica insieme all'ortografia
v Correggi automaticamente ortografia

$1,177.99
$999.99
$118.00
$1,599.98
$229.99

$249.99

$1,120.00

$160.00
$269.99

$50.00






EPUB/art/oo4mac_handle_alwaysoff.png





EPUB/art/oo4mac_keyvaluepairs02.png
Parole chiave

Elenco di controllo
Campeggio

recorsa
|

oy






EPUB/art/oo4mac_inspector_column_number.png
o
A e

Tipo: Numero

Riepilogo: Nessuno

Formato: 9.999,99






EPUB/art/oo4mac_inspector_column_duration.png
Tipo: Durata

Riepilogo: Nessuno

Impostazioni:  Ore lavorative
8 ore al giorno
40 ore alla settimana

160 | ore al mese

V| Formato esteso






EPUB/art/oo4mac_stylechits.png





